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Safety Information

Important Information

Read these instructions carefully and look at the equipment to become familiar with the
device before trying to install, operate, service or maintain it. The following special
messages may appear throughout this bulletin or on the equipment to warn of potential
hazards or to call attention to information that clarifies or simplifies a procedure.

~\ [ ]
A ;<\ The addition of either symbol to a "Danger"” or "Waming" safety label indicates that an electrical

hazard exists which will result in personal injury if the instructions are not followed.

all safety messages that follow this symbol to avoid possible injury or death.

& This is the safety alert symbol. It is used to alert you to potential personal injury hazards. Obey

Please Note

A DANGER

DANGER indicates a hazardous situation which, if not avoided, will result in death or serious
injury.

A WARNING

WARNING indicates a hazardous situation which, if not avoided, could result in death or
serious injury.

A CAUTION

CAUTION indicates a hazardous situation which, if not avoided, could result in minor or
moderate injury.

NOTICE

NOTICE is used to address practices not related to physical injury.

Electrical equipment should be installed, operated, serviced and maintained only by qualified
personnel. No responsibility is assumed by Schneider Electric for any consequences arising out of
the use of this material.

A qualified person is one who has skills and knowledge related to the construction, installation, and
operation of electrical equipment and has received safety training to recognize and avoid the
hazards involved.



Notices

Legal Information

FCC

The Schneider Electric brand and any registered trademarks of Schneider Electric Industries SAS
referred to in this guide are the sole property of Schneider Electric SA and its subsidiaries. They
may not be used for any purpose without the owner's permission, given in writing. This guide and its
content are protected, within the meaning of the French intellectual property code (Code de la
propriété intellectuelle frangais, referred to hereafter as "the Code"), under the laws of copyright
covering texts, drawings and models, as well as by trademark law. You agree not to reproduce,
other than for your own personal, noncommercial use as defined in the Code, all or part of this guide
on any medium whatsoever without Schneider Electric's permission, given in writing. You also
agree not to establish any hypertext links to this guide or its content. Schneider Electric does not
grant any right or license for the personal and noncommercial use of the guide or its content, except
for a non-exclusive license to consult it on an "as is" basis, at your own risk. All other rights are
reserved.

Electrical equipment should be installed, operated, serviced and maintained only by qualified
personnel. No responsibility is assumed by Schneider Electric for any consequences arising out of
the use of this material.

As standards, specifications and designs change from time to time, please ask for confirmation of
the information given in this publication.

This equipment has been tested and found to comply with the limits for a Class B digital device,
pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection
against harmful interference in a residential installation. This equipment generates, uses, and can
radiate radio frequency energy and, if not installed and used in accordance with the instructions,
may cause harmful interference to radio communications. However, there is no guarantee that
interference will not occur in a particular installation. If this equipment does cause harmful
interference to radio or television reception, which can be determined by turning the equipment off
and on, the user is encouraged to try to correct the interference by one or more of the following
measures.

— Reorient or relocate the receiving antenna.
— Increase the separation between the equipment and receiver.

— Connect the equipment to an outlet on a circuit different from that to which the receiver is
connected.

— Consult the dealer or an experienced radio/TV technician for help.

The user is cautioned that any changes or modifications not expressly approved by Schneider
Electric could void the user’s authority to operate the equipment.

This digital apparatus complies with CAN ICES-3 (B) /NMB-3(B).



This device complies with FCC radiation exposure limits set forth for general population. This
device must be installed to provide a separation distance of at least 20 cm from all persons and
must not be co-located or operating in conjunction with any other antenna or transmitter.

This equipment complies with Part 68 of the FCC rules and the requirements adopted by the
Administrative Council for Terminal Attachments (ACTA). On the side of this equipment is a label
that contains, among other information, a product identifier in the format US: AAAEQ#TXXXX. If
requested, this number must be provided to the telephone company.

This equipment uses the following Universal Service Order Codes (“USOC”) jacks: RJ11.

A plug and jack used to connect this equipment to the premises wiring and telephone network must
comply with the applicable FCC Part 68 rules and requirements adopted by the ACTA. A compliant
telephone cord and modular plug or compliant modular jack is provided with this product.

The REN is used to determine the number of devices that may be connected to a telephone line.
Excessive RENs on a telephone line may result in the devices not ringing in response to an
incoming call. In most but not all areas, the sum of RENs should not exceed five (5.0). To be certain
of the number of devices that may be connected to a line, as determined by the total RENs, contact
the local telephone company. The REN for this product is part of the product identifier that has the
format US: AAAEQ##TXXXX. The digits represented by ## are the REN without a decimal point
(e.g., 03is aREN of 0.3).

If this equipment, Digital Power Meter with Internal Modem, causes harm to the telephone network,
the telephone company will notify you in advance that service may be temporarily discontinued.
When advance notice is not practical, the telephone company will notify you as soon as possible.
You will also be advised of your right to file a complaint with the FCC if you believe it is necessary.

The telephone company may make changes inits facilities, equipment, operations or procedures
that could affect the operation of this equipment. If this happens, the telephone company will
provide advance notice in order for you to make necessary modifications to maintain uninterrupted
service.

If you experience trouble with this equipment, Digital Power Meter with Internal Modem, please
contact Schneider Electric at 615-287-3400. If this equipment is causing harm to the telephone
network, the telephone company may request that you disconnect this equipment until the problem
is resolved.

There are no user serviceable parts in this equipment.

Connection to party line service is subject to state tariffs. Contact the state public utility
commission, public service commission or corporation commission for information.

If your premises have specially wired alarm equipment connected to the telephone line, ensure that
the installation of this Digital Power Meter with Internal Modem does not disable your alarm
equipment. If you have questions about what will disable alarm equipment, consult your telephone
company or a qualified installer.



Industry Canada

Under Industry Canada regulations, this radio transmitter may only operate using an antenna of a
type and maximum (or lesser) gain approved for the transmitter by Industry Canada. To reduce
potential radio interference to other users, the antenna type and its gain should not be so chosen
that the equivalent isotropically radiated power (e.i.r.p) is not more than that necessary for
successful communication.

This device complies with Industry Canada license-exempt RSS standard(s). Operation is subject
to the following two conditions: (1) this device may not cause interference, and (2) this device must
accept any interference, including interference that may cause undesired operation of the device.

This device complies with Industry Canada RF radiation exposure limits set forth for general
population. This device must be installed to provide a separation distance of at least 20 cm from alll
persons and must not be co-located or operating in conjunction with any other antenna or
transmitter.

Network compatibility notice for the internal modem

The internal modem in meters equipped with this option is compatible with the telephone systems of
most countries in the world, except for Australia and New Zealand. Use in some countries may
require modification of the internal modem’s initialization strings. If problems using the modem on
your phone system occur, please contact Schneider Electric Technical Support.
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Safety precautions

Safety precautions

Installation, wiring, testing and service must be performed in accordance with all local and national
electrical codes.

A DANGER

HAZARD OF ELECTRIC SHOCK, EXPLOSION OR ARC FLASH

» Apply appropriate personal protective equipment (PPE) and follow safe electrical work
practices. See NFPA 70E in the USA, CSA Z462 or applicable local standards.

» Turn off all power supplying this device and the equipment in which it is installed before
working on the device or equipment.

» Follow guidelines in the Wiring section of the related Installation Sheet.

» Assume communications and I/O wiring are hazardous live until determined otherwise.
» Always use a properly rated voltage-sensing device to confirm that all power is off.

» Do not use the data from the meter to confirm power is off.

* Do not exceed the maximum ratings of this device.

* Do not short secondary terminals of Voltage Transformer (VT).

» Do not open secondary terminals of Current Transformer (CT).

» Ground secondary circuit of CTs.

» Do not perform Dielectric (Hi-Pot) or Megger testing on this device.

* Donotinstall CTs in equipment where they exceed 75% of the wiring space of any cross-
sectional area in the equipment.

+ Donotinstall CTs in areas where ventilation openings may be blocked or in areas of breaker
arc venting.

* Donotinstall CTs using Class 2 wiring methods or connect to Class 2 equipment. See NFPA
70.

» Secure CT secondary conductors to ensure they do not contact live circuits.
+ Connect protective ground (earth) before turning on any power supplying this device.
» Replace all devices, doors and covers before turning on power to this equipment.

Failure to follow these instructions will result in death or serious injury.

NOTE: See IEC 60950-1 for more information on communications and I/0O wiring connected to
multiple devices.

A WARNING

UNINTENDED OPERATION

Do not use this device for critical control or protection of persons, animals, property or
equipment.

Failure to follow these instructions can result in death, serious injury, or equipment

damage.

7EN02-0306-05
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A WARNING

POTENTIAL COMPROMISE OF SYSTEM AVAILABILITY, INTEGRITY, AND
CONFIDENTIALITY

» Change default passwords to help prevent unauthorized access to device settings and
information.

» Disable unused ports/services and default accounts, where possible, to minimize pathways
for malicious attacks.

» Place networked devices behind multiple layers of cyber defenses (such as firewalls, network
segmentation, and network intrusion detection and protection).

» Use cybersecurity best practices (for example: least privilege, separation of duties) to help
prevent unauthorized exposure, loss, modification of data and logs, interruption of services, or
unintended operation.

Failure to follow these instructions can result in death or serious injury or equipment
damage.

Page 120210 7EN02-0306-05



Introduction

PowerLogic™ ION8650 meters provide revenue-accurate, true RMS measurements of voltage,
current, power and energy, and are complemented by extensive I/O capabilities, comprehensive
logging, and advanced power quality measurement and compliance verification functions. The
meters come with an extensive selection of preconfigured data screens and measurements, so you
can use the meters with their default configuration after you perform basic setup. You can also
customize the meter to fit your unique requirements.

ION8650 meters give you the tools to manage complex energy supply contracts that include
commitments to power quality. You can also integrate the meters with energy management
solutions such as EcoStruxure™ Power Monitoring Expert (originally ION Enterprise), SCADA,
automation and billing systems via Internet communications and multiple industry-standard
communication channels and protocols including MV-90 and IEC 61850.

In this chapter

IONBBS0 MeterS ... 15
IONBB50 naming CONVENtION . L 15
ION8650 in enterprise energy management systems ... .. ...l 16
Measured Parameters ... il 16
1= (o N 16
DeMaNd .. ... 16
INStantaneouUs ... ... . 17
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Min/Max reCOrding ... 17
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Data display and analysisS toOIS ........... ... oo 18
The front panel .. 18
WebMeter internal web server feature ...l 18
Meter internal email serverfeature ... ... . ... il 18
XML compatibility . . 18
Power Monitoring Expert software . ... ... L 18

ION Setup device configurationtool ... ... . ... 19

MV =00 19

IEC B1850 ... 19
AlEriNg ... 19
Communications methods ... ... 20
SO CUNY . 20
Digital and analog /0 Options . .. 20
ONboard /0 ...l 20
EXpaNded 11O L 20
Additional information 21
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Technical NOMES ... 21
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ION8650 meters

The meter is suited to a wide range of applications. The meters can be used as stand- alone
devices, but their extensive capabilities are fully realized when used as part of an enterprise energy
management (EEM) system. The ION8650 meter is available with the following feature sets:

Model Feature set
128MB memory, 50 data recorders (800 channels), 4-30 Class A +

ION8650A ENS50160 power quality analysis (waveforms and transient
detection)

ION8650B 64MB memory, 45 data recorders (720 channels), 4-30 Class S +
ENS50160 power quality monitoring

ION8650C 32MB memory, 5 data recorders (80 channels)

NOTE: For complete details of the ION8650 meter feature sets, see the ION8650 Datasheet
available from www.se.com.

ION8650 naming convention

In the serial number and ANSI bar code area of the meter’s front panel you can view the feature set,
form factor and any special order options available with the meter. For example:

S8650A0COH6E0BOA

Power supply and system

S8650 Brand and model H6 frequency
A0 Feature set and form factor EO Communications
Cco Voltage/current inputs BOA I/0, security and special options

When there are differences between the models (such as a feature specific to one model), it is
indicated with the appropriate model number in this document.

7EN02-0306-05 Page 150f210
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ION8650 in enterprise energy management systems

Applications that include the meter typically require additional equipment. Display and analysis
software tools are almost always used to manage, interpret and distribute the data measured or
logged by a meter. There are usually a variety of tools used, and often these tools are connected
using different communications standards and protocols.

The meter can adapt to many situations. Advanced communications allow data to be shared
simultaneously across multiple networks, built-in 1/0 provides monitoring and non-critical control
capabilities, and a variety of display and analysis tools can be used to monitor your power system.

The meter is factory-configured and ready to operate

Your meter is preconfigured to provide most of the functionality needed in many applications. After
you perform the installation and basic setup, all the basic measurements, energy calculations and
recording functions are ready to operate. The meter can also be fully customized if necessary, to
meet your needs.

Measured Parameters

The meter provides fully bi-directional, 4-quadrant, revenue accurate energy metering. The following
sections list some of the parameters measured by the meter.

Energy

The meter provides all common active, reactive and apparent energy parameters.

« kWh, kVARh, kVAh delivered and received

kWh, kVARh, kVAh net (delivered - received)

kWh, kVARh, kVAh total (delivered + received)

Volt-hours and amp-hours
+ Integration of any instantaneous measurement
Energy registers can be logged automatically on a programmed schedule. All energy parameters
represent the total for all three phases.
Demand

The meter supports standard demand calculation methods, including block, sliding window (rolling
block), and predicted demand. It can measure demand on any instantaneous value and record peak
(maximum) and minimum demand with date and timestamps to the second. Peak demand registers
can be reset manually (password protected) or logged and reset automatically on a programmed
schedule.

Measurements include:
* kW, kVAR, kVA demand, min/max
* Amps, Volts demand, min/max

+ Demand on any instantaneous measurement

Page 16 of 210 7EN02-0306-05
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Instantaneous

The meter provides highly accurate, 1 second or 1/2 cycle measurements, including true RMS, per
phase and total for:

» Voltage and current

» Active power (kW) and reactive power (KVAR)
» Apparent power (kVA)

+ Power factor and frequency

+ Voltage and current unbalance

* Phasereversal

Harmonics

Complete harmonic distortion metering, recording and real-time reporting, up to the 63rd harmonic
for all voltage and current inputs.

+ Individual harmonics (including magnitude, phase and inter-harmonics)
+ Total even harmonics and total odd harmonics
+ Total harmonics (even +odd)

« K-factor, Crest factor

Min/Max recording

The meter records each new minimum and new maximum value with date and time- stamp for the
following parameters:

» Voltage and current min/max
* kW, kVAR, and kVA min/max
» Power factor

* Frequency

» Voltage unbalance

* Plus, any measured value

Power quality

The meter measures and records the following parameters:
+ Sag/Swells
+ Transients (ION8650A only)

The meter also has the following power quality features:

» Disturbance direction detection: This allows the meter to analyze disturbance (sag/swell)
information to help determine the direction of the disturbance relative to the meter.

« EN50160: ION8650A and ION8650B meters have a default framework that measures and
presents EN50160 compliance according to guidelines defined by Eurelectric (UNIPEDE).
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» |IEC 61000-4-30: The meter complies with the IEC 61000-4-30 power quality standard as
follows:

— The ION8650A complies with IEC 61000-4-30 Class A.
— The ION8650B complies with IEC 61000-4-30 Class S.

+ COMTRADE: ION8650A meters can save waveform data in COMmon Format for TRAnsient
Data Exchange (COMTRADE) format, which is then available for download via FTP. This is
intended for use in conjunction with IEC 61850 and is only available on ION8650A meters with
an Ethernet port.

Data display and analysis tools

The meter integrates seamlessly with display and analysis software available from Schneider
Electric™, such as Power Monitoring Expert that lets you analyze and monitor your system and
produce reports for any department in an organization. Power Monitoring Expert is designed to make
use of your meter's advanced capabilities. You can also use data acquired by the meter in a variety
of third-party systems.

The front panel

Local monitoring and standalone applications are facilitated by the meter’s front panel interface. The
front panel combines real-time display features with basic device configuration functions. The front
panel is often used in combination with Power Monitoring Expert or ION Setup, providing an
interface for field personnel.

WebMeter internal web server feature

WebMeter™ provides quick and easy access to real-time energy and basic power quality
information without special software using an on-board web server combined with an Ethernet port.
The built-in web pages display a range of energy and basic power quality information through the
web-enabled device.

Meter internal email server feature

You can configure your meter to automatically email high-priority alarm notifications or scheduled
system-status update messages to an external email address. Specify the type of event that
triggers an email alert, such as power quality disturbances or logged data at any pre-determined
interval, and have your Power Monitoring Expert or ION Setup administrator program the meter to
respond with an email message when these events occur. Email messages from your meter can be
received like any email message.

XML compatibility

The meters can exchange information using industry-standard XML format. This simple machine-
readable format supports integration with custom reporting, spreadsheet, database, and other
applications.

Power Monitoring Expert software

Power Monitoring Expert allows the meter to be part of a fully networked information system with
other meters and local and wide-area computer networks. Power Monitoring Expert is
recommended for all power monitoring systems where advanced analysis and non-critical control
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capabilities are required.

Power Monitoring Expert provides tools for managing your power monitoring network, logging data,
analyzing real-time and logged data, generating power system reports, and creating custom
functionality at the meter level.

Power Monitoring Expert also offers ways to remotely view information through a web browser: for
example, through the WebReach and Web Reporter components of Power Monitoring Expert, and
through Microsoft Terminal Services.

See Power Monitoring Expert help for more information.

ION Setup device configuration tool

ION Setup is a meter configuration tool designed specifically to configure and test meters. ION
Setup offers a graphical interface for performing basic meter setup, installing templates into meters,
upgrading firmware, viewing real-time and reset accumulated values, verifying meter accuracy and
measurements, and setting up advanced security.

You can download ION Setup from www.se.com. It is recommended that you always upgrade to
the latest version of ION Setup to help properly configure the features available on your device.

MV-90

MV-90 software (by Utility Translation Systems) is a multi-vendor translation system that can
collect and analyze data from a variety of different brands of meters, each with unique database
formats. MV-90 manipulates this data without extensive knowledge of the device of origin.

For more information on using the meter in an MV-90 system, see the MV-90 and ION Technology
technical note.

IEC 61850

IEC 61850 is an Ethernet-based protocol designed for electrical substations. It is a standard
(vendor-independent) method of communications, developed to support integrated systems
composed of multi-vendor, self-describing devices. When properly configured, the meter acts as a
serverin an IEC 61850 system. This meter supports IEC 61850:2010 (Edition 2).

Alerting

The meter can be configured to send alerts in response to power system conditions that you define,
such as a power quality problem (including surges, sags and swells), changes in relays, power
outages or required equipment maintenance. This allows you to automatically advise key people of
problems to allow quick remedial action, notify software so logs can be uploaded from the site that
initiated the alert, or service equipment on schedule.

You can configure the meter to send alerts to email, pagers, outage notification servers orto
software such as Power Monitoring Expert.

For more information on configuring alerting on the meter, see the /ION meter alerts technical note
and the Alert module description in the /ION Reference. For more information on configuring alerting
in Power Monitoring Expert, see Power Monitoring Expert help.

For more information on Ethernet outage notification, see the Outage notifications on the
PowerlLogic ION8650 product option document.
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Communications methods

Security

The meter can be integrated into various industry-standard networks. Data from the meter can be
made available to other devices using the Modbus ™ Master, Modbus RTU, Modbus TCP, DLMS
and DNP 3.0 protocols, as well the MV-90 translation system. You can also configure the meter to
import data from devices on these networks. With these advanced communications functions, the
meter operates in most existing power monitoring systems. Any data display and analysis software
that works with these protocols also functions with the meter.

The standard meter includes a selectable RS-232/RS-485 port, a high-speed RS-485 port, and an
optical port for communications in the field. Order options include a 10/ 100Base-T Ethernet port,
57.6 kbps internal modem (both FCC and CTR-21 compliant) and an internal cellular modem.
Depending on the hardware options purchased, up to four separate ports can communicate
simultaneously.

This meter offers standard and advanced security. Standard security is enabled by default from the
factory, and advanced security allows you to configure specific security settings. These include
features such as adding users with unique access privileges, and communications lockouts.

There are also additional features available on the meter that are based on the North American
Electrical Reliability Corporation Critical Infrastructure Protection (NERC CIP) standards, allowing
this meter to assist in making your facility NERC CIP compliant. These additional features include
advanced security through the front panel, communications and network port enabling and
disabling, Ethernet port number assignment and event log loss preventative measures.

Digital and analog I/O options

Onboard I/0

There are two optional onboard 1/O configurations available, each providing different capabilities.
The number and form of the digital inputs and outputs depend on the option you ordered; see your
meter's Installation Guide to determine the configuration available on your meter.

Additionally, two infrared ports (and corresponding LEDs) on the front panel are configured by
default for energy pulsing.

Digital inputs

The meter can be ordered with internally or extemnally excited Form A digital inputs. They can be
used for tariff inputs and other pulse counting applications.

Digital outputs

The meter can be ordered with both Form C and Form A solid-state outputs.

Expanded I/O

The 1/0 Expander option extends the meter’s 1/0 capabilities. The digital I/O Expander model
provides four Form A digital outputs, four Form C digital outputs, and eight Form A digital inputs.
The analog I/0 Expander model replaces the four form A digital outputs with analog outputs.

Refer to the PowerLogic I/O Expander Installation Guide for details on the options and installation
and operation instructions.
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Additional information

The most up-to-date documentation about your meter is available for download from www.se.com.
Available documentation includes:

Installation guides

This document is shipped with each meter. It details the mounting, wiring and basic setup of the
device. There is a separate installation guide for the socket and the switchboard versions of the
meter.

I/0 Expander installation guide

This document describes the optional external 1/O device that you can connect to the meter, for
additional digital /0O and analog output ports.

Product option documents

These documents provide option-specific information about the various product options you can
order for the meter. They usually ship with the product.

Online ION Setup help

The online ION Setup help has in-depth information on installation, setup and security of ION Setup.
It also contains instructions on using the Setup Assistant to configure devices.

ION Reference

This document describes ION architecture and provides detailed descriptions of all ION modules in
all ION meters.

Online Power Monitoring Expert help
The Power Monitoring Expert online help system provides information and instructions on using

Power Monitoring Expert components.

Technical notes

Technical notes such as the EN50160 technical note are available from the website, and provide
instructions for using meter features and for creating custom configurations.

Protocol documents

Each protocol document contains information explaining how the product interacts with a protocol,
such as DNP 3.0, DLMS, Modicon Modbus, IEC 61850 and MV-90.

ION device template reference

This document lists the default ION modules and their default configuration in the shipping template
for the most recent firmware releases of ION meters.

Technical assistance

Go to www.se.com and then search for support to get assistance with troubleshooting.
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Have the meter model, serial number and firmware version information ready. See "Device specific
information" on page 22 for details about obtaining this information. You may be asked by a
customer care agent to enable factory access to the device for troubleshooting. Factory access is
gained after a unique diagnostic access code is used to login to the device over a secure protocol.

Factory access is:
» Disabled by default.
« Temporarily enabled for a duration defined in the Factory Access minutes register.
* Requires adequate user privileges to enable.

* Provides read and write permissions.

Device specific information

Manufacturing-related information about the meter is available from the Factory module. The
meter's Factory module stores meter details such as device type and serial number. You can use
ION Setup in advanced mode to view the contents of the Factory module’s setup registers.

ION Reference describes the Factory module in detail. You can download /ON Reference from
Www.se.com.
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Frontpanel

Front panel

The front panel provides a user-friendly interface from which you can view system data or configure
basic meter settings. A scrollable display and three distinct modes (NORM, ALT and TEST) provide
easy access to a range of functions through a simple three- button keypad.

This chapter describes the front panel and explains how to use it to display data, perform tests, and
set up basic configuration options.

In this chapter

Front panel features . ... . L 24
Display SCreeN tYPES . . . ... 27
Modes Of OperatioN ... L 30
Configuring the meter withthefrontpanel ... ... .. ... .. ... 31

S BtUP MBNUS . . . 34
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Front panel features

The front panel includes a liquid crystal display (LCD) with detailed graphics and text, up and down
arrow buttons for screen navigation and basic setup procedures, as well as LED pulsers for testing
the meter. This section outlines the features available on the front panel of the meter.

A Watt pulser: A set of LEDs (infrared, red)
used for real energy pulsing.

VAR pulser: A set of LEDs (infrared, red)
used for reactive energy pulsing.
Demand reset switch: Resets the peak

C demand values in the meter. Can be
/—\ activated with the cover on or off.
Round button (Alt/Enter): Press to select a
(A Oo O— v O

— 77 highlighted option. Also used to toggle
D between Norm and Alt display modes.
|| “ Press and hold for 3 seconds to access

Setup menu.
Navigation buttons: Press the up or down
buttons to scroll and highlight a different
menu item or to increase/decrease the value
of a highlighted number. Press and hold the
up button for 3 seconds to move the cursor
to the left. Press and hold the down button
G for 3 seconds to move the cursor to the right.

ANt a
G Test mode button: Located under the front
\ e f F  |label, this places the meter into Test mode,
e ~ \/\/ ceasing accumulation of billable quantities.

Master reset button: Located in a recessed
pinhole under the front label to prevent

G accidental activation. You must remove the
meter cover and its label to access it.

Meter LCD screen

LED pulsers

Two LED pulsers located near the top of the front panel represent WATT (to the left) and VAR (to
the right).

These LEDs are preconfigured for energy pulsing. The adjacent infrared outputs are connected to
the LEDs and pulse at the same rate. Pulse rates can be adjusted by editing the settings of the
Calibration Pulser module; for a detailed description of LED pulser operation, see "Energy pulsing
with LEDs" on page 155.
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Demand reset switch

S

Located on the front of the meter's external cover assembly, the demand reset switch resets the
peak demand values logged in the meter. This switch can be activated with the cover on or off.
When the meter is in TEST mode, the demand reset switch resets the test demand parameters.

In most applications, the demand reset switch is sealed with an anti-tamper mechanism; a through-
hole in the switch can accommodate either an external seal or a locking mechanism. See for more
information on anti-tamper sealing.

A Demand Lockout Time register sets the minimum time allowed between consecutive demand
resets; the meter ignores any attempts to reset the demand outside the bounds of the register. The
default value for the Demand Lockout Time is 25 days (2160000s). For details on the Demand
Lockout Time setup register, see "Configuring demand reset lockout time" on page 140.

Navigation buttons

A
V©

The navigation buttons are the up and down arrow buttons and the round ALT/ENTER button.
Press the up or down arrow buttons to manually scroll back or forth through the available displays
and temporarily halt the display screen’s automatic scrolling function. Press ALT/ENTER to toggle
between NORM and ALT display modes. The automatic scrolling function restarts 60 seconds after
a button was last pressed.

Hold the ALT/ENTER button for approximately three seconds to display the setup menu. You can
then use the navigation buttons to view the device's configuration or edit basic settings. See "Setup
menus" on page 34 for further instruction on modifying the device's configuration using the front
panel buttons.
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Optical port

)

An optical port facilitates infrared communication with the device. For details on how to configure
and use this port, see "Serial connections" on page 96.

Master reset button

MASTER
RESET

[¢]

You must remove the meter's cover as well as the front panel label to access the master reset
button; it is located in the lower left of the faceplate. This button is recessed to prevent accidental
activation. For instructions on removing the meter cover and performing a master reset, and
information on what parameters are reset, see "Performing a master reset from the front panel" on
page 201.

Use the master reset button to delete most accumulated values and all derived revenue
measurements from the meter.

TEST mode button

TEST
MODE

(=

The TEST mode button is located under the meter's external cover assembly; it places the meter
into TEST mode. While in TEST mode, the meter stops accumulating billable quantities; energy and
demand measurements are accumulated in TEST mode registers.

See "TEST mode" on page 31 for more details on this mode of operation.
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Display screen types

The front panel displays measurements, event logs, phasor diagrams, bar graphs, harmonics
histograms, configured settings and configuration data. The types of display screens are described
below.

As shown in the graphics in the following sections, the display screen is divided into two sections:
the main display area and the status bar. The main display area presents meter data and status
information; the status bar provides time, date, phase, quadrant, and mode information. During
normal operation, the main display area automatically cycles through a series of several displays. If
you prefer, you can use the up or down arrow buttons to step manually through these displays. By
default, the automatic scrolling resumes 60 seconds after you have pressed a button.

NOTE: To adjust the contrast, hold down the up and down arrow buttons simultaneously. When
the contrast reaches the desired level, release the buttons.

For information on customizing the display on your meter, see "Displays" on page 185.

The status bar
The status bar runs along the bottom of the front panel display and contains information about the
following settings:
+ Date and time (in 24-hour format).

» Voltage phases present. The labels and rotation of phases correspond to the configuration of
the power monitoring system.

* Quadrant where the system power factor resides.
* Mode (NORM, ALT or TEST).

+ Time remaining in the sliding window (or rolling block) demand interval. If the interval has
counted to zero, the letters EOI (End Of Interval) appear on the status bar.

Peak demand reset count

o 2
12/09/2009 9:15:33

9:36:54 12/09/2014 ABC Q1 NORM H 1 11m —@

A Main display
B Status bar

Numeric displays

All NORM mode data and some of the ALT mode display screens use numeric displays. Numeric
displays show up to four parameters at a time. If no numeric values are available for a parameter,
N/Ais displayed.
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Peak demand reset count

2

12/09/2009  9:15:33
9:36:54 12/09/2014  ABC Q1 NORM E—_]1im

By default, the front panel automatically scales the units for basic measurements (such as voltage,
current and power parameters). For example, a measurement of 2,000 Watts is displayed as 2 kW.
A measurement of 2,000,000 Watts is displayed as 2 MW. The meter makes these conversions
using your PT and CT ratios.

The meter only performs automatic unit scaling if the displayed measurement is derived solely from
the Power Meter module’s output and the display units are set to default. See "Displays" on page
185 for more information.

Nameplate display and event log

Nameplate displays and event logs appear in ALT mode and are organized in tabular format.
Nameplate displays show owner, meter and power system details:

OWNER Best Utility
TAG 1 Substation 13A
TAG 2 Main Feed 13kV
FW Rev, FEATURE SET 004.020.000,A
BATTERY LIFE 96.9% DIAG NUM 41/999
9:36:54 12/09/2014 ABC Q1 ALT NH_111m

The Event Log displays recent high priority events (you must use software such as ION Setup to
retrieve all logged event data):

DATE TIME EVENT CODE
12/08/2014 10:23:45 Shutdown SD25
12/08/2014 10:42:03 Power Up SD25

12/08/2014 11:19:26 Changed Setup  SD25
ADDITIONAL LOGS - READ THROUGH COMMS
9:36:54 12/09/2014 ABC Q1 ALT HE_11Im

Histogram displays

Harmonic content is displayed in histogram format. The 2nd to the 63rd harmonics (31st on the
ION8650C meter) are displayed in the histogram. The total harmonic distortion (THD) is displayed
above the histogram.
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VA HARMONICST

HD: 50%

0:36:54 12092014 ABC Q1 AT B 11m

Phasor diagram displays

Phase information can be displayed in phasor diagram format. Phasor diagrams are accompanied
by tables that show phase, voltage and current magnitudes. In cases where a phase vector is too

small to be represented graphically, it is shown as atable entry only.

ve IC Vo BAEKV 0

Vb BBSKV 240

Ve o 846KV 120

VA la  2006A 20

1B, & 1A b 2106A 220

lc  2045A 100

9:36:54 12/09/2014  ABC Q1 ALT  E_11Im

Disk simulator

This display simulates the behavior of a mechanical watt-hour meter indicating power received or
delivered by the direction of the pulse.

KkWh disk simulator 14

9:36:54 12/09/2014  ABC Q1 NORM H—_111m

Time and date

This display supports time and date formats, enabling displays with nothing but date and/or time
and/or time remaining in the current interval.

9:36:54
12/09/2014

9:36:54 12/09/2014 ABC Q1 NORM H__111m
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Time-stamped values

Up to three timestamped parameters can be displayed on the same screen. The timestamp
indicates when the displayed parameter was last updated.

kW block peak deliver 000001
12/09/2010 7:30:00
kVA  block peak deliver 000002
12/09/2010 7:30:00
kVAR block peak deliver 000001
12/09/2010 7:30:00
9:36:54 12/09/2014  ABC Q1 NORM E——_111Im

Modes of operation

The meter has three modes of operation: NORM, ALT and TEST. Both NORM and ALT are display
modes, providing various power system data and meter properties screens. TEST mode is used to
perform diagnostics, verify the meter's accuracy, and verify meter functions.

NOTE: You can customize the display screens and alter the front panel’s scrolling characteristics
by editing the meter's Display and Scroll modules —refer to "DISPLAY SETUP menu" on page 41
for information on changing display settings and "Displays" on page 185 for information on
customizing the displays.

Basic operation (NORM mode)

The meter defaults to NORM mode when powered up, and remains in this mode until you manually
switchto ALT or TEST.

NORM mode screens are described in "NORM mode display screens" on page 189.

Meter configuration and NORM mode

» For meters without the hardware lock, all the settings available in the front panel SETUP menu
can be changed while the meter is in NORM mode, provided you have the correct password.

» For meters with the hardware lock, only the basic communications parameters in the COM
Setup menu can be changed in NORM mode. You must enter TEST mode to change other
meter parameters on the hardware-locked meter — see for more details.

ALT mode

ALT mode provides scrolling display screens that show power system data, billing information and
meter properties such as nameplate information.

ALT mode screens are described in "ALT mode default display screens" on page 190.
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Switching to ALT mode

Press the ALT/ENTER button to switch to ALT mode. Press the ALT/ENTER button again to
switch back to NORM mode at any time. If no buttons are pressed, the meter automatically reverts
to NORM mode after five minutes. As with any mode, pressing any button temporarily suspends
display screen scrolling, allowing you to press the up or down arrow buttons to manually browse the
available screens.

TEST mode

NOTE: If your meter has the optional hardware lock, you must remove the meter’s cover to put it
into TEST mode. See "Device security capabilities" on page 56 for more information.

TEST mode is typically used for meter function verification. The meter is usually reading data from a
test power supply while these functions are performed.

All the billing quantities that are recorded when the meter is in NORM and ALT mode stop
accumulating when the meter is switched to TEST mode — the data is sent to special TEST mode
registers instead. The values accumulated in these test registers are displayed on the front panel
(and in the Vista component of Power Monitoring Expert).

The regular NORM/ALT mode billing registers are unaffected while the meter is in TEST mode;
accumulation of billing data resumes as soon as you exit TEST mode. All test registers are reset to
zero when you exit TEST mode.

For detailed information on TEST mode, see "Switching to TEST mode" on page 195.

NOTE: The meter always returns to NORM mode when you exit TEST mode, even if you entered
TEST mode from ALT mode.

Configuring the meter with the front panel

Using the meter’s front panel, you can navigate through different menus to perform basic setup on
your meter.

NOTE: If you have a hardware-locked meter, only the basic communications parameters can be
changed in NORM mode. You must enter TEST mode to change other meter parameters on the
hardware-locked meter. See for more details.

Accessing the SETUP menu

To access the SETUP menu, press and hold the front panel's ALT/ENTER button while the meter
is displaying power system data. Within the SETUP menu is a list of sub- menus that contain the
meter’s configurable settings. The menu items are described in "Front panel features" on page 24.

Press the up or down arrow buttons to navigate through the menu. Highlight a menu item and press
the ALT/ENTER button. When you select an item from the SETUP menu, you are presented with
another menu of the settings in the meter. You may need to navigate several layers of menus to
access the setting you want to change.

The following diagram shows how the buttons are used to navigate the menus:
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240110
Ib 28513

Press and Hold

i 2nru_& 8650 SETUP
In 02| dien SECURITY -
30 A A 0 WO e - RETURN

PN £ASIC SETUR
Fress S| COMT SETUP
COM2 SETUP
s COM3 SETUP
avell,  COM4 SETUP

[~ aur/

EKTER Frass

VOLTS MODE

DE
FTFRIMARY

The settings contained in the SETUP menu are:

SETUP
1

BASIC SETUP W COM3 SETUP ENABLED COM PORTS

+ VOLTS MODE + PROTOCOL + COM1

+ PT PRIMARY i+ BAUD RATE v COM2

» PT SECONDARY = TRANSMIT DELAY +{ COM3

i CT PRIMARY » UNIT ID » COM4

+ CT SECONDARY » SERIAL PORT + ETHERNET

+ VA POLARITY  UNDO & RETURN

l VB POLARITY o COM4 SETUP L REBOOT

+ VC POLARITY

{iroLARITY ferorocar
J 1B POLARITY  BAUD RATE
L 1C POLARITY 1 TRANSMIT DELAY + PHASE LABELS
'+ PHASE ROTATION f» UNITID + PF SYMBOL
{4 SERIAL FORT + DIGIT GROUP
s RS485 BIAS +| DATE FORMAT
-+ SHOW DST
W PROTOCOL 4. o VOLTS DECIMAL
| BAUD RATE '+ CURRENT DECIMAL
-+ TRANSMIT DELAY |+ IP ADDRESS + POWER DECIMAL
s UNIT ID Ly MASK
W SERIAL PORT Is GATEWAY .
+ RS232 or RS485 I» SMTP ADDRESS
| RT/CTS HANDSHAKE Ly MAC ADDRESS -+ UPDATE RATE
+ RS485 BIAS | PORT ENABLE '+ CONTRAST

BACKLIGHT TO

Ll
ad CELL SETUP i+ DMD LOCK TO

+ TEST MODE TO

PROTOCOL = IP ADDRESS + DISPLAY SCALE
BAUD RATE s MEID + SCALING MODE
TRANSMIT DELAY ~ PROTOCOL 1-6 4 DELTA VECTORS
UNIT ID = PORT NUMBER 1-6

SECURITY

¥

MODIFY PASSWORD

W WEB CONFIG

Each of the main setup screens and the settings you can configure are discussed in "Setup menus”
on page 34.
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NOTE: Your display may appear differently than shown, depending on your meter's model and
configuration.

NOTE: The ENABLED COM PORTS setup menu only appears on the ION8650C.

Navigating the front panel screens

Use the up and down arrow buttons to scroll through the menu items. When the setting you want to
change is highlighted, press the ALT/ENTER button.

To return to a previous screen, use the up or down arrow button to highlight the RETURN menu item
and then press the ALT/ENTER button.

8650 SETUP

VOLTS MODE
FT FRIMARY
.

ALT
rrrrr

Configuring parameters using the navigation buttons

Use the up or down arrow buttons to change the value (if numeric) or the setting (if enumerated) of
the highlighted parameter.

To change the position of the cursor, press the up or down arrow buttons for about one second. The
up arrow button moves the cursor one position to the left and the down arrow button moves the
cursor one position to the right. Once you have the value you want, press the ALT/ENTER button to
select it.

NOTE: When setting Ethernet values (IP address, default gateway, etc.), press the up arrow
button to insert additional digit spaces. Press the down arrow to remove digit spaces (see
"NETWORK SETUP menu" on page 38 for more information).

OUT OF RANGE screen

When editing numeric data, the numbers displayed on the screen below MIN and MAX indicate valid
entry bounds. If you enter a value outside valid bounds, you are presented with a message stating
that the value is out of range. You can then either return to the register you were editing or choose to
exit.

Entering the front panel password with basic security enabled

With basic security enabled on the meter, you are presented with the password screen when you
attempt to change a setting on the front panel. After you enter the correct password, you do not have
to re-enter it for other any other changes unless you exit the configuration session, or the session
has elapsed.
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ENTER PASSWORD
0000000

X [Y8 ol
00000000 PRI

HOLD ARROW KEY TO MOVE CURSOR

To enter the password:

1. Use the arrow buttons to change the value of the highlighted digit. The up arrow increments
the number and the down arrow decrements it.

2. Hold down an arrow button for about one second to change the position of the cursor. The up
arrow moves the cursor left one position and the down arrow moves the cursor right one
position.

3. Press the ALT/ENTER button once you have the value that you want.

CONFIRM CHANGE
YES
NO

Advanced security username and password

If advanced security has been enabled on your meter, you are required to provide your username
and password when changing the meter’s settings through the front panel. See "Managing user
accounts" on page 67 for more information

Confirming configuration changes

The CONFIRM CHANGE screen appears when you attempt to change the meter’s settings through
the front panel. This allows you to cancel an unwanted configuration change. The front panel also
informs you when an entry is out of range. Select YES to confirm your change or NO to cancel it,
then press the ALT/ENTER button to return to the previous setup screen.

Setup menus

The following sections describe the setup menus in more detail.

BASIC SETUP menu

The BASIC SETUP menu lets you set volts mode, potential transformer (PT) and current
transformer (CT) ratios and various other settings (such as voltage and current polarities) so that
you can ensure that your meter is adequately set for your application.

To access the BASIC SETUP menu with the meter’s front panel:

1. Press and hold the ALT/ENTER button on the front panel of the meter. After about three
seconds the SETUP screen appears.

2. Use the up or down arrow buttons to navigate to the BASIC SETUP menu. Press the
ALT/ENTER button.
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Menu item

3. Press the up or down arrow buttons to navigate to the appropriate parameter, then press the

ALT/ENTER button to edit the parameter.

Many of these settings are configured when the meter is initially put into service (the device
will not operate properly until Volts mode and PT and CT ratios are set), but some settings
may need to be changed to refine the device’s operation.

NOTE: If you have a hardware-lockable meter, you must put the device into TEST mode
prior to making changes to the BASIC SETUP parameters. For TEST mode information, see

"TEST mode" on page 31.

The BASIC SETUP menu has the following settings:

Setting options

Default

Description

Volts mode!

PT Primary’
PT Secondary’
CT Primary’

CT Secondary

VA Polarity

VB Polarity

VC Polarity

IA Polarity

IB Polarity

IC Polarity

Phase Rotation

* 9S -4 Wire Wye/Delta

» 29S -4 Wire Wye

+ 35S -3Wire

+ 36S -4 Wire Wye

* Demo

1.0 t0 999999.00

1.0 t0 999999.00

1.0 t0 999999.00

1.0 t0 999999.00

* normal
* inverted
* normal
* inverted
* normal
* inverted
* normal
* inverted
* normal
* inverted
* normal
* inverted
« ABC

+ ACB

*See note

120

120

NORMAL

NORMAL

NORMAL

NORMAL

NORMAL

NORMAL

ABC

The power system’s configuration and
supported form factor. 36S - 4 Wire Wye is
only available on the socket meter.

Note: The default setting varies depending
on the meter form factor. Ensure you verify
that the correct option is selected for your
power system before putting the meter into
service.

The Potential Transformer’s primary winding
rating

The Potential Transformer's secondary
winding rating

The Current Transformer’s primary winding
rating

The Current Transformer’s secondary
winding rating

The polarity of the Potential Transformer on
VA1

The polarity of the Potential Transformer on
V2

The polarity of the Potential Transformer on
V3

The polarity of the Current Transformer on I1

The polarity of the Current Transformer on 12

The polarity of the Current Transformer on I3

The expected rotation of the voltage phases
(ABC or ACB)
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1These registers are typically set when the device is commissioned. Changing the values of these registers while the device

is in service is not recommended.

COM port setup menus

See "Communications overview" on page 92 more information on configuring meter
communications.

To make changes to communications settings with the meter’s front panel, hold down the
ALT/ENTER button for three seconds to enter the SETUP menu, then press the down arrow button
to select the COM SETUP you want.

Depending on the communications options ordered with your meter, the following menu items are

available:
Menu item Description
COM1 Setup Settings for the selectable RS-232 or RS-485 communications port.
COM2 Setup Settings for the internal modem port.
COMS3 Setup fSrce);[]ttirE)%sn (fa?rthe optical communications port located on the meter’s
COM4 Setup Settings for the COM4 RS-485 port.
Network Setup Settings for the Ethernet communications port.
Cell Setup Settings for the cellular modem port.
Set which two COM ports are enabled for communication, in
Enabled COM Ports addition to COM3 (front optical port) which is always enabled. This
menu is only available on the ION8650C.

NOTE: For hardware-locked meters, you must be in TEST mode to alter these COM port settings.

Serial COM port settings

There are three main parameters that you must set or verify if your meter is connected to a serial
network (including modem communications): Unit ID, Baud Rate, and Protocol.

NOTE: Other parameters such as TRANSMIT DELAY are used in advanced configuration or fine-
tuning your system. The main parameters are the most common parameters required to get your
meter communicating.

To configure the COM port settings:

1. Press and hold the ALT/ENTER button on the front panel of the meter. After about three
seconds the SETUP screen appears.

2. Use the up or down arrow buttons to navigate to the COM port that you want to configure.
Press the ALT/ENTER button.

3. Press the up or down arrow buttons to navigate to parameter you want to edit then press
ALT/ENTER.

4. Use the up and down arrow buttons to change the value of the parameter then press
ALT/ENTER.
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The menu items, and their setting options and default configurations, are listed in the following table
for COM1 (selectable RS-232 or RS-485), COM2 (modem), COMS (optical port) and COM4 (RS-

485).

Menu item

Default

Applies to...

All

All

All

All

COM!1

COM1
(RS-232 only)

COM!1

(RS-485 only)
and COM4

COM1, COM3
and COM4

Protocol

Baud Rate

Transmit Delay

Unit ID

RS232 OR
RS485

RTS/CTS
Handshake

RS485 Bias

Serial Port

Setting options

All COM ports: None1, ION,
Modbus RTU, DNP V3.00,
DLMS,

GPS:TrueTime/Datum2, GPS
Arbiter2, GPS Arbiter-Vorne2,
Factory

Additional protocols on COM1
and COM4: Modbus Master3,
EtherGate4, ModemGate3

300, 1200, 2400, 4800, 9600,
19200,
38400, 57600, and 115200 bps

0.0t01.0s.

1t0 9999

RS232 or RS485

RTS/CTS or RTS with Delay

OFF or ON

801, 802, 8N1, 8N2, 8E1, 8E2

ION

9600 bps

0.01s (10ms)

COM¢1: Unit ID
is based on the
serial number>.

COM2: 101
COM3: 102
COM4: 103

RS485

RTS with
Delay

OFF

8N1

Description

Specifies the protocol used by
the communications port.

Specifies the baud rate of the
serial port. Ensure all devices on
the same loop are configured to
use the same baud rate.

The amount of time in seconds
that the meter waits for
communications
acknowledgments.

Sets the meter Unit ID.

A unique Unit ID is required for
each device (including all the
devices on a ModemGate or
EtherGate serial loop).

Specifies the communications
mode used by COM1.

Specifies the flow control used
by the communications port.

Enables or disables RS485
biasing. See "RS-485 biasing"
on page 100 for more
information.

Sets the parity and data format.
For example, 8N1 is eight (8)
data bits, no

(N) parity bit and one (1) stop bit.
Ensure that all devices on the
same loop are set to the same
format.

1Select None from the Protocol setting options to disable the COM port.

23ee"Time synchronization" on page 135 for more details about GPS settings. See also the Time
Synchronization & Timekeeping technical note for further details on using the meter’s time
synchronization functions.

3Modbus Master is not available on the ION8650C.

4See "Configuring Ethemet connections" on page 103 and "Internal modem connections" on page
109 for more details.

SUnit ID for COM1 is based on the meter’s serial number. For example, if the serial number is PA-
0009B263-01, the Unit ID is set in the factory to 9263.
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NETWORK SETUP menu

There are two main parameters that you must set or verify if your meter is connected to an Ethernet
network: |IP address and subnet mask address.

NOTE: There are other parameters, such as GATEWAY ADDRESS and SMTP ADDRESS, that
are used in advanced configuration or in fine tuning your system. The main parameters are the
most common parameters required to get your meter communicating.

The menu items, and their setting options and default configurations, are as follows:

Menu item Setting options Default Description

IP Address  0.0.0.0t0255.255.255.255  None Sets the P address for the
Used if subnet masking applies
to your network

Mask 0.0.0.0 to 255.255.255.255 None ~HED LT T &

administrator to determine if
subnet mask is used.

Used in multiple network
configurations

Gateway 0.0.0.0 to 255.255.255.255 None — see your network
administrator to determine if
gateway is used.

Sets the IP address for the
SMTP mail server that is
configured to forward mail from
the meter to the final

SMTP 0.0.0.0 to 255.255.255.255 None T
Address
— see your network
administrator to determine if
the SMTP mail serveris used.
Read-only factory-set The MAC address is read-only and provided for
MAC Address hexadecimal value information purposes only.

» Webserver
- FTP

* DNPoverTCP Specifies whether the network

Yes ports are enabled or disabled.

Port Enable ION over TCP

* Modbus over TCP
« Modbus TCP

Most network settings can be configured through the front panel; all network settings can be
modified in Power Monitoring Expert or ION Setup. See "Configuring Ethernet connections" on page
103 for more information.

NOTE: Configuring the IP Address, Mask, Gateway, and Port Enable settings incorrectly can
cause network disruptions. See your Network Administrator for more information.
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NOTICE

DATA LOSS

Maintain sufficient access to communicate to and configure your device.

Failure to follow these instructions can result in data loss.

Typically, your network administrator provides you with the appropriate IP address for the meter.
The subnet mask and gateway settings are only required if you have communications between
multiple Ethemet networks and if subnetting is implemented.

Use the navigation buttons to edit the values of the network settings so that they match your
system addresses. As you configure the network addresses, the front panel automatically discards
unnecessary leading zeros from each three-digit grouping. The hidden leading zeros appear (and
disappear again) as you move the position of cursor across the network address.

89.123.40.[056

In the example above, the highlighted zero is discarded as soon as you change the position of the
cursor.

CELL SETUP menu

The CELL SETUP menu contains the following values that configure the cellular modem:

Menu item Setting options Default Description

Not Displays the IP address
: assigned to the cell modem by
configurable the network

f Not Displays Mobile Equipment
MEID/CCID  Not configurable configurable  Identifier

Specifies the protocol used for
connection 1-6

Port Number 1- Specifies the port number to
6 1-65535 0 establish connection 1-6

IP Address 0.0.0.0 to 255.255.255.255

None, ION, Modbus TCP,
Protocol 1-6 DNP 3.0 None

» Webserver
- FTP
* DNPover TCP
IP Address Yes
* ION over TCP

* Modbus over TCP

* Modbus TCP

NOTE: To disable the connection to a port, set the Protocol to None. This allows you to restrict the
number of simultaneous connections to the meter through the cell modem.
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ENABLED COM PORTS menu (ION8650C only)

Up to three COM ports can be active simultaneously on the ION8650C. COM3 (the front optical
port) is always enabled. The ENABLED COM PORTS menu allows you to select the other two
COM ports that you want enabled.

NOTE: A meter restart is required to change the enabled communications ports.

Menu item Description

COoM1 Specifies whether COM1 (RS-232/RS-485) is enabled or disabled.
COM2 Specifies whether COM2 (modem) is enabled or disabled.

COmM3 COM3 (front optical port) is always enabled.

Com4 Specifies whether COM4 (RS-485) is enabled or disabled.

Ethernet Specifies whether the Ethernet port is enabled or disabled.

Wi & Bl Fe)ga?rcterc‘je menu with no changes to the COM ports. No meter restart
Reboot ng;?t;té the meter. The changes are applied when the meter

The default settings vary depending on your order option. See your meter’s Installation guide for
details.

See "ION8650C communications options" on page 95 for details on changing the enabled COM
ports.

FORMAT SETUP menu

The FORMAT SETUP contains the following values that set labeling and formatting preferences:

Menu item Setting options Default Description

ABC, 123, RWB, RYB, XYZ, Specifies how phases are
Phase Labels orRST ABC labeled.
PFSymbol  LD/LG, +/-, or CAP/IND LD/LG Specifies the symbol pair

used to indicate power factor.

Numbers of three digits or
greater can be grouped in any
of the following three formats:

Digit Group 1000.0, 1,000.0 or 1 000,0 1000.0 1000.0 (no commas, no
spaces) or 1,000.0 (commas,
no spaces) or 1 000.0 (no
commas, spaces).

YYYY/MM/DD, -
Date Format ~ MM/DD/YYYY or DD/ MM/DD/YYYY g.gefe"f'zz o CEESEND
MM/YYYY ISplayed.

. : You can choose to display
ShowDsT ~ panetdisplayDSTorDisplay pigpiay psT  Daylight Savings Time (DST)
or not.

Number of decimal places
displayed for voltage values
Volts Decimal 1. to 123456789. XXX 1.XX (up to 9 digits before the
decimal place and up to 3
digits after the decimal place).
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Default

Description

Menu item Setting options
Current 1. to 123456789.XXX
Decimal ) :
Power

Decimal 1. to 123456789. XXX

1.XXX

1.XXX

Number of decimal places
displayed for current values
(up to 9 digits before the
decimal placeand upto 3
digits after the decimal place).

Number of decimal places
displayed for power values (up
to 9 digits before the decimal
place and up to 3 digits after
the decimal place).

DISPLAY SETUP menu

You can configure the following display preferences:

Menu item

Setting options

Default

Description

Update Rate  1s, 2s, 3s, 4s, 5s, or 6s
Contrast 0to9
Backlight TO  0to 7200

DMD Lock TO 0to 5184000

TEST mode

TO 60 to 21600

Display Scale 1.0to0999999.0
Scaling Mode  Multiply or Divide
Delta Vectors  System or Instrument

1s

300

2160000

1800

1000

Divide

Instrument

The front panel can update its
data from every 1to every 6
seconds.

A front panel display contrast
level can be set from 0 to 9
where higher numbers
represent a sharper level of
contrast. You can adjust the
contrast level at any time by
pressing and holding down both
up and down arrow buttons
simultaneously.

Backlight timeout: this
selection allows you to make
the backlight turn off
automatically after 0 to 7200
seconds (two hours). If this
value is set to 0 (zero), the
backlight is always on.

Demand lockout time (in
seconds) controls the minimum
allowable time between
consecutive demand resets.
You can select values from 0
(disabled) to 5184000 (60
days).

If there are no front panel key
presses, the meter exits TEST
mode automatically; the TEST
mode timeout setting defines
how long the meter remains in
TEST mode before switching
to norm mode. While in TEST
mode, the value on the bottom
right of the status bar indicates
the amount of time before
TEST mode times out.

Scale applied to values before
they are displayed.

Specifies whether values are
divided or multiplied by the
Display Scale before being
displayed.

Specifies how vector diagrams
are displayed when in Delta
mode.
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SECURITY menu

8650 SETUP
DISPLAY SETUR

SECURITY
RETUIRN

The settings in the front panel SECURITY menu allow you to:
+ Modify the existing meter password or reset it to the factory default.

+ Enable web browser configuration on the meter.

A valid password is required in order to enter the SECURITY menu. The default password is 0
(zero).

See "Cybersecurity" on page 54 for information on meter security, including security
recommendations, password best practices and instructions on configuring security through the
front panel.

If your device’s front panel or user passwords are lost, you must return the device for factory
reconfiguration, which resets your device to its factory defaults and destroys all logged data.

NOTICE

DATA LOSS

Record your device's front panel and user password information in a secure location.

Failure to follow these instructions can result in data loss.
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Templates and firmware

Your meter comes installed with a preconfigured default template. This template contains various
frameworks which provide all the power measuring and analyzing functionality of the meter. The
default templates and frameworks can be used immediately without any user configuration. They
can also be customized, reconfigured, and pasted from one meter to another.

For more information on templates, frameworks and ION modules, see the /ION Reference.

Firmware is your meter’s operating system. When newer firmware is available for your meter,
simply upgrade to the latest version for all the added features and functionality.

In this chapter

Factory INfOrmMation ... L 44
Updating or restoring the template ... ...l 45
Upgrading Your Meter il 47

7EN02-0306-05
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Factory information

The Factory module displays firmware version, serial number and other device information in read-
only setup registers (read-only registers can be viewed but not changed) or configurable information
in read/write setup registers.

Factory Module settings

The device information provided is as follows:

Setup register Description

Device Type A device type identifier (for example, “8650” for the ION8650)

Compliance A statement of whether the device is ION compliant or not

Options Shows model number of meter

Revision The meter’s firmware version

Serial Num The meter’s serial number

ION Version The ION version supported by the device

Template The name of the template (framework) installed on the device at the
factory

Nom Freq The expected frequency of the power system being monitored

MAC Address Media Access Control address’

Feature Set The feature set of the meter (ION8650A, ION8650B or ION8650C)

1 The MAC address of your meter cannot be changed; it is forinformation only.

The Factory module also holds the alternate PT and CT values, which can scale operational values
on revenue-locked meters (see "Scaled operational values" on page 171 and numerous read-only
setup registers that hold the calibration constants used at the factory.

TAG your meter
Three configurable read/write setup registers are provided for you to enter your company name and
other text information you want stored in the meter:

» Owner: A text register for storing user information (for example, company name). It can be up to
255 characters in length.

+ Tag 1: A text register for storing user information (for example, device location). It can be up to
15 characters in length.

+ Tag 2: Atext register for storing user information (for example, device number or identifier). It

can be up to 15 characters in length.

NOTE: Tag 2, if entered, it is used as the default MV-90 Device ID. Refer to the MV-90 and ION
Technology technical note for more information.
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Updating or restoring the template

You may need to update or restore the meter’s template:

+ If there is a new template with additional features or if you have configured one meter and want
to configure others with the same settings.

+ If you have made changes and want to return to the original configuration. The basic setup of
the device can be retained, so the does not need to be taken out of service for a long period of
time.

If you restore the factory configuration, all recorded data and any custom features that you have
created (such as custom alarms or custom data recorders) are lost.

NOTICE

DATA LOSS

Ensure all important data from the device has been retrieved before you restore the factory
configuration.

Failure to follow these instructions can result in data loss.

Use Power Monitoring Expert or ION Setup to upgrade or restore the template.

Meter I/0 module behavior

Your meter’s I/O modules may change state during a firmware upgrade. The meter's 1/O behavior is
determined by how it is configured in the new template that has been loaded.

A WARNING

HAZARD OF UNINTENDED OPERATION

» Do not use the meter for critical control or protection applications where human or equipment
safety relies on the operation of the control circuit.

» Be aware that an unexpected change of state of the digital outputs may result when the supply
power to the meter is interrupted or after a meter firmware or template upgrade.

Failure to follow these instructions can result in death, serious injury, or equipment
damage.

Using the front panel

You cannot restore the factory configuration from the meter’s front panel.

Using ION Setup
1. Obtain the meter template that you want to update or restore:

— Download your meter’s factory template or an update template from www.schneider-
electric.com.
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— Save ayou have configured on another meter. See the ION Setup Help for instructions.
Save the .DCF file. The default template file locationis .../ION Setup/ TEMPLATE.
Start ION Setup.
Open the Setup Assistant for your meter. See ION Setup help for instructions.
Select the Template screen.

Click the Send to Meter tab then click Send. The Open ION8650 DCF file dialog box
appears. Navigate to the location where you saved the .DCF file.

Select the .DCF file and click OK. The Template Paste Options dialog box appears. Select
the check boxes for the settings you want to retain (not overwrite) and click OK.

Rapid Meter Programming pastes the template onto your meter. A dialog box confirms the paste
was successful.

Using Designer

See Power Monitoring Expert help for detailed instructions on updating and restoring templates and
frameworks.

NOTE: The time required to complete the steps in this procedure can vary depending on your
connection and the meter configuration. Some steps may take several minutes to complete.

1.
2.

Open your meter in Designer. Ensure that the meter's main Configuration screen is displayed.
Click Edit > Select All then press DELETE.

A confirmation dialog box appears explaining that some modules will not be deleted (core
modules cannot be deleted — scroll down in the dialog to see which standard modules will be
deleted).

Click OK on the confirmation dialog box.

The modules are deleted (other than persistent and core modules). You may get a message
stating that persistent modules could not be deleted. Click Continue.

The main meter Configuration screen is blank except for a folder that contains the modules
which cannot be deleted.

Click Edit > Select All to select the Frameworks folder. This selects all sub-folders and
modules within the folder.

Click Edit > Paste from Framework, then select the appropriate .fwn file from the folder
\ION Enterprise\config\fmwk\nd\. Click Open.

NOTE: The Factory module’s Default Template register tells you the filename for the default
factory framework. For details about framework files, contact Technical Support or visit
www.se.com.

The Paste Summary dialog box appears.

Click on the first module, scroll down to the last module, hold the SHIFT key and click on the
last module. This selects all of the modules.
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7. Continue holding the SHIFT key and click on the check box to the left of the module name. A
lock icon with a green check mark appears; this performs a lock-paste of the modules.

NOTE: Persistent modules can be overwritten in Designer. When pasting a default
framework onto a meter, use lock-paste on the Persistent modules, not free-paste. A list of
Persistent modules is available from Technical Support.

8. Select the Maintain external inputs check box and click OK.

A message appears indicating that Designer is pasting modules. All modules are selected
when the paste is complete. Click anywhere in the background of the node diagram to
deselect all of the modules.

9. Click the Power Meter shortcut in the Basic Configuration area to select it. Click the Reset
icon or select Edit > Reset. This reverts the Power Meter to the settings it had before you
deleted any modules (retaining your original basic setup).

10. Click File > Send & Save. If you receive a message stating that the operation is incomplete,
click Continue then click File > Send & Save again.

Upgrading your meter

You can upgrade the firmware (operating software) and template on your meter using either Power
Monitoring Expert or ION Setup.

General upgrading considerations

Upgrading to compatible firmware and template versions

Ensure that the firmware version that you are upgrading to is compatible with your meter and that
the version number is greater than your existing firmware (or else you will downgrade your meter).

Ensure that the template you are upgrading to matches the feature set of your meter (in other words,
if your meter is an ION8650A, the template must be an A-variant template). The variant is indicated
in the template filename.

You can download meter firmware and templates from www.se.com.

Recording your device’s usernames and passwords

Ensure that you record your device’s usernames and passwords prior to upgrading the device
firmware.

If your device’s front panel or user passwords are lost, you must return the device for factory
reconfiguration, which resets your device to its factory defaults and destroys all logged data.

NOTICE

DATA LOSS

Record your device's front panel and user password information in a secure location.

Failure to follow these instructions can result in data loss.
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See "Cybersecurity" on page 54 for more information on the device’s security settings.

Using a laptop computer to upgrade

Laptop computers generally have different default power properties than desktop computers.
Incorrect power options can adversely affect device upgrading because the connection between the
laptop and the device must be maintained in order to complete the upgrade successfully. If the
laptop’s hard disk shuts down or the laptop enters system standby mode, this connection is broken,
and the upgrade procedure must be restarted.

If you are upgrading a meter using a laptop computer, follow these guidelines:
* Plug the laptop computer into a wall outlet. Do not run the laptop on its battery.

+ Configure the hard disks so that they do not shut down after a certain period of time (for
example, set to “never”).

» Turn off power suspension (for example, system stand-by) and hibernate options.

+ Disable options that power down the laptop when it is closed. This prevents a shut down if the
laptop is accidentally closed.

» Disable the screen saver; screen savers can burden the CPU.

Upgrading devices via a ModemGate connection

The maximum acceptable baud rate for upgrading via ModemGate is 56.6 kbps. Ensure that the
baud rate on the ModemGate communications port and the baud rate on the meter to be upgraded
are set to this or lower.

Meter behavior when an upgrade fails

The meter allows three consecutive attempts to upgrade the meter. If the third attempt fails, an error
is generated, and you must power cycle the meter before you try again. Wait 30 seconds for the
meter to reset after power cycling it before you try to upgrade again.

Meter I/0O module behavior

Your meter’s I/O modules may change state during a firmware upgrade. The meter's 1/O behavior is
determined by how it is configured in the new template that has been loaded.

A WARNING

HAZARD OF UNINTENDED OPERATION

» Do not use the meter for critical control or protection applications where human or equipment
safety relies on the operation of the control circuit.

» Be aware that an unexpected change of state of the digital outputs may result when the supply
power to the meter is interrupted or after a meter firmware or template upgrade.

Failure to follow these instructions can result in death, serious injury, or equipment
damage.
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Accumulated energy values and upgrades
The firmware upgrade process clears accumulated energy values in the meter.

If you want to retain these values across a firmware upgrade, you can use the Register Edit feature
in ION Setup to manually restore pre-upgrade values back to your meter.

Upgrading firmware using ION Setup

Performing a device upgrade in ION Setup involves:
+ upgrading the device firmware, and
+ upgrading the device template.

You can download your device’s latest firmware and template from www.se.com. Save the files in
the .../ION Setup/ TEMPLATE folder for easy access.

Upgrading the device firmware and template

1. Open the Setup Assistant for your meterin ION Setup. See ION Setup help for instructions.
2. Select the Template screen.
3. Click the Firmware Upgrade tab, then click Upgrade. Enter your meter password (if

prompted) and click OK.

NOTE: If you want to retain customized meter template settings, other than those listed in the
Template Paste Options dialog box (see Step 6), click on the Save to PC tab and click Save. Save
your template as a .DCF file. Select this file in Step 5 instead of the file obtained from the website.

1. Browse to the .UPG file (device firmware) that you downloaded from the website and click
Open. Type your ION Setup password when prompted and click OK.

2. Browse to the .DCF file (device template) that you downloaded from the website (or saved
from your meter in Step 3) and click Open. The Template Paste Options dialog box appears.

3. Select the options that you do want to be retained and clear any options that you do not want
to retain then click OK.

4. Track the progress of the upgrade.

After the firmware download is complete, ION Setup attempts to verify the firmware. If the
verification fails, contact Technical Support.

5. Click Exit when you get a message that the upgrade is complete.
Upgrading firmware using Power Monitoring Expert
Power Monitoring Expert includes the Device Upgrader utility for upgrading devices.

NOTE: Supervisor-level access (level 5) is required to upgrade the device.

Before using Device Upgrader

Data stored in the meter's memory is lost during the firmware upgrade. This includes waveforms,
Min/Max values, and information stored in the Data Recorder and Integrator modules. Ensure you
save your meter’s data before you upgrade your meter.

7EN02-0306-05 Page 49 of 210



Templates and firmware

ION8650 User Manual

You need the applicable upgrade (.upg) files for your meter, which are available from www.se.com.
Save these files in a folder that is accessible from your Power Monitoring Expert computer.

For more information about using Device Upgrader, refer to Power Monitoring Expert help.

Using Device Upgrader

1.
2.
3.

Stop the ION Log Inserter Service and the ION Virtual Processor Service.
Start Management Console.

Select Tools > System > Device Upgrader. Type your username and password in the login
prompt.

A dialog box displays recommendations and warnings regarding the upgrade operation. Make
sure you read and understand these warnings before you click OK. If you need to implement
any changes because of the recommendations and warnings, close Device Upgrader, make
the changes then re-open Device Upgrader and continue.

The Device Upgrader utility appears.
Select your meter type from the List Devices of Type box.

Select the appropriate meter from Select Devices to Upgrade box. To select multiple
devices, hold down CTRL while clicking each device.

Click Select File in the Select Revision section. Locate and select the upgrade (.upg) file
that you downloaded from the website, then click Open.

Select or clear the Save/Restore Framework check box (selected by default). If selected,
this keeps a copy of your current framework template during the upgrade. After the firmware
upgrade is complete, Device Upgrader restores your framework template.

NOTE: Device Upgrader loads new meter firmware that does not contain any framework
templates. If you want to preserve customizations that you have made to your device
framework, make sure you select Save/Restore framework. However, if you intend to
replace the existing meter framework with a new one (for example, a new default meter
template that you downloaded), clear Save/Restore framework.

If you intend to replace the meter’'s framework configuration with a new template, it is
recommended that you upgrade using ION Setup. See "Upgrading firmware using ION Setup"
on page 49 for information.

Specify how Device Upgrader responds to an unsuccessful upgrade in the Failure Handling
section (you only need to do this if you are upgrading multiple devices):

— Select Halt After, then enter a number in the box to specify how many attempts you want
Device Upgrader to make before stopping during an unsuccessful upgrade. By default, the
utility is set to stop after the first unsuccessful upgrade.

— Select Ignore All to attempt to upgrade all of the selected devices regardless of the

number of devices that do not upgrade successfully.

NOTE: Firmware upgrade error codes are described in the Power Monitoring Expert online
help.
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9. Click Select File in the Select Revision section. Navigate to the upgrade (.upg) file that you
want to use and click Open.

This file will be downloaded to all the devices that are highlighted in the Select Devices to
Upgrade list.

10. Click Upgrade to upgrade the selected device(s).

The Upgrade Status box shows each stage in the upgrade process. The completed progress
bar indicates what percentage of the upgrade is complete. Each completed upgrade is noted in
the Upgrade Status box.

11. Restart the ION Log Inserter Service and the ION Virtual Processor Service.

NOTE: If connection to the device is lost, or if power to the device is interrupted during an
upgrade, restart the Device Upgrade utility procedure.

Editing accumulated energy values using ION Setup
You can edit energy values such kWh and kVARh using ION Setup.

NOTE: Ensure you have recorded accumulated energy values before upgrading your meter’s
firmware. You can then re-enter these values after the upgrade.

1. Start ION Setup.

2. Open the Setup Assistant for your meter.
3. Select the Template screen.
4

. Click the Register Edit tab, click Energy then click Display. Enter your meter’s password (if
prompted) and click OK.

The Register Editor screen displays.
5. Click Edit to enable editing.

6. Entervalues for kWh, kVAh and kVARNh as required. Click Send to finish. Only values that
have the checkbox selected will be sent to the meter.

7. Click Close to close the Register Editor screen.
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Basic setup

This chapter explains how to perform basic meter setup using the front panel, Power Monitoring
Expert or ION Setup.

Basic configuration of the meter is provided by the Power Meter module. The Power Meter module
is the main connection between the power system measurements and all other ION modules in the
device. This module reports the values for all voltage, current and power measurements. The Power
Meter module’s setup registers describe details of the power system being monitored.

Basic setup is typically performed when the meter is initially put into service, although the device
cannot operate properly until the Volts Mode and PT and CT ratios are set. After this basic setup is
performed the meter operates properly, and there is generally no need to make further changes to
the basic setup.

Other advanced parameters can be configured, if needed. See the description of the Power Meter
module in ION Reference for more information.

Basic setup parameters

Menu item Setting options Default Description
* 9S -4 Wire Wye/Delta The power system’s configuration and
supported form factor. 36S -4 Wire Wye is
+ 29S -4 Wire Wye only available on the socket meter.
Volts mode » 35S -3 Wire *See note Note: The default setting varies depending
on the meter form factor. Ensure you verify
+ 36S -4 Wire Wye that the correct option is selected for your
power system before putting the meter into
+ Demo service.
. 1 The Potential Transformer’s primary
PT Primary 1.0 t0 999999.00 120 o )
winding rating
1 The Potential Transformer's secondary
PT Secondary 1.0 t0 999999.00 120 o )
winding rating
The Current Transformer’s primary windin
CT Primary’ 1.0 t0 999999.00 5 _ L .
rating
The Current Transformer’s seconda
CT Secondary 1.0t0 999999.00 5 Lo . 3
winding rating
) * normal The polarity of the Potential Transformer on
VA Polarity NORMAL
* inverted Vi1
. * normal The polarity of the Potential Transformer on
VB Polarity NORMAL
* inverted V2
VC Polarity * normal NORMAL The polarity of the Potential Transformer on
* inverted V3
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Description

Menu item Setting options Default
e normal

IA Polarity NORMAL
* inverted
e normal

IB Polarity NORMAL
* inverted
* normal

IC Polarity NORMAL
* inverted
« ABC

Phase Rotation ABC
- ACB
« ON

ScaleRevParam ON
 OFF

The polarity of the Current Transformer on
11

The polarity of the Current Transformer on
12

The polarity of the Current Transformer on
13

The expected rotation of the voltage phases
(ABC or ACB)

Whether or not PT/CT correction is applied
to displayed and recorded meter data

1 These registers are typically set when the device is commissioned. Changing the values of these registers while the device

is in service is not recommended.

Configuring basic setup

Use the front panel, ION Setup, or Power Monitoring Expert to perform basic meter setup.

Using the front panel

Access the BASIC SETUP menu to configure the power system settings. See "BASIC SETUP

menu" on page 34 for instructions.

Using ION Setup

1. Open the Setup Assistant for your meter. See the ION Setup Help for instructions.

2. Select the Basic Setup screen and click the PT/CT Ratios tab.

3. Configure each register as required by selecting the parameter and clicking Edit.

NOTE: Scaled Rev Param determines if the PT/CT correction is applied to displayed and
recorded meter data. By default, Scaled Rev Param is set to ON and PT/CT corrections are

applied.

Using Designer

Open your meter in Designer and navigate to the Basic Configuration Framework. Right-click on the

Power Meter module to edit.
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Cybersecurity
This chapter contains up-to-date information about your product’s cybersecurity.
In this chapter
Cybersecurity OVervieW .. 55
Device security capabilities ...l 56
Product defense in depth ... . 58
Cybersecurity configuration . ... .. . 60
Useraccounts and privileges ... ... iiiiiiiiiil.. 66
PasSSWOIAS 69
Hardenthe device ... ... ... 76
Threat INtelligeNCE .. 79
Upgrades and security configuration ... 81
FaC OrY ACCESS ... 82
Secure disposal guidelines .. 86
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Cybersecurity overview

Network Administrators, System Integrators and personnel that commission, maintain or dispose of
adevice should:

» Apply and maintain the device’s security capabilities. See "Device security capabilities” on
page 56 for details.

» Review assumptions about protected environments. See "Protected environment
assumptions" on page 58 for details.

» Address potential risks and mitigation strategies. See "Potential risks and compensating
controls" on page 59 for details.

» Follow recommendations to optimize cybersecurity.

Your device has security capabilities that:

+ Allow it to be part of a NERC CIP compliant facility. Go to the North American Electric
Reliability Corporation website for information on NERC Reliability Standards.

« Align with cybersecurity standards in the IEC 62443 international standard for business IT
systems and Industrial Automation and Control Systems (IACS) products. Go to the
International Electrotechnical Commission website for information about the IEC 62443
international standard.

To report a security topic affecting a Schneider Electric product or solution, go to the Schneider
Electric Vulnerability Management Policy website.

A WARNING

POTENTIAL COMPROMISE OF SYSTEM AVAILABILITY, INTEGRITY, AND
CONFIDENTIALITY

» Change default passwords to help prevent unauthorized access to device settings and
information.

» Disable unused ports/services and default accounts, where possible, to minimize pathways
for malicious attacks.

» Place networked devices behind multiple layers of cyber defenses (such as firewalls, network
segmentation, and network intrusion detection and protection).

» Use cybersecurity best practices (for example: least privilege, separation of duties) to help
prevent unauthorized exposure, loss, modification of data and logs, interruption of services, or
unintended operation.

Failure to follow these instructions can result in death, serious injury, or equipment
damage.
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Device security capabilities

This section describes the security capabilities available with your device.

Standard meter security

Anytime you make configuration changes to your device, you must enter a password. Standard
security is enabled by default from the factory. See "Standard meter security" on page 61.

Advanced meter security

Advanced meter security restricts allowed actions to the authorized use of the control system. See
"Advanced meter security" on page 62.

Information confidentiality

These security capabilities help protect the confidentiality of information through secure protocols
that employ cryptographic algorithms, key sizes and mechanisms used to help prevent
unauthorized users from reading information in transit, i.e. SSH, SFTP, and information at rest.

Physical security

These security capabilities together with perimeter security help prevent unauthorized access to
revenue-related parameters and settings or leave clear evidence that the device has been physically
tampered with:

» Physical revenue-lock protection is used to help prevent unauthorized access to the meter,
parameter values and settings.

» The hardware-lock feature is an ordering option that locks the ION module parameters specific
to revenue data so that these parameters cannot be altered.

« Multiple anti-tamper sealing points are used to help prevent access and provide evidence of

tampering.

Configuration

These security capabilities support the analysis of security events, help protect the device from
unauthorized alteration, and record configuration changes and user account events:

+ Internal time synchronization.
+ Time source integrity protection and meter configuration event logging.
« Timestamps, including date and time, match the meter clock.

+ SSH server hosts an internal SFTP site and stores files in the meter’s flash memory, such as
COMTRADE records.

+ Settings can be saved as a Security Configuration File (.scf) using ION Setup.
» Embeds user information with changes.

+ Offload information to syslog or a protected storage or retention location.
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User accounts and privileges

These security capabilities help enforce authorizations assigned to users, segregation of duties and
least privilege:

User authentication is used to identify and authenticate software processes and devices
managing accounts.

Least privilege configurable in multiple dimensions: read; peak demand reset; time sync; test
mode; meter, security and communications configuration.

User account lockouts configurable with number of unsuccessful login attempts.
Use control is used to restrict allowed actions to the authorized use of the control system.
Supervisors can override user authorizations by deleting their account.

Password strength feedback using ION Setup.

Hardening

These security capabilities help prohibit and restrict the use of unnecessary functions, ports,
protocols and/or services:

Least functionality can be applied to prohibit and restrict the use of unnecessary functions,
ports, protocols and/or services.

Port numbers can be changed from default values to lower the predictability of port use.

Session lock is used to require sign in after a period of inactivity for SFTP, SSH and the display,
but not ION protocol.

Session termination is used to terminate a session automatically after inactivity or manually by
the user who initiated the session.

Concurrent session control to limit the number of concurrent sessions with each interface.

Threat intelligence

These security capabilities help provide a method to generate security-related reports and manage
event log storage:

Machine and human-readable reporting options for current device security settings.
Audit event logs to identify:

— Meter configuration changes.

— Energy management system events.

Audit record storage capacity communication to notify a user when the threshold is
approaching.

Audit storage capacity of 5,000 event logs by default and alternate methods for log
management.

Time source integrity protection and event logged when changed.
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Secure disposal

These security capabilities help release the device from active service and prevent the potential
disclosure of data:

NERC CIP

Purging of shared memory resources through device wiping and other decommissioning tasks.

Physical (recommended) or sustainable device disposal possibilities.

The North American Electric Reliability Corporation (NERC) has created Critical Infrastructure
Protection (CIP), a set of standards that can assist in monitoring and protecting the assets that
make up the power transmission system in North America. NERC CIP is made up of standards that
cover aspects such as critical cyber asset identification, electronic security perimeters, and
systems security management.

This meter has incorporated security features that can assist in making a facility NERC CIP
compliant.

For more information about NERC or the CIP standards, refer to the documentation located at
http://www.nerc.com.

Product defense in depth

Use a layered network approach with multiple security and defense controls in your IT and control
system to minimize data protection gaps, reduce single points of failure and create a strong
cybersecurity posture. The more layers of security in your network, the harder it is to breach
defenses, take digital assets or cause disruption.

Protected environment assumptions

Cybersecurity governance — Available and up-to-date guidance on governing the use of
information and technology assets in your company.

Perimeter security — Installed devices, and devices that are not in service, are in an access-
controlled or monitored location.

Emergency power — The control system provides the capability to switch to and from an
emergency power supply without affecting the existing security state or a documented
degraded mode.

Firmware upgrades — Meter upgrades are implemented consistently to the current version of
firmware.

Controls against malware — Detection, prevention, and recovery controls to help protect against
malware are implemented and combined with appropriate user awareness.

Physical network segmentation — The control system provides the capability to:

— Physically segment control system networks from non-control system networks.

— Physically segment critical control system networks from non-critical control system
networks.
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 Logical isolation of critical networks — The control system provides the capability to logically
and physically isolate critical control system networks from non-critical control system
networks. For example, using VLANS.

* Independence from non-control system networks — The control system provides network
services to control system networks, critical or non-critical, without a connection to non-control
system networks.

» Encrypt protocol transmissions over all external connections using an encrypted tunnel, TLS
wrapper or a similar solution.
« Zone boundary protection — The control system provides the capability to:
— Manage connections through managed interfaces consisting of appropriate boundary

protection devices, such as: proxies, gateways, routers, firewalls and encrypted tunnels.

— Use an effective architecture. For example, firewalls protecting application gateways
residing ina DMZ.

— Control system boundary protections at any designated alternate processing sites should
provide the same levels of protection as that of the primary site. For example, data centers.

» No public internet connectivity — Access from the control system to the internet is not
recommended. If a remote site connection is needed, for example, encrypt protocol
transmissions.

* Resource availability and redundancy — Ability to break the connections between different
network segments or use duplicate devices in response to an incident.

+ Manage communication loads — The control system provides the capability to manage
communication loads to mitigate the effects of information flooding types of Denial of Service
(DoS) events.

» Control system backup — Available and up-to-date backups for recovery from a control system
failure.

Potential risks and compensating controls

Address potential risks using the following compensating controls:

Area Issue Risk Compensating controls
Change the default
Default account settings If you do not change the  password of O (zero) to
are often the source of default password, help reduce unauthorized
User accounts . ]
unauthorized access by  unauthorized access can access. See
malicious users. occur. "Passwords" on page
69.
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Area Issue Risk Compensating controls

For transmitting data
over an internal network,
physically or logically
segment the network.

ION, Modbus, DNP, For transmitting data
DLMS, IEC 61850 and o over an external
If a malicious user

some IT protocols are ; network, encrypt

i gained access to your .
unsecure. The device protocol transmissions

Secure protocols network, they could
does not have the : over all external
o . intercept . .

capability to transmit . connections using an

. communications.
data encrypted using encrypted tunnel, TLS
these protocols. wrapper or a similar

solution. See "Protected
environment
assumptions" on page
58.

Cybersecurity configuration

Your device comes with security features that you can configure to help protect against
unauthorized configuration and access to your device’s data through its user interfaces or
communications.

These features arrive in a default state and can be configured for your installation needs. Please
note that disabling or modifying settings within the scope of these individual features can impact the
overall security robustness of the device and ultimately the security posture of your network in
either positive or negative ways.

SCF file

Security configuration settings selected in ION Setup are applied to the meter and can be saved as
a Security Configuration File (.scf). The security log file (SECURITY.LOG) contains the history of
Security Configuration Files saved from ION Setup.

The security log and Security Configuration Files are saved to the C:\ProgramData\Schneider
Electric\lON Setup\Security folder.

NOTE: The security log file can be changed by anyone with access to the ProgramData folder.

Recommendations to optimize cybersecurity in a protected environment:

» Change the Standard Security mode default password and use Advanced Security mode. See
"Passwords" on page 69 for more information.

» Store your meter's Security Configuration File (.scf) in a protected location.

+ Revenue-lock the meter, confirm it is revenue-locked and use anti-tamper sealing points before
putting the meter into service. This helps prevent unauthorized access to the meter, parameter
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values and settings. See "Scaled operational values" on page 171 and "Anti-tamper sealing
methods" on page 170 for more information.

Default security settings

Area Setting Default
HTTP Disabled
SSH Terminal Disabled
Communications protocols
SFTP Enabled
Modbus TCP Enabled

Broadcast time
Time and time keeping synchronization Enabled

Configuration using the display Enabled

Configuration Confi ti ina Modb
gur.a ion using Modbus Disabled
programing
Standard security mode
Enabled
(standard.scf)
Security mode
Advanced security mode .
Disabled

(advanced.scf)

See "Harden the device" on page 76 for information about changing default security settings.

Time synchronization security considerations

Depending on the software security settings, a workstation that connects to the device may send a
time synchronization signal to synchronize the device's internal clock with the workstation's clock.
This can cause overlaps in the demand intervals, and timestamps in the data logs may not be
accurate.

The Time Sync Source setup register, located in the Clock module, identifies the only
communications port that will accept time synchronization broadcasts. You can configure this setup
register through ION Setup or the Designer component of Power Monitoring Expert.

Refer to the Time synchronization & timekeeping technical note for more information on
implementing time synchronization.

Standard meter security

Standard meter security is enabled by default on the meter; all configuration functions are
password-protected.

« If you make configuration changes to the meter using the front panel, the meter prompts you for
its password before accepting any configuration changes. You do not need to re-enter the
password for each subsequent change. However, if you perform no additional configuration
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changes for five minutes, the meter exits setup mode; to make any further changes, you need
to re-enter the Setup menu and provide the valid meter password.

If you make any configuration changes using ION Setup or Power Monitoring Expert software, you
are prompted by the meter for its password (in addition to the password used to access the
software).

After you enter the correct meter password and confirm the new configuration, the change is set on
the meter.

Related topics:

"Setting up standard or advanced security" on page 62

Advanced meter security
Advanced security allows you to:
« Enable or disable Modbus programming.

+ Configure communications lockouts to limit the number of invalid login attempts permitted for
each protocol and set the priority of associated device events.

+ Add up to 50 users, each with unique access privileges.

» Enable advanced security access through the front panel.

Related topics:

"Setting up standard or advanced security" on page 62

Setting up standard or advanced security

Using Advanced security mode is recommended because it has stronger user login, user privilege
management, and password complexity.

The following table describes the security capabilities for each security mode:

Standard Advanced

Security capability  Security configuration option security  security
mode mode

Use a single account to access the meter with a
numeric password for login.

User credentials and . . .
Create multiple user accounts with alphanumeric

password robustness i i : .
passwords for login and configuration changes.

Password strength feedback using ION Setup. °

Define user account lockout criteria after

User account ) ] .
i unsuccessful login attempts and define session ) °
lockouts and timeouts
timeout length.
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Standard Advanced

Security capability = Security configuration option security  security
mode mode

. User accounts with variable permissions to read
User privileges ) ) . °
access, test mode or configuration privileges.

Disable or enable webpages for viewing meter
Webpages data online using a web browser (Active Web ° °
Server).

Disable or enable ability to configure the meter

using:
. . . . .
* Modbus communications programming.
Configuration » The Display.
Disable and enable time synchronization. °
Password required for configuration changes
[ ] [ ]

using the display or communication protocols.

Cybersecurity event  Set-up cybersecurity event logs and alarms using
logs and reports event priorities.

Required for this procedure:
* Meter connection using ION Setup.
* Login credentials.
To set up standard or advanced security:
1. Open ION Setup > select the meter > Setup Assistant.
2. Security > Security Mode > Edit. The Open Security Configuration file dialog box opens.
3. Select the default standard.scf or advanced.scf security configuration file.
4. Click Open. The Standard Options or Advanced Options dialog box opens.
5

On the Standard or Advanced Options dialog box:
— Select or clear Web Server to enable or disable the ability to view meter data online using
webpages.

— Select or clear Allow Modbus programming to enable the ability to program some meter
settings using Modbus.

— Select or clear Allow Front Panel programming to enable or disable the ability to change
meter settings using the display.

6. Click Nextto go through Setup Assistant screens and select the security options you want.

— See "Passwords" on page 69 for recommendations.

— See "Managing user account lockouts and timeouts" on page 68 for details about lockouts
after unsuccessful login attempts and ION protocol session timeouts.
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— See "Managing user accounts" on page 67 for details about adding users and assigning
privileges.

If an option is grayed out, it is not available with your meter type or firmware.
7. Click Finish. The Save As dialog box opens.
8. Click Yes. The Save As dialog box opens.
9. Save the file with a unique file name to avoid overwriting default Security Configuration Files.

10. Click Exit.

Viewing and validating security settings
Generate a Meter Configuration Report to view security settings and user privileges.
Required for this procedure:
* Meter connection using ION Setup.

* Login credentials.

To view and validate security settings:
1. Open ION Setup > select the meter > Setup Assistant.

2. Reports > Meter Configuration > Display. The Meter Configuration Report for your meter
opens.

3. Scroll down to the Security section to view settings. For example:
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8" Meter Configuration Report for PO-3%99A9%9-99 >

Parameter Walue 6

DOPT Digit Grouping 1000.0

DOPT Date Format FAb ADD SO

DOP1 Time Farmnat 24H

P11 PF Sigh Carwvention IEEE

DOP1 Meazurement Symbals |IEEE

P41 Phaze Lbls ABC

Secuty - Security

Secuty Mode Standard

Hardware Lock Dizabled

Front Panel Pazsward Yes

Wieb Server Yes

Allow web Server Programming Yes

Secure YWeb Page Yiewing Mo

Allove Modbus Programming Mo

Allow Front Panel Programming Tes

Allow Broadcasting Time Synchronization  Yes

55H Lock Attempts M

Telnet Lock Atternpts a

FTP Lock Attempts g

Factory Lock Atterpts g

Front Panel Lock dttemptz g

10M Lock Attempts a

HTTP Lock Attempts 8

Lockout Duration Minutes 1440

10M Silence Minutes 30

HTTF Silence Minutes W AA

% alid Auth Pricrity i}

Irvalid Auth Priority 128

Sernial Settings - Coml

b1 Pratnenl Fartnm N

£ >
LCloze Save Az Frint Help

4. Click Close or Save As to save the report as a .txt file.

Applying security settings to multiple meters

A Security Configuration File (.scf) can be applied to other meters. If differences in capabilities
between meters exist, a message will open communicating when a capability is not available.

Required for this procedure:

Meter connection using ION Setup.

+ Login credentials.

» Saved Security Configuration File (.scf).

NOTICE

LOSS OF DATA

Record your device's user and password information in a secure location.

Failure to follow these instructions can result in equipment damage.

To apply security settings to multiple meters:
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Open ION Setup > select the meter > Setup Assistant.
Security > Security Mode > Send. The Open Security Configuration file dialog box opens.

Select the Security Configuration File (.scf) that contains the current meter settings you want
and click Open. The Security Options dialog box opens.

NOTE: Open the security log file to determine the SCF file you want. See "Cybersecurity
configuration" on page 60 for more information.

Click Exit.

Restoring default security configuration

Required for this procedure:

Meter connection using ION Setup.

Login credentials.

NOTICE

LOSS OF DATA

Record your device's user and password information in a secure location.

Failure to follow these instructions can result in equipment damage.

To restore the default security configuration:

1.

2
3
4.
5

Open ION Setup > select the meter > Setup Assistant.

. Security > Security Mode > Edit. The Open Security Configuration file dialog box opens.

Select the standard.scf and click Open. If prompted, click No to use Legacy security support.
Click Next to navigate to the Define individual users/passwords screen.

Click Finish. The Confirmation message box opens.

User accounts and privileges

Recommendations to optimize cybersecurity in a protected environment:

Assign users only the essential privileges needed to perform their role.

Revoke user privileges when no longer needed due to role change, transfer or termination. User
credentials do not expire.

Follow user account management tasks as described by your organization or contact your
network administrator.
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Managing user accounts

User privileges can be modified. Users can be added or removed at any time. The maximum
number of users is 50.

Required for this procedure:

* Meter connection using ION Setup.

+ Login credentials.

» Advanced Security Mode enabled.

+ Security configuration access privileges.

NOTICE

LOSS OF DATA

Record your device's user and password information in a secure location.

Failure to follow these instructions can result in equipment damage.

To manage user accounts:

1.
2.
3.

6.
7.

Open ION Setup > select the meter > Setup Assistant.
Security > Security Mode > Edit. The Open Security Configuration file dialog box opens.
Select the Security Configuration File (.scf) that contains the current meter settings and click

Open. The Security Options dialog box opens.

NOTE: Open the security log file to determine the SCF file you want. See "Cybersecurity
configuration" on page 60 for more information.

Click Next to navigate to the Define individual users/passwords screen.
Select each user and assign individual permissions:

The following table describes the device access associated with each permission level:

Permission level Device access

Time Sync Access Set the meter’s time and time synchronization parameters.
Read Access View parameters, except security configuration.

Peak Demand Reset
Reset peak demand values.

Access
Comm Config Access Configure communication settings.
Test Mode Access Switch the meter to test mode, if available with your meter type.

Full Meter Config Access  Configure meter settings.

Security Config Access Configure security settings.

Click Finish. A Confirmation message box opens.

Click Yes. The Save As dialog box opens.
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8. Save the SCF file with a unique file name to avoid overwriting default Security Configuration
Files.

9. Click Exit.

Managing user account lockouts and timeouts

If a useraccount is locked out, that user can still access the device by entering the correct
credentials over a different protocol and communications method. Lockout is applied to each user,
protocol and connection type. For example, serial and Ethernet protocols are locked out separately.

User account lockouts and timeouts options include:
* Lockout after unsuccessful login attempts.
» Session timeout for ION protocol only.

e Lockout duration.

Prerequisites:
* Meter connection using ION Setup.
* Login credentials.

 Security configuration access privileges.

To manage user account lockouts and timeouts:
1. Open ION Setup > select the meter > Setup Assistant.
2. Security > Security Mode > Edit. The Open Security Configuration file dialog box opens.
3. Select the Security Configuration File (.scf) that contains the current meter settings and click

Open. The Security Options dialog box opens.

NOTE: Open the security log file to determine the SCF file you want. See "Cybersecurity
configuration" on page 60 for more information.

4. Click Next to navigate to the Select protocol lockout options screen:
5. Select each protocol and click Edit to change lockout and session timeout values for:
— Protocol lockout after unsuccessful login attempts.

— Session timeout for ION protocol only. This is configurable because there is no login and
logout action for ION protocol sessions.

Enter a value for the Lockout duration for user lockout occurrences.
Click Finish. A Confirmation message box opens.

Click Yes. The Save As dialog box opens.

© ® N 9

Save the SCF file with a unique file name to avoid overwriting default Security Configuration
Files.
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Passwords

Recommendations to optimize cybersecurity in a protected environment:

» Document and store passwords and usernames in a protected location.

NOTICE

DATA LOSS

Record your device's front panel and user password information in a secure location.

Failure to follow these instructions can result in data loss.

+ Change the default password of 0 (zero) to help reduce unauthorized access.

Default account settings are often the source of unauthorized access by malicious users.

* View the Device Configuration Checklist to quickly determine if the default password is used:

Device Configuration Checklist >

+ Configuration Efrois

= Configuration WWamings
Detault PT/CT settings
Defaul voltage/current nominal settings
Voltage Wing: Minimal measuwed voltage
Current Winng: Minimal measured current
Clock: Timezone not set
Alarming: Disabled Voltage Sag/Swell alam
Mameplate: Missing Dwner/Tagl /Tage info

Security: Default password in use

till uzing a fronk panel password of 0 [zero).

[] Acknowledge issues until next configuration change

Back Exit Help

+ Use Advanced security mode.
+ Use alphanumeric passwords with a length of six characters.

* Follow user account management tasks as described by your organization or contact your
Network Administrator, for example, maximum password age or history policies.
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Default usernames and passwords

The following table lists the password requirements and usernames:

Security mode Password range Limit Default password Username
Standard 0 to 99999999 8 digits 0 (zero) 8650
Any combination
y User1, User2,
Advanced of letters and 6 characters 0 (zero)
User3, etc...
numbers

Changing a password
Required for this procedure:
* Meter connection using ION Setup.
* Login credentials.
* Advanced Security Mode enabled.

+ Security configuration access privileges.

You can also change the password using ION Setup Diagnostics tool, Security Options Module
using ION Setup Advanced Mode, and Power Monitoring Expert.

NOTICE

LOSS OF DATA

Record your device's user and password information in a secure location.

Failure to follow these instructions can result in equipment damage.

To change a password:
1. Open ION Setup > select the meter > Setup Assistant.
2. Security > Security Mode > Edit. The Open Security Configuration file dialog box opens.
3. Select the Security Configuration File (.scf) that contains the current meter settings and click

Open. The Security Options dialog box opens.

NOTE: Open the security log file to determine the SCF file you want. See "Cybersecurity
configuration" on page 60 for more information.

4. Select auser.
5. Click Next to navigate to the Define individual users/passwords screen.

6. Select each user and assign passwords.
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NOTE: Select the Show password check box to display the user password after it has been
changed.

7. Click Finish. A Confirmation message box opens.
8. Click Yes. The Save As dialog box opens.

9. Save the SCF file with a unique file name to avoid overwriting default Security Configuration
Files.

Entering the front panel password

When you attempt to change a setting on the front panel with basic security enabled, you are
presented with the password screen. After you enter the correct password, you do not have to re-
enter it for other any other changes unless you exit the configuration session, or the session has
elapsed.

ENTER PASSWORD
00000008

MIN: MAX:
00000000 99999999

HOLD ARROW KEY TO MOVE CURSOR

To enter the password:

1. Use the arrow buttons to change the value of the highlighted digit. The up arrow increments
the number and the down arrow decrements it.

2. Hold down an arrow button for about one second to change the position of the cursor. The up
arrow moves the cursor left one position and the down arrow moves the cursor right one
position.

3. Press the ALT/ENTER button once you have the value that you want.

Logging into a device using the front panel

When you attempt to change a setting through the front panel of a device that has advanced
security enabled, you are prompted for a username and password. See "Managing user accounts”
on page 67 for information regarding setting advanced security on your meter.

If the access level associated with the user is not sufficient to change the setting, the NOT
AVAILABLE message is displayed.

NOTE: The printable ASCII character set is used when entering an advanced security password
through the front panel. If a password created through ION Setup contains any of the extended
ASCII character set, that password cannot be entered through the front panel.
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ENTER USERID
USER1

HOLD ARROW KEY TO MOVE CURSOR

ENTER PASSWORD
0]

HOLD ARROW KEY TO MOVE CURSOR

Tologin to a device using the front panel:

1. Use the arrow buttons to change the highlighted character in the username. The up arrow
moves the cursor forward through the list of available characters and the down arrow moves
the cursor backward. Hold the up arrow to move the cursor one position to the left or hold the
down arrow to move the cursor one position to the right.

NOTE: Usemames are fixed as USER1 through USER50. USERQO is the designated front
panel user and is not a valid user through advanced security. The meter ignores leading
zeros. For example, USER1, USERO01 or USERQO1 are all recognized by the meter as
Userl.

2. Press the ALT/ENTER button once you have the value that you want. The ENTER
PASSWORD message appears.

3. Use the arrow buttons to change the value of the highlighted character. The up arrow
increments the number and the down arrow decrements it. Hold the up arrow to move the
cursor one position to the left or hold the down arrow to move the cursor one position to the
right.

4. Press the ALT/ENTER button once you have the value that you want.

If the username or password is not correct, the INVALID LOGIN message is displayed. All
invalid access attempts are logged in the event log.

Logging into the device using software

When you attempt to make changes using software to a device that has security enabled, you are
prompted for a username and password (if advanced security is enabled) or a password (if standard
security is enabled).

Tologin to a device using software:
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1. Select a user or enter a valid username (if advanced security is enabled).
2. Enterthe appropriate password and click OK.

NOTE: Depending on your software’s security settings, you may also be prompted for a
software username and password.

Configuring basic meter security using the front panel

This section describes the security configuration options available to front panel users. Instructions
are provided on the following procedures:

» Changing the meter password.

+ Resetting the meter password.

Changing the basic security password

By default, the basic security password is set to 0 (zero). The password can be changed to any
number up to eight digits long. It is highly recommended that you change the password from the
default value. See "Device security capabilities" on page 56 for recommendations.

To change the basic security password:
1. Hold down the ALT/ENTER button to access the SETUP menu.
2. Use the up and down arrows to highlight SECURITY then press the ALT/ENTER button.

3. Use the up and down arrows to highlight MODIFY PASSWD then press the ALT/ENTER
button.

4. Enter the current meter password when prompted (see "Entering the front panel password" on
page 71). After you enter the current password, you can modify the password:

MODIFY PASSWORD

000000CH

Ml [
DOD0O000 9999959
HOLD ARROW KEY TO MOVE CURSOR

5. Use the up and down arrow buttons to change the value of the highlighted digit. The up arrow
increments the number and the down arrow decrements it.

6. Hold down an arrow button for about one second to change the position of the cursor. The up
arrow moves the cursor left one position and the down arrow moves the cursor right one
position.

7. Press the ALT/ENTER button once you have the value that you want. You are prompted for
your current password before the new password is saved.

Page 73 0f 210 7EN02-0306-05



ION8650 User Manual Cybersecurity

NOTICE

DATA LOSS

Record your device's front panel and user password information in a secure location.

Failure to follow these instructions can result in data loss.

If your device’s front panel or user passwords are lost, you must return the device for factory
reconfiguration, which resets your device to its factory defaults and destroys all logged data.

Resetting the front panel password

If you forget or lose your meter password, you can reset the meter's front panel password to the
factory default value of 0 (zero). Resetting the password requires that the meter be in TEST mode.

+ If your meter has the password security check enabled (or your meter has the hardware lock
security option enabled), you must remove the meter's outer cover to access the TEST mode
button.

Refer to "Switching to TEST mode" on page 195 for details on putting the meter into TEST mode.
To reset the front panel password to the factory default:

1. Put your meterinto TEST mode.

2. Press and hold down the ALT/ENTER button and the demand reset switch simultaneously.

Continue to press and hold the button and switch until a message appears on screen stating
that the password has been reset to the default (this might take a few seconds). Password
security is now enabled, and the front panel password is 0 (zero).

Updating passwords on multiple meters
Use the ION Setup Diagnostics tool to update passwords on multiple meters at the same time.
Required for this procedure:
* Meter connection using ION Setup.
* Login credentials.

+ Security configuration access privileges.

NOTICE

LOSS OF DATA

Record your device's user and password information in a secure location.

Failure to follow these instructions can result in equipment damage.
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To update passwords on multiple meters:
1. Open ION Setup > select the System.
Tools > Diagnostics. The Systems diagnostics: System dialog box opens.
Select the Tools tab > Advanced Security Password Updater.
Click Open.
Select the meters that need a password update.
Click Set Info.
Click Start.

Click Allow passwords to be visible.

© ©® N o g H» w DN

Select each user, click Password and enter a new password.

If the meter is connected to a display, update the password for the Front Panel.

10. Click Start. A Notice message box opens.
11. Click Proceed. A result is displayed for each device.

12. Click Save As to save a copy of updated meter passwords in a .txt file. The Save As dialog
box opens.

13. Save the file with a unique file name to a protected location. An ION Setup message box
opens.

14. Click OK.
15. Click Exit.
16. Click Close.
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Harden the device

Recommendations to optimize cybersecurity in a protected environment:
» Harden the meter according to your company’s policies and standards.

+ Review assumptions about protected environments and address potential risks and mitigation
strategies. See "Product defense in depth" on page 58 for details.

» Change the default password. See "Passwords" on page 69 for details.

+ Change the communication protocol ports from their default values. This lowers the
predictability of port use.

« Disable communication protocol ports when they are not in use. This reduces the attack
surface.

Disabling and enabling protocols and changing port numbers

Disabling unnecessary and unused communication protocol ports, such as SFTP, and network
ports, reduces the attack surface. Changing port number default values reduces the predictability of
use. See "Default Ethernet ports" on page 117 for port defaults.

Leave ION protocol enabled for configuration changes and upgrades. If ION protocol is disabled,
use the display, Modbus programming to access the meter.

Required for this procedure:
» Meter connection using ION Setup.
+ Login credentials.

+ Security configuration access privileges.

NOTICE

LOSS OF ACCESS

Maintain sufficient access to communicate with and configure your device.

Failure to follow these instructions can result in loss of access to the device.

To disable and enable protocols and change port numbers:
1. Open ION Setup > select the meter > Setup Assistant.
Communications > Advanced Ethernet > Protocols.
Change the default port number.

2
3
4. Enable or disable the protocol.
5. Click OK.

6

Click Exit.

7EN02-0306-05 Page 76 of 210



Cybersecurity

ION8650 User Manual

Disabling and enabling meter configuration methods

Limiting configuration methods, such as Modbus and the display, and providing read-only access
reduces the attack surface.

Required for this procedure:

* Meter connection using ION Setup.

+ Login credentials.

» Security configuration access privileges.

To enable or disable meter configuration methods:

1.
2.
3.

®©® N o v

Open ION Setup > select the meter > Setup Assistant.
Security > Security Mode > Edit. The Open Security Configuration file dialog box opens.
Select the Security Configuration File (.scf) that contains the current meter settings and click

Open. The Security Options dialog box opens.

NOTE: Open the security log file to determine the .scf file you want. See "Cybersecurity
configuration" on page 60 for more information.

On the Security Options dialog box:

a. Select or clear Enable Web to enable or disable the ability to view meter settings online
using webpages.

b. Select or clear Allow Front Panel programming to enable or disable the ability to
change meter settings using the display.

c. Select from the Modbus Access drop-down list:

— None: Disables built-in Modbus map access.

— Read/Write: Enables configuration of basic metering parameters using only Modbus
communications protocol.

— Read Only: Enables ability to read metering parameters using only Modbus
communications protocol. This option is enabled by default.

Click Next.
Click Finish. A Confirmation message box opens.
Click Yes. The Save As dialog box opens.

Save the SCF file with a unique file name to avoid overwriting default Security Configuration
Files.

Click Exit.

Disabling and enabling webpages and time sync sources

Disabling webpages removes the ability to access meter data online using a web browser. If your
meter can be accessed by a web browser outside your protected network, a malicious user could
intercept communications.
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See "Disabling and enabling protocols and changing port numbers" on page 76 for details on
enabling HTTP.

Disabling the ability to modify the meter’s time source helps protect against disguised
communication from an unknown source as being trusted and possibly invalidating timestamps.

See "Time synchronization" on page 135 for more information.

Required for this procedure:
» Meter connection using ION Setup.
+ Login credentials.

+ Security configuration access privileges.

To disable and enable webpages and time synch sources:
1. Open ION Setup > select the meter > Setup Assistant.
2. Security > Security Mode > Edit. The Open Security Configuration file dialog box opens.
3. Select the Security Configuration File (.scf) that contains the current meter settings and click

Open. The Security Options dialog box opens.

NOTE: Open the security log file to determine the SCF file you want. See "Cybersecurity
configuration" on page 60 for more information.

4. On the Security Options dialog box:

a. Select or clear Enable Web to enable or disable webpages for viewing meter data online
using a web browser.

b. Select or clear Allow Broadcasting Time Synchronization to enable or disable the
ability to modify the meter’s time synchronization source.

Click Next to go through Setup Assistant screens.
Click Finish. The Confirmation message box opens.

Click Yes. The Save As dialog box opens.

®©® N o o

Save the Security Configuration File (.scf) with a unique file name to avoid overwriting default
Security Configuration Files.

9. Click Exit.

7EN02-0306-05 Page 78 of 210



Cybersecurity

ION8650 User Manual

Threat intelligence

Event logs and alarms can assist with monitoring suspicious activity and identifying the cause of
cybersecurity breaches that could lead to a cybersecurity incident.

Setting up cybersecurity event logs and alarms

The event log can be used to monitor user logins and user account lockouts. The record limit for the
event log is 5,000 by default. When the limit is reached, new records overwrite older ones.

To be notified when the Event Log record limit is approaching, see "Data logging" on page 159.

To extend record retention, offload information to syslog or a protected storage or retention location,
see "Configuring Syslog network settings using ION Setup" on page 115.

You can also change event priorities for cybersecurity events using ION Setup Advanced Mode.
Refer to the ION Reference document at www.se.com for information about working with modules.

Required for this procedure:
» Meter connection using ION Setup.

+ Login credentials.

To set up cybersecurity event logs and alarms:
1. Open ION Setup > select the meter > Setup Assistant.
2. Security > Security Mode > Edit. The Open Security Configuration file dialog box opens.

3. Select the Security Configuration File (.scf) that contains the current meter settings and click
Open. The Security Options dialog box opens.

Open the security log file to determine the .scf file you want. See "Cybersecurity
configuration" on page 60 for more information.

4. Click Next to navigate to the Select protocol lockout options screen:
IMAGE
5. Click Events. The Event Priorities dialog box opens:

IMAGE

6. Leave default values or enter values for each event priority according to your reporting
requirements:

Priority Description Value range
None Not recorded in the event log. 0

Recorded in the event log. Event log
Info Only cut-off range. Will not appearin Event 1-5
Log reports or syslog records.

Recorded in the event log. 6-63

Recorded in the event log. Produces

64-127
alarm low alarm.

Low
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Priority Description Value range

. Recorded in the event log. Produces
Medium ) 128-191
medium alarm.

Recorded in the event log. Produces

High low alarm. Recorded in syslog 192-255
records.
7. Click OK.
8. Click Next.

9. Click Finish. A Confirmation message box opens.
10. Click Yes. The Save As dialog box opens.

11. Save the Security Configuration File (.scf) with a unique file name to avoid overwriting default
Security Configuration files.

12. Click Exit. The Device Configuration Checklist message box opens.

13. Click Exit.

Viewing and downloading event logs

Generate an event log report to assist with cybersecurity incident investigations.

Event logs contain:
» Meter configuration changes.

» Energy management system events.

Required for this procedure:
* Meter connection using ION Setup.
* Login credentials.

» Configured event logs and alarms.

To view and download event logs:
1. Open ION Setup > select the meter > Setup Assistant.
2. Reports > Event Log > Display. The Log reports dialog box opens.

3. Inthe Upload Log Records dialog box, select the records you want to save, and then click OK.
NOTE: Only All available records and Last options are available for Event Logs.

The Event Log for your meter opens.
4. Click Save As, select either CSV or TXT > Save, and then click Close.
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Upgrades and security configuration

When meter firmware or ION Setup software is upgraded, security configuration remains the same
until changed, including usernames and passwords. It is recommended security configuration is
reviewed after an upgrade to analyze privileges for new or changed device features and revoke or
apply them according to your company’s policies and standards.
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Factory access

Factory access is restricted to Schneider Electric Technical Support and should only be enabled
when requested by Schneider Electric authorized personnel.

The factory access security feature interacts with standard and advanced security to enable
factory-level access to the device for the specific period of time entered in the Factory Access
Minutes setup register, located in the Security Options module. The Factory Access Minutes
register value can range from one minute to 19 years. Setting it to O (zero) disables all factory
access.

If the device uses standard security, when you press any of the device’s front panel buttons, power
cycle the device, or edit the Factory Access Minutes setup register, factory-level access is enabled
on the device for the duration specified in the Factory Access Minutes setup register. If the device
has advanced security enabled, the Factory user must also be enabled. The device will only permit
factory-level access, with the correct login credentials, for the period specified in the Factory
Access Minutes setup register.

Configuring the factory access minutes setup register

You must use ION Setup in advanced mode to configure the Factory Access Minutes setup
register, located in the Security Options module. In order to change security settings, you must be
logged into ION Setup with a Supervisor level user account with permissions to change these
settings.

To configure the factory access minutes setup register:

1. Connect to your device in advanced mode in ION Setup. See the ION Setup Help for more
information.

2. Navigate to the Security Options Modules folder and double-click on the module in the right-
hand pane.

3. Select the Setup Registers tab.
4. Select Factory Access Minutes and click Edit. A dialog box appears.
5. Enter the desired duration (in minutes) for factory access to be enabled. Select Elapsed

Interval Format from the dropdown list to enter day, hour and minute values.

You can also use the Designer component of Power Monitoring Expert to configure the register. See
Power Monitoring Expert help for more information.

Factory access and standard security

If a user tries to login to factory-level access (using SSH or HyperTerminal) on a device with
standard security, both of the following conditions must be met before the device can proceed with
subsequent checks:

1. Factory Access Minutes setup register is not 0 (zero).
2. The user and password information for factory-level access has been entered correctly.

If both conditions are met, the device checks the following to determine if access will be granted:
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» Front panel button: if the time since one of the device’s front panel buttons was pushed is less
than the Factory Access Minutes register value, the user is given access.

» Power cycle: if the time since the device was powered up is less than the Factory Access
Minutes register value, the user is given access.

» Factory Access Minutes edit: if the time since the Factory Access Minutes register value was
edited is less than the Factory Access Minutes value, the user is given access.

If any one of these conditions are met, the user is given access. If none of these conditions are met,
the user is not given factory-level access on a device with standard security even if they entered
appropriate user and password information.

Factory access and advanced security

If a user tries to login to factory-level access (using SSH or HyperTerminal) on a device with
advanced security, all three of the following conditions must be met before the device can proceed
with subsequent checks:

1. Factory Access Minutes setup register is not 0 (zero).
2. The user and password information for factory-level access has been entered correctly.
3. The Factory user has been enabled. See "Managing user accounts" on page 67 for

instructions.

NOTE: The Factory user can be enabled and disabled on the user configuration screen of the ION
Setup advanced security wizard.

If all three of these conditions are met, the device checks the following to determine if access will be
granted:

» Front panel button: if the time since one of the device’s front panel buttons was pushed is less
than the Factory Access Minutes register value, the user is given access.

» Power cycle: if the time since the device was powered up is less than the Factory Access
Minutes register value, the user is given access.

» Factory Access Minutes edit: if the time since the Factory Access Minutes register value was
edited is less than the Factory Access Minutes value, the user is given access.

If any one of these conditions are met, the user is given access. If none of these conditions are met,
the user is not given factory-level access on a device with advanced security even if they entered
appropriate user and password information.

Factory access examples

Scenario 1

This example illustrates how factory access functions on a device using standard security, with a
Factory Access Minutes setup register value of 10, over a protocol that is not session-based.
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NOTE: A protocol that is not session-based actively communicates login credentials while you are
connected to the device (for example, ION).

1. The user pushes a front panel button on the device (T=0). This starts the factory access
duration of ten minutes.

2. Two minutes after the button press (T=2), Schneider Electric Technical Support requests
factory-level access to the device, with the correct login credentials, over ION. Factory-level
access is granted.

3. Tenminutes after the button press (T=10), factory-level access expires, and the user is
automatically logged out.

Any attempt to connect to the device using factory-level access is now denied.

NOTE: With protocols that are not session-based (for example, ION), the access expires when
the time since the factory access was activated equals the duration specified in the Factory
Access Minutes setup register.

Scenario 2

This example illustrates how factory access functions on a device using advanced security, with a
Factory Access Minutes setup register value of 5, over a serial port (a session-based protocol).

1. The user connects to the device using ION Setup with Supervisor-level access.
— Inthe advanced security wizard, he enables the Factory user.

— Inthe Communications tab, he sets the protocol of the appropriate serial port to Factory.

2. The user power cycles the device (T=0). This starts the factory access duration of five
minutes.

3. Two minutes after the power cycle (T=2), Schneider Electric Technical Support requests
factory-level access to the device, with the correct login credentials, over the serial port.
Factory-level access is granted.

4. An hour after the power cycle (T=60), Schneider Electric Technical Support logs off factory-
level access.

NOTE: With protocols that are session-based, once factory-level access has been granted,
it does not matter if the logged-in time exceeds the value of the Factory Access Minutes
setup register.

The factory-level access period has expired and must be restarted by pushing one of the
device’s front panel buttons, power cycling the device, or modifying the Factory Access
Minutes setup register.

5. The user connects to the device using ION Setup with Supervisor-level access.
— Inthe advanced security wizard, he disables the Factory user.

— Inthe Communications tab, he changes the serial port protocol from Factory back to its
original setting.
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Scenario 3

This example illustrates how remote factory access functions on a device using advanced security,
over a protocol that is not session-based.

NOTE: A protocol that is not session-based actively communicates login credentials while you are
connected to the device (for example, ION).

1.

The customer contacts Schneider Electric Technical Support to request that they connect to a
device using factory-level access using the following information:

—the username and password of an advanced security user that has device security
configuration access, and the front panel password of the device.

—the device’s Ethernet connection information.

Technical Support connects to the device using ION Setup, entering the advanced security
username and password provided.

— Inthe advanced security wizard, he enables the Factory user.

—Using the advanced mode of ION Setup, he changes the Factory Access Minutes setup
register from O (default) to 30 (T=0).

Two minutes after editing the Factory Access Minutes setup register (T=2), Schneider Electric
Technical Support requests factory-level access to the device, with the correct login
credentials, over HTTP. Factory-level access is granted.

Twenty minutes after editing the Factory Access Minutes setup register (T=20), Schneider
Electric Technical Support finishes working on the device and logs off factory-level access.

Technical Support connects to the device using ION Setup, entering the advanced security
username and password provided.

— Inthe advanced security wizard, he disables the Factory user.

—Using the advanced mode of ION Setup, he changes the Factory Access Minutes setup
register back to 0 (zero).

Schneider Electric Technical Support contacts the customer to indicate they are finished working on
the device and have restored the security settings, and recommends that the customer update their
advanced user password information and store their password information and device security
configuration file in a secure location.
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Secure disposal guidelines

Use the Secure disposal checklist when disposing a meter to help prevent potential disclosure of

data.

Secure disposal checklist

Task Description

Document disposal actions according to your
Record activities company’s policies and standards to keep a
record of activities.

See "Wiping the device" on page 86 for detailed

Wipe the device
steps.

Follow decommission and sanitization tasks as
described by your organization or contact your
Network Administrator.

Decommission network and security rules. For
Decommission and sanitize example: A firewall rule that could be used to
get past the firewall.

Perform records tracking sanitization tasks to
remove records in related systems. For
example: monitoring SNMP servers.

See "Disposal, reuse, recycling" on page 89 for

Disposal and reuse ) .
more information.

Completed

O

Wiping the device

Follow tasks in the order listed, performing the Overwriting the Communications module registers

task last to keep connectivity.

Required for this procedure:
» Meter connection using ION Setup.
+ Login credentials.

+ Security configuration access privileges.

NOTICE

LOSS OF DATA

Failure to follow these instructions can result in data loss.

Ensure all important data from the device has been saved before performing a reset.
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NOTICE

LOSS OF ACCESS

Maintain sufficient access to communicate with and configure your device.

Failure to follow these instructions can result in loss of access to the device.

To wipe the device:

1. Overwrite the meter template file. This overwrites the meter template with the default factory
template. See "Overwriting the meter template file" on page 87 for detailed steps.

2. Delete the IEC 61850 configuration file. This deactivates functions related to the IEC 61850
protocol. See “Deleting an IEC 61850 configuration file”, page 75 for more information.

3. Restore default security configuration. See “Restoring default security configuration”, page
126 for more information.

4. Overwrite factory module registers. This deletes values for:

— Device owner.
— Devicetag.

— Device location.
— Device name.

See "Overwriting factory module registers" on page 88 for more information.
5. Perform a master reset. This deletes values for:

— Event log, data and waveform records.

— Power quality event (COMTRADE) files.

— Energy, metering, min./max., revenue and test mode, and peak demand values.
— Disturbance (sag/swell event) counter, EN50160 parameters and statistics.

6. Overwrite communications module registers. This deletes values for network infrastructure
details. See "Overwriting communication module registers" on page 88 for more information.

Overwriting the meter template file

To overwrite the meter template file:

1. Gotowww.se.com and search for the meter template for your device.

Download the ZIP file and extract files.
Open ION Setup.
Click the meter to select it > Setup Assistant.
Template > Send to Meter tab.
Click Send.

N o o > DN

Navigate to the extracted files and select the DCF file.
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10.
11.
12.
13.

NOTE: FWN file type is also an option.

Click Open.

Click Proceed. The Template Paste Options dialog box opens.
Clear all check boxes and click OK.

Click Yes. The overwriting process could take a few minutes.
Click OK.

Click Exit and then OK.

Overwriting factory module registers

To overwrite the factory module register:

1.

2
3
4,
5

6.

Open ION Setup.

. Ctrl + click on the meter to select it. This switches ION Setup to Advanced mode.

Double-click Factory Modules folder > select meter type.

Select the Setup Registers tab.

. Type text or characters to replace values for these setup registers by selecting them and click

Edit:

— FAC1 Device Namespace.
— FAC1 Device Name.

— FAC1 Owner.

— FAC1 Tag1.

— FAC1 Tag2.

Click Send.

Overwriting communication module registers

To overwrite the communication module registers:

1.

2
3.
4

Open ION Setup.

. Ctrl + click on the meter to select it. This switches ION Setup to Advanced.

Double-click Comm Modules folder > Ethernet > Setup Registers.

. Type text or characters to replace values for network infrastructure setup registers by

selecting them and clicking Edit. Some registers include:
— IP Address.

— |P Mask.

— IP Gateway.

NOTE: IP values can be replaced with text.
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— Primary DNS.
— Secondary DNS.

— All servers.

All port numbers.

5. Click Send.

Disposal, reuse, recycling
Before removing the device from its intended environment, follow the Secure disposal guidelines.

Follow device removal tasks described by your organization or contact your network administrator
to determine a responsible method of disposal.

Dispose of the device according to the legislation of the country. Some regulatory organizations
include:

+ The United States Environmental Protection Agency (EPA) for guidance on the sustainable
management of electronics.
— The EPA provides an Electronic Product Environmental Assessment Tool (EPEAT) that

helps assess the environmental attributes of electronics.

» The European Waste Electrical & Electronic Equipment Directive (WEEE Directive) is the
community directive on waste electrical and electronic equipment.

» The European Restriction of Hazardous Substances Directive (RoHS) directive on the
restriction of the use of certain hazardous substances in electrical and electronic equipment.

NOTICE

UNAUTHORIZED OR UNINTENDED ACCESS TO CONFIDENTIAL DATA
« Store devices that are not in service in an access-controlled or monitored location.
» Physically destroy devices that are decommissioned.

Failure to follow these instructions can result in unauthorized or unintended access to
sensitive or secure customer data.

Device disposal

It is recommended that the entire device is physically destroyed. Destroying the device helps
prevent potential disclosure of data contained in the device that was not removed.

Device reuse
Store the device in a location that is access controlled or monitored if there is potential for reuse.
Device recycling

To get recycling information for your device:
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1. Go to the Schneider Electric Check a Product web site.

Enter the meter commercial reference or the first few characters + '*'. For example: M8650*

Click Check your product

> w0 DN

Enter your email and then click | acknowledge to receive the disposal report.
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Communications

This chapter includes general instructions for connecting and configuring all the communication
ports on your meter.

For specific installation steps and meter specifications, consult your ION8650 Installation Guide.

NOTE: If you cannot communicate as expected with an ION8650C, ensure that you have enabled
the communications port that you are using and that you have power cycled the meter. See
"ION8650C communications options" on page 95 for more information.

In this chapter

CommuNiCatioNs OVEIVIEW 92
Communications OptiONS ... L. 93
ION8650C communications options ... ... .. .. 95

Serial CONNECHIONS .l 96

Configuring Ethernet connections ... ... 103
Enabling and Disabling Ethernet ports .. . 108

Internal modem CONNECHIONS ... .o L 109

SV 00 L 115

Ethernet protocol CoONtrol . 116

HTTPS outage alerts ... . e 117
Adding and deleting TLS certificates .......... ... ... . 117
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Communications overview

The following illustration shows the connections to the communications card.

A Communications wiring on switchboard

B Communications wiring on breakout panel

Ethernet 10/100Base-T: RJ45 connector. See "Configuring Ethermnet
connections" on page 103.

Cell modem option: SMA connector. "Internal modem connections" on page
109.
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Serial COMs and Expanded 1/0: Molex Micro-Fit 24 pin male connector. See "
Communications options" on page 93.

IRIG-B GPS Time Synchronization.

Modem on COM2: RJ11 male connector. See "Internal modem connections"
on page 109.

ANSI Type Il Magnetic Optical Communications Coupler on COM3. This port
is located on the front panel. See "Configuring the optical port" on page 102.

Optical communications breakout cable for serial communications. Ordered
separately. See "Communications breakout cable" on page 100.

Optional I/0O Expander for serial communications (and expanded 1/O). Ordered
and shipped separately. For more information, see the I/O Expander
documentation.

Serial COMs:

COM1: RS-232 or RS-486
COM4: RS-485

Communications options

Socket and switchboard meters communication options

code

ION8650 meters have numerous communication possibilities depending on your ordering options
and, in the case of the ION8650C, the enabled communications ports.

Not all models have the same communications options available. Contact your Schneider Electric
sales representative for the latest ordering options and documentation. You can use all
communications ports simultaneously on the ION8650A and ION8650B; you can use the front
optical port plus two other ordered communications ports simultaneously on the ION8650C.

Available options Notes

COM1 RS-232/ RS-485 User selectable RS-232 or RS-485

Maximum 57.6 kbps baud rate
COM2 Internal Modem RJ 11 )

modem RJ11 connection

ANSI Type Il optical port located at
COM3 Optical Port yp P P

front of meter
COom4 RS-485 —
Cell modem Internal cell modem Available on socket meter only
Network Ethernet RJ45 (10/100Base-T) —

. Format is unmodulated IRIG-B time

IRIG-B Captured wire connector

See the ION8650 switchboard installation guide for wiring instructions.

Optional switchboard breakout panel communication options
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Connector type
Ethernet (option)

Modem (option)

(0 )>)

I/0O Expander (option)
COM1 RS-232

Chassis ground

Digital inputs
IRIG-B

myc¥o

@ 00809

I OMMmMmOO wm>

€] Digital outputs

5

©
©,© © ©,0 SN2 or SN R
5
J  Auxiliary power
] supply (option)

=

o )

NOTE: The communications ports on an I/O Expander are not enabled when connected to a
breakout panel. Use the RS-485 and RS-232 connectors provided on the breakout panel.

Communications accessories

The following accessories are currently available as separate products:

/0 Expander

The I/O Expander connects with the male Molex connector on the meter to provide I/O capabilities
as well as access to standard serial communications ports. Refer to the I/O Expander Installation
Guide for details about this device.

Communications breakout cable

The communications breakout cable connects with the male Molex connector on the meter. This is
a pre-made cable that provides access to the standard serial communications ports on the meter.
Cable lengthis 5 feet (152 cm).

Molex extension cables

Molex extension cables can be ordered in both 5 and 15 feet (1.5 or 4.5 meter) lengths.

Optical probe

The optical probe attaches to the optical port on the front of the meter and allows on- site
communications (for example, with a laptop computer).
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ION8650C communications options

The ION8650C supports concurrent communications on the optical port (COM3) and a maximum of
two other communications ports for a total of three simultaneous communications connections. If
your ION8650C has three communications ports enabled, you must disable one of the active
communications ports before you can enable another one in its place. For example, if you have an
ION8650C with optional Ethernet enabled, you must disable the Ethernet port in order to
communicate over both serial ports (COM1 and COM4).

The default settings vary depending on your order option. See your meter’s Installation guide for

details.

NOTE: Switching the active communications ports requires a meter reboot before the changes
can take effect.

Enabling and disabling ION8650C communications ports using the front panel

1. Press the ALT/ENTER button to enter the SETUP menu.

2. Use the arrow buttons to scroll down the menu and select ENABLED COM PORTS, then
press ALT/ENTER. Select CONTINUE and press ALT/ENTER when prompted.

3. Select the active communications port you want to disable (for example, Ethernet) and press
ALT/ENTER. Select DISABLED and press ALT/ENTER. If prompted, enter the meter
password to confirm the change.

4. Select the communications port you want to enable (for example, COM1) and press
ALT/ENTER. Select ENABLED and press ALT/ENTER. Confirm the change if prompted.

A WARNING

HAZARD OF UNINTENDED OPERATION

* Do not use the meter for critical control or protection applications where human or
equipment safety relies on the operation of the control circuit.

» Be aware that an unexpected change of state of the digital outputs may result when the
supply power to the meter is interrupted or after a meter firmware or template upgrade.

Failure to follow these instructions can result in death, serious injury, or equipment
damage.

5. Select REBOOT and press ALT/ENTER. Enter the meter password and confirm the change if
prompted. This power cycles the meter and applies the change.

NOTE: Select UNDO & RETURN to exit the ENABLED COM PORTS setup menu without
making any changes. Your meter will not reboot.

Enabling and disabling ION8650C communications ports using ION Setup

NOTE: You must manually power cycle the meter to have the changes take effect.
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1. Select Communications > Enable/Disable and click the Enabled Ports tab.

2. Select an available port to enable or disable.
You can only enable or disable communications ports that were ordered with the meter. Ports
that were not ordered appear in the list as Not Installed (in the graphic above, COM2 was not
ordered).
Click Edit. Enter the meter password, if prompted. The Set Enabled Ports dialog box
appears.

3. Select a check box to enable a listed port or clear a check box to disable a listed port. You can
enable a maximum of two of the ports listed in the dialog box.

4. Click OK to return to the Setup Assistant. Changes will take effect the next time the meter is
power cycled, either manually or in a power outage.

A WARNING

HAZARD OF UNINTENDED OPERATION

» Do not use the meter for critical control or protection applications where human or equipment
safety relies on the operation of the control circuit.

» Be aware that an unexpected change of state of the digital outputs may result when the supply
power to the meter is interrupted or after a meter firmware or template upgrade.

Failure to follow these instructions can result in death, serious injury, or equipment
damage.

Serial connections

The ION8650 provides RS-232 and RS-485 serial communications connections, located on the
back of the meter, as well as an optical port, located on the front of the meter.

Refer to the ION8650 Installation Guide for information on determining the serial port options
available on your meter.

If the meter's COM1 port is set to RS-232, you can connect this port to a remote modem, which in
turn is connected to a computer. You must use a null-modem RS-232 cable to connect the meter to
an external modem. One end of the cable must be equipped with a Micro-Fit 3.0 Molex female
connector for mating with the Molex male connector on the meter.

You can connect numerous meters’ COM1 ports by selecting RS-485 and using an RS- 232 to RS-
485 converter to create a serial network.

NOTE: You cannot use both RS-232 and RS-485 ports on the meter's COM1 simultaneously.

You can configure your local and remote modems with Power Monitoring Expert or ION Setup. You
can also use ION Setup or Power Monitoring Expert to schedule regular connection times to collect
meter data.

Extension cables with Molex connectors are available for your meter. Pin assignments for the
Molex connector are provided in the ION8650 Installation Guide that ships with the meter (also
available at www.schneider-electric.com).
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NOTE: The total number of possible serial connections is limited by the number of physical serial
ports on the meter. The meter has two physical serial ports (not counting the front optical port).

RS-232 connections
Refer to the ION8650 Installation Guide for the meter's RS-232 specifications and specific wiring
instructions.

Because of the wiring configuration between pins 2 and 3, the meter is considered a DTE (Data
Terminal Equipment) device in all RS-232 connections.

)

ONOOBAWN

LT L]
1 1

ONOOBAWN

A DB9 null modem wiring diagram
B DCE (computer)
C DTE (meter)

Communications settings for the RS-232 port are accessible through the front panel SETUP menu,
Power Monitoring Expert or ION Setup.

Meter connections to single devices

DB direct connect to computer
DB9 direct connect to external modem

Molex direct connect to I/O Expander connected to
computer

D Molex direct connect to I/O Expander connected to external
modem

O W >
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Meter connections to a serial loop

RS-232
50 feet (15.2 m) maximum

B RS-232to RS-485 converter
C RS-485loop

RS-485 connections

Refer to the ION8650 Installation Guide for RS-485 specifications and wiring instructions.

The breakout cable’s twisted pair provide connections for both of the meter's RS-485 serial
communications ports. The first set is for COM1 RS-485 connections. The second set is for COM4
RS-485 communications.

Up to 32 devices can be connected on a single RS-485 bus. Use a good quality shielded twisted
pair cable for each RS-485 bus, AWG 22 (0.33 mm2) or larger. The overall length of the RS-485
cable connecting all devices cannot exceed 4000 feet (1219 m). The RS-485 bus can be configured
in straight-line or loop topologies.

Straight-line topology

(C)
D & /&

(D)
& © &

+\\{ N = +- @

)
:
|+

ﬁ
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>

RS-232 to RS-485 converter
B Shield

Wiring color codes for the Molex cable are provided in the
C IONB8650 Installation Guide that ships with the meter and is
available at www.se.com.

D Termination resistor

Loop topology

A RS-232to RS-485 converter
B Shield

C Termination block

General bus wiring considerations

Devices connected on the bus, including the meter, converter(s) and other instrumentation, must be
wired as follows:

» Connect the shield of each segment of the cable to ground at one end only.
+ |solate cables as much as possible from sources of electrical noise.

» Use an intermediate terminal strip to connect each device to the bus. This allows for easy
removal of a device for servicing if necessary.

+ Install a ¥4 Watt termination resistor (Rt) between the (+) and (-) terminals of the device at each
end point of a straight-line bus. The resistor should match the nominal impedance of the RS-485
cable (typically 120 ohms — consult the manufacturer's documentation for the cable’s
impedance value).

RS-485 connection methods to avoid

Avoid any device connection that causes a branch in the main RS-485 bus. This includes starand
tee (T) methods. These wiring methods can cause signal reflections that can lead to interference. At
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any connection point on the RS-485 bus, no more than two cables should be connected. This
includes connection points on instruments, converters, and terminal strips. Following this guideline
ensures that both star and tee connections are avoided.

* 0] ol ———
(A) - oj:go A
O
+
* 0 ot ___
_ o) of—-——
o O
O] LA
— 0 — -
O O
+

A Avoid 3-way 'Star' connection point
B Avoid 3-wat 'T' connection point

RS-485 biasing

The RS-485 +/- wires are floating (ungrounded) so there can be voltage signals on the wires even
when there is no device communicating on the bus. The amount of floating voltage depends on
many factors, such as capacitive effects in the RS-485 bus and noise in nearby systems. If the
floating voltage is high enough, it can be incorrectly interpreted as an RS-485 signal and cause your
meter to stop communicating. The meter has an RS-485 biasing option to prevent the RS-485 bus
from floating when devices are not sending data.

Setting RS-485 biasing using the front panel
1. Press and hold the ALT/ENTER button for a few seconds. The SETUP menu appears.

2. Use the navigation buttons to highlight the RS-485 COM port that you want to configure
(COM1 or COM4) and press ALT/ENTER to select.

3. Use the navigation buttons to highlight RS-485 BIAS and press ALT/ENTER to select.

4. Select either ON (RS-485 biasing applied) or OFF (RS-485 biasing not applied).
Setting RS-485 biasing using ION Setup

1. Open the Setup Assistant for your meter. See the ION Setup Help for instructions

2. Select Communications > Serial Settings.

3. Click the COM1 or COM4 tab. Select RS485 Bias and click Edit.

4. Select ON to apply RS-485 biasing or OFF to not apply RS-485 biasing.

5. Click OK.

Communications breakout cable

Refer to the ION8650 Installation Guide for the DB9 serial pin assignments for the optional breakout
cable female DB9 connector. A communications breakout cable facilitates communications
connections by connecting to the Molex male connector on your meter. The cable splits to a
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standard DB9 female connector and two RS-485 shielded, twisted pairs.

0—_

Molex male from the meter
Two RS-485 twisted pairs
RS-485 shield

DB9 female connector

OO0 w>»

Configuring RS-485

Using the front panel
1. Press and hold the ALT/ENTER button for a few seconds. The SETUP menu appears.

2. Use the navigation buttons to highlight the RS-485 COM port that you want to configure
(COM1 or COM4) and press ALT/ENTER to select.

3. Configure the settings (for example, Protocol, Baud Rate and Unit ID) to match your
communication system.

Disabling the COM port using the front panel

You have the option of disabling the COM port through the front panel when the port is not being
used.

1. Press and hold the ALT/ENTER button for a few seconds. The SETUP menu appears.

2. Use the navigation buttons to highlight the RS-485 COM port that you want to configure
(COM1 or COM4) and press ALT/ENTER to select.

3. Use the navigation buttons to highlight the Protocol setting and press ALT/ENTER to select.
4. Select None from the list of available protocols.

5. Select YES to confirm the change.

Using ION Setup

1. Open the Setup Assistant for your meter. See the ION Setup Help for instructions.
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1. Select Communications > Serial Settings.

2. Click the COM1 or COM4 tab and configure the settings (for example, Protocol, Baud Rate,
and Unit ID) to match your communications system.

Disabling the COM port using ION Setup
You have the option of disabling the COM port through ION Setup when the port is not being used.
1. Open the Setup Assistant for your meter. See the ION Setup Help for instructions.
1. Select Communications > Serial Settings.
2. Click the COM1 or COM4 tab, select Protocol from the list and click Edit.

3. Select None from the dropdown list and click OK.

Configuring the optical port

Refer to the ION8650 Installation Guide for optical port specifications.

The optical port available on ION8650 meters is compatible with standard magnetic optical
communications couplers, or optical probes (ANSI Type I). Optical probes are available both from
Schneider Electric and other suppliers as a separate product; contact Schneider Electric for a list of
suppliers. The original equipment manufacturer's warranty applies. See the Optical Magnetic
Couplers technical note for more detailed information.

Optical probes can communicate real-time measurements via the ION, RTU, DLMS, DNP 3.0,
Factory, or GPS protocols. You can configure the optical port communications settings with the
front panel, Power Monitoring Expert or ION Setup.

Using the front panel
1. Press and hold the ALT/ENTER button for a few seconds. The SETUP menu appears.
2. Use the up or down arrow buttons to select COM3 SETUP.
3. Press the ALT/IENTER button to access COM3 SETUP parameters.
4. Configure the settings (for example, Baud Rate, Unit ID, and Protocol) to match your
communications system.
Disabling the COM port using the front panel

You have the option of disabling the COM port through the front panel when the port is not being
used.
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4.
5.

Press and hold the ALT/ENTER button for a few seconds. The SETUP menu appears.

Use the navigation buttons to highlight the optic port (COM3) and press ALT/ ENTER to
select.

Use the navigation buttons to highlight the Protocol setting and press ALT/ENTER to
select.to select.

Select None from the list of available protocols.

Select YES to confirm the change.

Using ION Setup

1.
1.
2.

Open the Setup Assistant for your meter. See the ION Setup Help for instructions.
Select Communications > Serial Settings.

Click the COM3 tab and configure the settings (for example, Baud Rate, Unit ID, and
Protocol) to match your communications system.

To enable communications from the optical port, you must configure the COM3
communications. The Protocol, Baud Rate and Unit ID settings must properly match your
system. When creating a site, ensure RTS Control setting is disabled for the COM3 serial
site.

Disabling the COM port using ION Setup

You have the option of disabling the COM port through ION Setup when the port is not being used.

1.

2
3.
4

Open the Setup Assistant for your meter. See the ION Setup Help for instructions.

. Select Communications > Serial Settings.

Click the COMS tab, select Protocol from the list and click Edit.

. Select None from the dropdown list and click OK.

Using Power Monitoring Expert

1.
2.

Open Management Console and add a Direct Site.

Set the Serial Port to COM3 and ensure that the settings properly match your system. Ensure
that RtsCts is disabled for the optical port site in Management Console. Refer to the
Management Console section of the online Power Monitoring Expert help for details.

Configuring Ethernet connections

This section only applies if your meter has the Ethemet option. Refer to the ION8650 Installation
Guide for Ethernet port specifications and information on determining the options available on your

meter.
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Ethernef

Ethernet connections are made via the RJ45 modular jack on the rear of the unit. Use high quality
Category 3, 4 or 5 UTP cable (RJ45 female to RJ45 male) if you require an extension. The optional
Ethernet port is capable of data rates up to 10 Mbps and supports TCP/IP, FTP, ION, and
Modbus/TCP protocols. The meter supports a maximum of eight simultaneous Ethernet
connections with additional dedicated connections for Modbus master over TCP/IP and IEC 61850.

NOTE: Some features, such as IEC 61850, COMTRADE and Ethernet outage notification, require
that your meter has an Ethernet connection.

(=

QO © ©o

TCP/IP Modbus master dedicated TCP connection.
A Connect with up to 10 Modbus slave IP addresses. Refer to
"Third party protocols" on page 119

8 simultaneous connections. Protocols include ION, DNP,
and Modbus/TCP.

IEC 61850 dedicated connection for up to 5 IEC 61850
clients.

1 FTP connection.
SMTP server (email), outgoing only.

vs)

mao O

You can configure Ethernet communications using the front panel, Power Monitoring Expert or ION
Setup. In each case, you must configure the IP Address, Subnet Mask, Gateway, SMTP Server
and SMTP Connection Timeout to properly match your system. You must also ensure that the
network ports are either enabled or disabled, depending on your system configuration.

NOTE: The MAC address of your meter cannot be changed and is provided for information only.
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Using the front panel

1. Press and hold the ALT/ENTER button for a few seconds. The SETUP menu appears.

2. Use the up or down arrow buttons to select NETWORK SETUP and press ALT/ ENTER.

3. Configure the Ethernet Communications settings (for example, IP Address, Mask, Gateway,
SMTP Address and Port Enable) to match your communications system.

Using ION Setup

1. Open the Setup Assistant for your meter. See the ION Setup Help for instructions.

2. Select Communications > Basic Ethernet and click the IPv4 and TCP/IP tabs.

3. Select a setting and then click Edit. Configure the settings as required.

Parameter Values
Contact your local network

IPv4 Address .
administrator for parameter values.
Contact your local network

Subnet Mask

administrator for parameter values.

Contact your local network

Default Gateway .
administrator for parameter values.

Contact your local network

Rx Timeout .
administrator for parameter values.

Modbus Gateway 7801, 7802, 502

MAC Address Read-only

Description
Specifies TCP/IP Ethernet address.

The subnet IP address of your
network.

The gateway IP address of your
network.

Specifies the number of seconds the
meter will wait for communication
acknowledgments.

Specifies the port on which the
Modbus Gateway will send and
receive requests.

Your meter's media access control
(MAC)
address.

1. Select Communications > Advanced Ethernet and click the DNS and SMTP tabs.

2. Select a setting and then click Edit. Configure the settings as required

Parameter Values

Contact your local network

SMTP Connection  Contact your local network

Primary DNS .
administrator for parameter values.
Contact your local network
Secondary DNS . y
administrator for parameter values.
Contact your local network
SMTP Server

administrator for parameter values.

Timeout administrator for parameter values.

Description

The IP address of your network’s
primary DNS server, if your network
uses DNS.

The IP address of your network’s
primary DNS server, if your network
uses DNS.

The IP address of your SMTP
server.

Specifies the number of seconds the
meter will wait for communication
from the SMTP server.
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Using Power Monitoring Expert

After you wire your meter to the Ethernet network and perform basic setup, add the meter to your
Power Monitoring Expert network using Management Console.

To enable communications through the Ethernet port, you must configure the Ethernet
Communications module. Start Designer and configure the IP Address, Subnet Mask, Gateway,
SMTP Server and SMTP Connection Timeout registers to match your system.

Adding an Ethernet device to your Power Monitoring Expert network

In Management Console, the Ethernet Device Options screen appears when you add an Ethernet
device (meter). Use this screen to describe your meter’'s Ethernet address and other
communications information. Be sure to include:

+ the server computer that communicates with the Ethernet device.

» the Ethernet device TCP/IP address.

Domain name resolution (DNS)

You can configure the meter as a DNS client in systems using a DNS server.

A DNS server maps domain names to IP addresses. If you configure the meter to use a DNS
server, the meter can communicate with other network resources using their domain names, rather
than their IP addresses, and vice versa. For example, if your network has an SMTP server with the
domain name of smtp.company.com, you can enter smtp.company.com as the SMTP Server
address in the meter's communications settings.

Configuring EtherGate connections

The meter can function as an Ethernet gateway (EtherGate). EtherGate is a powerful
communications tool that lets you communicate through a gateway meter to a serial network
connected to the meter. When a meter installed on the Ethernet network has EtherGate enabled, a
master device (such as a workstation running Power Monitoring Expert) can communicate through
the gateway meter to a serial network of devices wired to the gateway meter's COM port. The
transfer of data between protocols is handled automatically. EtherGate is available on serial ports
COM1 and COM4 in place of the ION, Modbus Master, Modbus RTU, or DNP 3.00 protocols. With
EtherGate enabled, the meter permits the direct transfer of data from up to 62 devices (31 devices
per COM port).
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A
B
Cc

Gateway meter
Ethemet
Serial devices connected to the gateway meter

Install the serial devices, configure them and connect them to your Ethernet-connected gateway
meter. Ensure that each serial device is configured with the same baud rate and has a unique Unit
ID. Then use the meter’s front panel, Power Monitoring Expert or ION Setup to change the COM1 or
COM4 Protocol setting to EtherGate. You must then create an EtherGate site in Power Monitoring
Expert or ION Setup and add the serial devices to the EtherGate site. See The ION meter as an
Ethermnet gateway technical note for more information on setting up an Ethernet gateway.

Using the front panel to set the EtherGate protocol

1.
2.

4.

Press and hold the ALT/ENTER button for a few seconds. The SETUP menu appears.

Use the up or down arrow buttons to select the COM port that you want to configure (COM1 or
COM4) and press ALT/ENTER.

Scroll to PROTOCOL and press ALT/ENTER. Change the port's PROTOCOL setting to
ETHERGATE.

Press ALT/ENTER to set the protocol.

Using ION Setup to create an EtherGate site

Follow the instructions below to communicate to the devices on the RS-485 loop with ION Setup.

In ION Setup:

1.

Right-click on your workstation icon and select Insert Item. The New Network Item dialog
box appears.

Select Site and click OK. The New Site dialog box appears.
Click the General tab.

Configure the site as follows:

— Type asite name.
— Select Ethernet from the Comm Link options.
— Select the Gateway check box.

— Type the meter’s IP address and select a port in the Gateway Info fields. For the port,
select either 7801 for COM1 or 7802 for COMA4.

Click OK.

Right-click on your newly created site and select Insert Item. The New Network Item dialog
box appears.

Select Meter and click OK. The New Device dialog box appears.

Enter serial device information here and click OK. Your new device appears under your newly
created site.
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8. Repeat steps 5to 7 to enter each device on your serial network.

NOTE: Use a standard Ethernet connection in ION Setup to connect to and read data from
your EtherGate meter.

Using Power Monitoring Expert to create an EtherGate site

Follow the instructions below to communicate to the devices on the RS-485 loop with Power
Monitoring Expert.

In Management Console:
1. Create an Ethernet gateway site.

2. Configure your Ethernet gateway site with the IP address of the gateway meter. Select the IP
Port that matches the gateway meter's COM port that is connected to the RS-485 loop (select
7801 for COM1 or 7802 for COM4).

3. Add each of the devices on the RS-485 loop to the Ethernet Gateway site (you do not need to
add the gateway meter as a device).

NOTE: Use a standard Ethernet connection in Power Monitoring Expert to connect to and
read data from your EtherGate meter.

Enabling and Disabling Ethernet ports
Through the front panel, you can enable or disable the Ethemet ports on your meter.

Changing Ethernet configuration parameters without another method of configuration enabled may
cause loss of communications with your device.

NOTICE

DATA LOSS

Maintain sufficient access to communicate to and configure your device.

Failure to follow these instructions can result in data loss.

Follow the instructions below to enable and disable the Ethernet ports on your meter. Using the front
panel:

1. Press and hold the ALT/ENTER button for a few seconds. The SETUP menu appears.

2. Use the up or down arrow buttons to select NETWORK SETUP and press ALT/ ENTER.
3. Scrollto PORT ENABLE and press ALT/ENTER.
4

Select the port you want to change, and press ALT/ENTER. Select Yes to enable the port and
No to disable.

5. Select YES to confirm the change. Enter the meter password if prompted.
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Using ION Setup

See "Ethernet protocol control" on page 116 for instructions regarding enabling and disabling
Ethernet ports through ION Setup.

Meter FTP server

The meter can function as an FTP server, supporting IEC 61850 protocols, COMTRADE formatted
waveform files and TLS certificates. The FTP timeout period is 90 seconds on a control port. Only
one simultaneous FTP transfer connection is permitted. To connect to your meter, ensure that your
FTP software is configured to only use a single FTP connection. The recommended FTP software
is Windows Explorer or WinSCP running on a Windows-based machine.

NOTE: To connect to your meter using Windows Explorer, you must include the login and
password in the FTP connection string. For example, with standard meter security (no user
configured) and the front panel password of 2, to connect to a meter with an IP address of
123.45.6.78, the Windows Explorer connection string would be ftp:// 0:2@123.45.6.78.

The meter communicates using FTP on the following ports:

Description
21 Incoming commands connections
20 Active data connections
3000-3020 Passive data connections

File names are limited to ASCII characters that do not contain a blank spaceor/, \, ¢, *, ?, <, >, and
have a maximum length of 64 characters.

FTP folder structure

Your meter has the following FTP folder structure:
+ CASTORE: you can add and delete TLS certificates in this folder.

+ COMTRADE: you can read COMTRADE files from these folders, but you cannot delete or add
files.

» |EC61850: you can add an IEC 61850 configuration (CID) file to this folder to activate the IEC
61850 protocol functions of your meter.

For more information about using FTP for IEC 61850 or COMTRADE, refer to the IEC 61850
protocol and ION Technology protocol document or the COMTRADE and ION Technology technical
note.

Internal modem connections

This section only applies if your meter has the internal 56k modem or cell modem option. Refer to
the ION8650 Installation Guide for internal modem specifications and information on determining the
options available on your meter.

NOTE: The internal cellular modem option is only available on the ION8650 socket meter.
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56k universal internal modem

The 56k universal internal modem is accessed through COM2, supports all standard modem
protocols at transmission rates from 300 bps to 57600 bps (300 bps is only recommended for paging
applications) and can be shared by up to 31 devices on an RS-485 chain. It is available with a
standard six-pin RJ-11 phone plug. If you have multiple meters linked on an RS-485 loop, only the
first meter requires a 56k modem. This setup is referred to as a ModemGate (see "Configuring
ModemGate connections” on page 112 ). You can configure the settings of the 56k modem with the
front panel, Power Monitoring Expert or ION Setup.

To enable communications through the meter's 56k modem, configure the COM2 communications
Baud Rate, Unit ID, Protocol, and Modeminit setup registers as required for your system. See
"Configuring ModemGate connections” on page 112 for more information on this register.

NOTE: When the meter is equipped with the Alert module, the modem can initiate calls. Paging is
supported through numeric paging and the TAP1 protocol. See the Power Monitoring Expert online
help for details on managing modem connections, setting up periodic dial-out and configuring
remote site event notification.

Modemlinit setup register

The Modeminit setup register defines the initialization string for the internal modem with a maximum
of 47 characters. Edit the Modeminit register and enter the desired initialization string. The string is
sent to the modem as soon as you download the COM2 module. Note that the string is also sent to
the modem whenever the meter is powered up or the baud rate in the COM2 Communications
module is changed.

NOTE: Changing the Modeminit or Baud Rate setup registers while the internal modem is online
causes the modem to disconnect from the phone line.
Modem initialization strings

Refer to the Modem AT Commands technical note for a complete list of AT commands for meter
modems.

NOTE: The Modem AT Commands technical note also contains instructions on how you can
determine your meter's modem type based on the meter's serial number.
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Adjusting the modem initialization string for CTR-21 compliant modems

The table below shows the strings to add to the end of your modem configuration string setup
register for each of three possible scenarios.

Behavior Add to modem initializing string

Does not answer

(modem does not detect ring tone) "NC70

Does not dial In order of preference:

(modem does not detect dial tone *NC70, *NC70X0, *NC8 (Italy only)
Does not detect busy signal *NC70

If your local modem (not the internal modem) is not already set up, configure it with the Remote
Modem Setup utility in Power Monitoring Expert according to the instructions in the online help.
After the meter is installed and the internal modem is connected to the telephone network, the
COM2 module can be configured using the meter’s front panel, Power Monitoring Expert or ION
Setup. For information on how to connect the internal modem to the telephone network, refer to your
ION8650 Installation Guide.

Configuring COM2 through the front panel
1. Press and hold the ALT/ENTER button for a few seconds. The SETUP menu appears.
2. Use the up or down arrow buttons to select COM2 SETUP and press ALT/ENTER.

3. Configure the COM2 settings (for example, Baud Rate, Unit ID, and Protocol) to match your
communications system.

Disabling the COM2 port using the front panel

You have the option of disabling the COM port through the front panel when the port is not being
used.

1. Press and hold the ALT/ENTER button for a few seconds. The SETUP menu appears.

2. Use the navigation buttons to highlight the COM2 port and press ALT/ENTER to select.

3. Use the navigation buttons to highlight the Protocol setting and press ALT/ENTER to select.
4

. Select Yes to confirm the change.

Configuring the meter and modem site using ION Setup
1. Open the Setup Assistant for your meter. See the ION Setup Help for instructions.
2. Select Communications > Serial Settings and click the COM2 tab.
3. Select the setting that you want to configure and click Edit.
4

. Configure the COM2 settings (for example, Baud Rate, Unit ID, and Protocol) to match your
communications system.

Disabling the COM2 port using ION Setup
You have the option of disabling the COM port through ION Setup when the port is not being used.

1. Open the Setup Assistant for your meter. See the ION Setup Help for instructions.
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1. Select Communications > Serial Settings.
2. Click the COM2 tab, select Protocol from the list and click Edit.

3. Select None from the dropdown list and click OK.

Configuring the COM2 module using Designer

Before you can configure the COM2 module in Designer, you must add the meter (with the internal
modem) and a modem site to your Power Monitoring Expert network.

Adding a meter and a modem site to your Power Monitoring
Expert network

In Management Console, add the meter with the internal modem and a modem site to your Power
Monitoring Expert network. Describe how your remote modem is wired and other communications
information on the options screens.

Either before or after adding the modem site, you must add a dial out modem to the server computer.
The server computer dial out modem communicates to the modem at the modem site.

On the Modem Site Options screen, ensure that you:

+ Select the server computer that you want to communicate with the remote modem and that the
server computer dial out modem is configured.

* Enter the remote modem telephone number.

+ Set the baud rate of the modem site to the baud rate of the COM2 port to avoid communications
errors.

See the Power Monitoring Expert online help for more information.

Configuring the COM2 Communications module in Designer

Start Designer and configure the COM2 Communications module Baud Rate, Unit ID, and Protocol
setup registers to match your communications system. Configure the initialization string for the
internal modem using the Modemdnit register. Refer to "ModemlInit setup register" on page 110.

Configuring ModemGate connections

ModemGate is a powerful feature that creates a communications connection between the telephone
network and an RS-485 serial network of devices. When you specify the protocol for a meters COM
port as MODEMGATE, all data received by the meter’s internal modem is automatically transferred
to the serial network. ModemGate is available on either the COM1 or COM4 port; you cannot use
the feature on both ports simultaneously. The meter must have the COM2 modem option to function
as a modem gateway.
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Workstation with Power Monitoring Expert and modem
Telephone network

ModemGate meter equipped with optional internal modem
Devices on RS-485 loop

OO0 w>»

NOTE: The baud rate used between connected modems is independent of the internal baud rate
used for communication between the meter and its modem.

Wire a serial connection between one or more meters and the meter COM port hosting the
ModemGate (COM1 or COM4). You can make ModemGate connections through an RS-232 cable
to a single device or through an RS-485 shielded twisted pair cable to multiple devices. ModemGate
connections do not connect a workstation running Power Monitoring Expert (or other master device)
to the gateway meter's COM1 or COM4 port, but rather to the gateway meter’s internal modem port
(COM2); the meter then transfers the data to the serial devices connected to COM1 or COM4.

Configuring the meter for ModemGate
1. Install the meter and connect the internal modem.

2. Use the front panel, Power Monitoring Expert or ION Setup to set up the internal modem and
the serial communications port (COM1 or COM4) that is the ModemGate. You can enable
ModemGate on either COM1 or COM4, not both simultaneously.

3. Set the internal modem COM2 Baud Rate, Unit ID and Protocol. The baud rate must be the
same as the port hosting the gateway and all the devices connected to the gateway.

4. Set the protocol of the port connected to the RS-485 loop to MODEMGATE (either COM1 or
COM4). For each device on the RS-485 loop, you must also:

— Set the baud rate to the same value as the modem baud rate (COM2).

— Configure each device, including the gateway meter, with a unique Unit ID.

Configuring devices connected to the ModemGate meter

1. Use Power Monitoring Expert, ION Setup or the front panel to change and configure settings.
Ensure each device connected to the meter has the same baud rate as the meter ModemGate
port (either COM1 or COM4)
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2.

Ensure each device connected on the RS-485 network (including the meter modem) has a
unique Unit ID. Record the serial baud rate of the modem site and the Unit IDs for every
device in order to add the ModemGate and its meters to your network.

NOTE: Ensure RS-485 is selected for connections to multiple devices along the same bus.

Using ION Setup to create a ModemGate site

1.

8.

Right-click on your workstation icon and select Insert Item. The New Network Item dialog
box appears.

Select Site and click OK. The New Site dialog box appears.
Click the General tab.

Configure the site as follows:

— Type asite name.
— Select Modem from the Comm Link options.

— Click Modem configuration to access the Modem configuration wizard, which
configures your local and remote modems.

— Enter the phone number of the modem you are connecting to in the Phone Number field.
Click OK.

Right-click on your newly created site and select Insert Item. The New Network Item dialog
box appears.

Select Meter and click OK. The New Device dialog box appears.

Enter serial device information and click OK. Your new device appears under your newly
created site.

Repeat steps 5 to 7 to enter each device on your serial network.

Using Power Monitoring Expert to create a ModemGate site

To communicate to the devices on the RS-485 loop using Power Monitoring Expert:

1.
2.

Start Management Console and create a Modem Site.

Configure your modem site by typing in the appropriate fields or using the dropdown menus.
Include the meter’s internal modem telephone number and ensure that the server computer’s
dial out modem is configured. Refer to the online Power Monitoring Expert Help for information
on adding a dial out modem.

Adding ModemGate meters to the Power Monitoring Expert
network

1.

Start Management Console and click Devices. Right-click in the Devices display window and
select New > Serial Device on Direct Site.

2. Enter the information by typing in the appropriate fields or using the dropdown menus,

remembering that:
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— Unit ID: The value in the UNIT ID field identifies the meter on the RS-485 loop.

— Site: The ModemGate site that you created.

Internal cell modem

Syslog

Configuration of the internal cell modem is accessible through the front panel and ION Setup.

Two modems are available: CDMA and LTE. The CDMA modem supports the EV-DO Rev. A and
CDMA2000 1xRTT standards at transmission rates up to 3.1 Mbps downlink/1.8 Mbps uplink. The
LTE modem supports Cat 1 LTE standards at transmission rates up to 10 Mbps downlink/5 Mbps
uplink. Both modems allow for up to six simultaneous protocol data connections.

The cell modem requires network activation. For information regarding the network activation for
your region and modem, refer to the Powerlogic ION8650 cell modem product option document.

NOTE: The 56k modem and cell modem exist as separate ordering options. You cannot have a
56k modem and a cell modem on the same device.

Syslog uses the User Datagram Protocol (UDP) to transport event log information from the meter
directly to a centralized syslog server. The server can receive logs from many devices, then store
and filter the logs as needed. You can use ION Setup to modify the syslog network settings for your
device. Syslog is a useful feature to help maintain meter log information for extended periods of
time.

NOTE: Ethemet is required to use the Syslog feature.

Configuring Syslog network settings using ION Setup

1. Open the Setup Assistant for your meter. See the ION Setup Help for instructions.
2. Select Communications > Advanced Ethernet and click the SysLog tab.

3. Select Enable Syslog and click Edit. Select Yes to enable the syslog server or select No to
disable. Click OK.

4. Select Syslog Serverand click Edit. Enter the location for the syslog server. This value is
entered as an IP address in the format aaa.bbb.ccc.ddd. Click OK.

5. Verify that the syslog server is receiving log information from the meter.
NOTE: If the Enable Syslog register is enabled but the Syslog Serverregister does not contain an

IP address, an event is created in the event log that informs you that syslog is enabled with no
server IP.

Syslog Server

Syslog is an open standard allowing you to use any one of a number of syslog servers applications
currently available. The decision regarding which syslog server solution to use can be based on
budget and your technical requirements. See the individual syslog server's documentation for more
information.
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Event log priority to syslog severity

The following table lists the mapping between ION event priorities (0-255) and the Syslog severities.
Only four of the syslog severities are used in the mapping.

ION event priority range ION event priority name Syslog severity

0-63 None 6 - Informational

5 - Normal but significant
64-127 Low

condition
128-191 Medium 4 - Warning condition
192-255 High 2 - Critical condition

Ethernet protocol control

The Ethernet protocol control feature allows you to enable, disable, or change the port number of the
Ethernet protocols supported on your meter.

If you are connected to your device over Ethernet, changing Ethernet configuration parameters
without another method of configuration enabled may cause loss of communications with your
device and render it inoperable. In this case a factory reconfiguration of your device is required,
which resets your device to its factory defaults and all logged data is lost.

NOTICE

DATA LOSS

Maintain sufficient access to communicate to and configure your device.

Failure to follow these instructions can result in data loss.

NOTE: The protocol port number may not be configurable on all protocols.

Using the front panel

You cannot change the Ethernet port number assignments through the front panel.

Using ION Setup
1. Open the Setup Assistant for your meter. See the ION Setup Help for instructions.
2. Select Communications > Advanced Ethernet and click the Protocols tab.
3. Select a protocol from the list and click Edit.
4. Select the Enabled check box to enable the port.

NOTE: The IEC 61850 port is enabled when a valid CID file is uploaded to the meter. The
port is disabled by removing the CID file.
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NOTE: The EtherGate port is enabled if the applicable serial port is set to EtherGate. If the
serial port is set to a different protocol, the EtherGate port is closed.

5. Select a port number from the Port Number dropdown list or by clicking in the Port Number
field and entering a port number. Existing connections are not affected by the change, but any
new connections must comply with the meter’s latest settings.

6. Click OK. If multiple ports are set to the same number, ION Setup responds with a message
indicating that the port is already in use by another protocol.

Default Ethernet ports

Protocol Default port

ION 7700
DNP 20000
DLMS 4059
Modbus TCP 502
Modbus RTU over Ethernet 7701
EtherGate (COM1) 7801
EtherGate (COM4) 7802
SFTP/SSH 22
SMTP 161
NTP 123
IEC 61850 102
HTTP 80

HTTPS outage alerts

Your meter supports HTTPS for alert messages sent to outage notification servers.

HTTPS uses Transport Layer Security (TLS) encryption to secure the communications channel and
protect exchanged data between the client and the server. When configured to use HTTPS, the
meter uses the self-signed certificate installed on its FTP server.

For more information on Ethernet outage notification, see the Outage notifications on the
Powerlogic ION8650 product option document and the Alert module description in the ION
Reference.

Adding and deleting TLS certificates

Adding and deleting certificates—using both ION Setup and SFTP—requires the SFTP protocol on
the meter be enabled and the SFTP server be accessible.

Privacy-Enhanced Mail (PEM) files only are supported.

The meter supports a maximum of 10 certificates with a maximum total file size of 12 kB for all
certificates.

NOTE: The certificates on the meter cannot be read, only added or deleted.

To add or delete a TLS certificate using ION setup:
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2
3.
4

Open the Setup Assistant for your meter. See the ION Setup Help for instructions.
Select Communications > Basic Ethernet, and then click the Certificates tab.
Click Add to add a new certificate to the meter.

Select a certificate and click Delete to remove a certificate from the meter.

To add or delete a TLS certificate using SFTP:

1.
2.

Start your SFTP software.

Connect to your meter via SFTP by entering your meter’s IP address. Depending on your
SFTP software and meter security settings, you may be prompted for login credentials.

With standard meter security (no user configured), enter login credentials of 8650 and the
meter password to connect to the meter. For advanced meter security, enter a valid user and
password.

Navigate to the CASTORE folder on your meter.
Add and delete certificates as required.

Close your SFTP software to disconnect from the meter. The SFTP connection automatically
disconnects once the SFTP timeout period has elapsed.
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Third party protocols

This chapter explains how Modbus, DNP 3.0 and IEC 61850 protocols are implemented on the
meter.

It also contains brief instructions for configuring your meter to work with MV-90 systems.

For additional instructions on using the meter with Modbus, DLMS, IRIG-B, IEC 61850 and MV-90
protocols, see the following documents:

* Modbus protocol and register map for ION devices protocol document
* Modbus and ION Technology technical note

* DLMS/COSEM and ION technology protocol document

* IRIG-B GPS Time Synchronization technical note

» |EC 61850 and ION technology protocol document

* MV90 and ION technology technical note

In this chapter

Third party protocols overview . ... . . 120
Communications protocol configuration ... .. ... 120
The meteras Modbus slave .. il 120
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Third party protocols overview
The meter supports DNP 3.0, DLMS, Modbus RTU and Modbus/TCP, and IEC 61850 protocols.

Most Modbus, IEC 61850 and DNP modules that send meter data using these protocols are factory
configured and only require basic configuration, such as communications setup.

* Your meter is preconfigured to send Modbus data (acting as Modbus slave). It is not ready to
receive data as a Modbus master until you set up the necessary framework.

* Your meter is preconfigured to send DNP 3.0 data to a DNP master.

* You must use an IEC 61850 configuration tool and ICD file to configure the IEC 61850 aspects
of your meter, except for I/O and additional data values, which must be done through ION
Setup.

NOTE: Changing the default third-party protocol frameworks (or creating new frameworks to
enable receive functionality) is an advanced procedure that requires an understanding of the
protocol and the meter’s internal operation before you proceed. Refer to the descriptions in the ION
Reference of the DNP, IEC 61850 and Modbus modules. Refer to the Multiport DNP 3.0 and ION
Technology, DNP 3.0 Device Profile, IEC 61850 and ION Technology, and Modbus and ION
Technology documents for information on these protocols.

Communications protocol configuration

In order to use the pre-configured Modbus or DNP slave configuration, you must first assign the
communications protocol that you want to use to the applicable port. By default, all communications
ports are configured to use the ION protocol. Select the third-party protocol that you want from the
list of available protocols for the communications port you are configuring. See "Communications"
on page 91 for instructions. You do not have to assign a communications channel for IEC 61850, but
your meter must have an Ethernet connection.

NOTE: Modbus RTU is available on each of the meter's communications ports, and multiple ports
can communicate using Modbus simultaneously. Modbus TCP is available on the meter’s optional
Ethernet connection. Up to three ports can use the DNP 3.00 protocol at any one time.

The meter as Modbus slave

Your meter can act as a Modbus slave, using both the Modbus RTU and Modbus/TCP protocols.

The meter can act as a Modbus slave device, making any real-time data available through the
Modbus protocol. Modbus master devices connected to the meter can read this data or write data to
your meter’s ION registers (for example, to make configuration changes).

NOTE: If you encounter issues reading or writing to the device using Modbus, ensure that your
device’s security settings allow Modbus programming. See "Cybersecurity" on page 54 for more
information on device security.
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Using the Modbus RTU protocol

The factory Modbus slave configuration

The meter makes data available to Modbus master devices using pre-configured Modbus Slave
modules. These modules are linked to other modules in the meter that provide the energy, power
and demand data. Once a communications channel is configured to use Modbus RTU protocol, the
data is available to Modbus master devices.

NOTE: Connect to IP port 7701 for Modbus RTU communications over Ethernet. The Modbus unit
ID of the meter over Ethernet has a default value of 100.

e
Vs
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Q Vina G 40011

B (D)

Power Meter module

Measure data is linked to the Modbus module's input
Modbus Slave module

Modbus Slave module outputs data in Modbus format
Set the COM port to the Modbus RTU protocol
Communications port

Data is available to Modbus master devices

O Mmoo W >

As the data available through the Modbus Slave modules is in a specific format, knowledge of the
Modbus protocol and an understanding of the settings used in the meter are required to interpret the
data provided.

Changing the Modbus configuration

If the factory Modbus configuration does not suit your needs, the existing Modbus Slave modules
can be relinked to other parameters that you want to access through Modbus.

If your Modbus master device requires data in a format different than that provided by the factory
Modbus configuration, you can edit the setup registers in the Modbus Slave modules. These setup
registers specify the Modbus format, scaling and base address settings. Refer to the ION
Reference for complete details on the Modbus Slave module.

Configuring the meter as a Modbus slave

You cannot configure Modbus through the meter's front panel; you can only assign the Modbus
protocol to communication ports (see "Communications" on page 91 for details).

Use Power Monitoring Expert or ION Setup to perform full Modbus configuration.
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Using ION Setup
1. Open the Setup Assistant for your meter. See the ION Setup Help for instructions.
1. Select Communications > 3rd Party Protocols.
Click the Modbus Slave tab.
Select the map name (for example, Default) and click Edit. The Modbus map editor appears.

Edit, add, or delete the Modbus Slave module registers or the name of the Modbus map.

o » w DN

Click OK.

Modbus Slave modules

All ION8650 meters have nine Modbus Slave modules. Meters with EN51060 support (ION8650A
and ION8650B) have 11 additional modules. For a detailed Modbus map, refer to the Modbus
Protocol and Register Map for ION Devices document, available from www.se.com.

Importing data using Modbus RTU

Itis possible to bring data into the meter using Modbus. Various ION registers can be written to by
Modbus master devices by correlating the Modbus register number with the address of the ION
register you want to write to. When a Modbus register is written with a value, the corresponding ION
register is written, provided the Modbus RTU protocol is active on the communications port that
connects the Modbus master to the meter.

You can use the Modbus RTU protocol to write values into ION external numeric, pulse and
Boolean registers, allowing you to enable, disable and reset meter functions. You can also use the
Modbus protocol to change setup register values in various ION modules to configure the meter's
operation.

To bring data into the meter with Modbus RTU, you must disable the meter's password security.

Using the Modbus/TCP protocol

Modbus/TCP is an open Modbus protocol variant (formerly called MBAP). It defines the packet
structure and connection port (port 502) for the industry standard TCP/IP protocol. The structure of
Modbus/TCP is very similar to the Modbus RTU packet except that it has an extra six-byte header
and does not use the cyclic redundancy check (CRC). Modbus/TCP retains the Modbus RTU limit
of 256 bytes per packet.

NOTE: For Modbus RTU communications over Ethernet, connect to IP port 7701.

Modbus TCP communications

You can communicate to the meter using Modbus TCP. Your meter must have the optional Ethernet
port. Configure the meter to connect using connection port 502 to use Modbus TCP
communications protocols.
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NOTE: You cannot form an EtherGate connection to the Modbus TCP network. The Modbus unit
ID of the meter over Ethernet has a default value of 100.

| A Connect to port 502 |

The meter as Modbus master

ION8650 meters can act as a Modbus master using the Modbus RTU and Modbus/TCP protocols:

» The meter can Modbus master using Modbus RTU over serial connections between the meter's
COM1 or COM4 ports and the Modbus slave devices. It can Modbus master over both COM1
and COM4 simultaneously.

* Meters with an Ethernet connection can Modbus master over TCP/IP using up to ten available
TCP connections. These TCP connections are dedicated to Modbus mastering, and are not
included in the maximum of eight (8) Ethernet connections.

The meter acting as Modbus master can write data to (export) and read data from (import) Modbus
slave devices. The data can be processed by the meter and sent out using other communications
methods (email, Power Monitoring Expert, etc.). The meter can also send data directly to other
devices on a Modbus network.

NOTE: Modbus master functionality is not available on the ION8650C.
For more information on Modbus mastering, see the Modbus and ION Technology technical note.

NOTE: If you encounter issues reading or writing to the device using Modbus, ensure that your
device’s security settings allow Modbus programming. See "Cybersecurity" on page 54 for more
information on device security.

Configuring the meter as a Modbus master
This section describes the ION modules involved in using the meter as a Modbus master and using
ION Setup or Power Monitoring Expert.

The Modbus master configuration

There is no preconfigured Modbus master framework on your meter. This functionality must be
enabled by configuring the following modules in your meter's framework.
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Modbus master ION modules

Several ION modules work together to create Modbus master functionality on the meter. Your meter
has some or all of these modules, depending on the model and firmware version. See the /ON
Reference for more information on these and other ION modules:

Modbus Master Device module: reads data from a Modbus slave, which can be an ION meter
or third-party device. This imported data can be used by other ION modules. The Modbus
Master Device module references a Modbus Master Map module setup register to specify the
Modbus format, scaling, and base address settings.

Modbus Master Map module: provides a common place to hold setup information (used to
decode a Modbus response) for specific device types. This information can be referenced by
multiple Modbus Master Device modules.

Modbus Master Options module: maps any serial connection or Ethernet TCP socket from
the Modbus Import, Modbus Export and Modbus Master Device modules to any serial
communications port or unique IP address and port number.

Modbus Export module: provides write functionality.

Modbus Import module: provides read functionality. This data can then be used by other ION
modules.

NOTE: Modbus Export and Modbus Import modules are legacy modules and are provided for
backwards compatibility.

See the Modbus and ION Technology technical note for more information on configuring Modbus
master and /ION Reference for more information on the modules used in Modbus mastering.

Using the front panel

You cannot configure Modbus through the meter’s front panel. You can only assign the Modbus
protocol to communication ports. See "Communications" on page 91 for details.

Use Power Monitoring Expert or ION Setup to perform full Modbus configuration.

Using ION Setup

1.

2
3
4.
5

IS

Open the Setup Assistant for your meter. See the ION Setup Help for instructions.
Select Communications > 3rd Party Protocols.
Click on the Modbus Master tab.

Click Add to add a Modbus slave device. The Modbus Device dialog box appears.

. Type the slave device’s name and a label suffix (if applicable). Select the device type of the

slave device from the Device Type list (in this example, an ION6200).
Type the unit ID of the slave device in the Slave ID box.

Select the serial or TCP connection you want to configure from the Connected via list. This is
the connection used by the Modbus master to connect to that slave device. Click
Connections. The Modbus Device dialog box appears.

Select the tab that corresponds to the connection you are configuring (for example, if you
selected TCP Connection 1 from the Connected via list, select the TCP 1 tab), and edit the
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text boxes as follows:

— Serial Connections: Select the port that is connected to the Modbus slave devices from
the Assigned Port dropdown list.

— TCP Connections: Type the IP address of the Modbus slave device. Ensure that the IP
port is 502. You can enter up to ten (10) Modbus slave device IP addresses.

NOTE: For Modbus mastering over RTU, the total number of possible serial connections
is limited by the number of physical serial ports on the meter that can Modbus master. The
meter has two physical serial ports that support Modbus master (COM1 and COM4).

To Modbus master over Ethernet, the meter must have the optional Ethernet connection.

Click OK when you have finished configuring connections to return to the Modbus
Device dialog box.

9. Click OK to add the slave device. The device now appears in the list. Continue adding devices
by clicking Add until all devices are entered.

NOTE: The meter as Modbus master over TCP/IP will attempt to communicate to a slave for up to
100 seconds (as per the RFC 1122 standard) before moving on to the next slave device.

See the Modbus and ION Technology technical note for more information.

Using Power Monitoring Expert
Use Designer to configure Modbus master functionality on your meter.
1. Open the master meter in Designer.

1. Navigate to the Modbus Master Options module. Right-click on the center of the module icon
to access the ION Module Setup dialog box.

2. Configure the setup registers by selecting the setup register you want to change and clicking
Modify, or by double-clicking on the register.
— Serial Connections: Select the appropriate port from the dropdown list.
— TCP Connections: Enter the IP address of the Modbus slave device, followed by a colon

() and the IP port (502), for example, 192.168.0.1:502. You can enter up to 10 unique IP
addresses.

NOTE: For Modbus mastering over RTU, the total number of possible serial connections
is limited by the number of physical serial ports on the meter that can Modbus master.
The meter has two physical serial ports that support Modbus master (COM1 and
COM4).

To Modbus master over Ethernet, the meter must have the optional Ethernet connection.

3. Create a new Modbus Master Map module for each slave device. The Modbus Master Map
module has two setup registers:

— Device Type: Enter the type of device that you want to map. This value is referenced by

the Modbus Master Device module.

— Device Map: This is the data that you want to access from the Modbus slave device, in
the form of text strings containing the parameter label, register value, data format, etc.
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4. Create a new Modbus Master Device module for each slave device. Configure the following
setup registers in the Modbus Master Device module:

— Connection: Select the serial or TCP connection being used to communicate with the
slave device.

— Slave Addr: Type the unit ID of the slave device.

— Device type: Type a device type string. Ensure that this is the same as the device type
entered in the Modbus Master Map module.

— Slave name: Type a name for the slave device.
5. Link the module inputs and outputs as required.
6. Select File > Send & Save when you are finished.

See Power Monitoring Expert help for more information on creating, modifying and linking
modules in Designer and the /ON Reference for details of module setup and output registers.

Using the DNP 3.0 protocol

The Distributed Network Protocol Version 3.0 (DNP 3.0) is an open protocol used in the electric
utility industry for communications and interoperability among substation computers, remote
terminal units (RTUs), intelligent electronic devices (IEDs; for example, meters), and master
stations.

Your meter can be integrated into a DNP network as a DNP slave, using the DNP Slave Import,
DNP Slave Export and DNP Slave Options modules. For more information on the various DNP
modules, see the /ION Reference.

Y our meter supports a maximum of three concurrent connections (or “sessions”) using the DNP 3.0
protocol; one for each serial port, up to three using Ethernet, or a combination of both. Combinations
available depend on the meter's communications options. A session consists of all incoming and
outgoing DNP master/slave traffic on one of the meter's communications ports.

In addition to the standard DNP Slave Export modules with update rates of once per second, high-
speed versions of these modules with typical update rates of once per 8 milliseconds are available.
Additionally, millisecond timestamping is supported for DNP events.

Consult the DNP User’s Group at http://www.dnp.org/ to learn more about the protocol.

The factory DNP 3.0 configuration

Your meter is preconfigured with a DNP framework that allows for basic DNP slave functionality.
DNP Slave Export modules are used to send data to the DNP master while DNP Slave Options
modules provide per-session settings such as communications options. Although some minor setup
of the framework is necessary before it is enabled (assigning the DNP protocol to the
communications ports, for example), most module settings should not require alteration.

For information on your meter’'s default DNP map and factory configuration, see the ION8650 DNP
3.0 Device Profile.
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Importing data using DNP 3.0

Data can be imported into the meter from a DNP control relay or analog output device. DNP Slave
Import modules are used to take a DNP Analog output or Binary output object and map them into
ION registers.

NOTE: DNP Slave Import modules are not part of the factory DNP framework and must be added
manually. Refer to the DNP Slave Import module description in the /ON Reference for details.
Refer to the DNP 3.0 Device Profile protocol document for a description on the DNP 3.0
communications protocol used by the meter.

Configuring DNP 3.0

If the factory DNP configuration does not suit your needs, you can relink the existing DNP Slave
Export modules to access a different set of parameters through DNP. Altemnately, you can add
additional DNP Slave Export modules and link the desired parameters to them.

If your DNP network requires data in a format different than that provided by the factory DNP
configuration, you can edit the setup registers in the DNP Slave Export modules and the DNP Slave
Options modules. Do not make any changes to the DNP Slave Options modules’ setup registers
unless you understand the effects each change will cause. Refer to the /ON Reference for complete
details on DNP Slave Export and DNP Slave Options module function.

For detailed information on configuring your meter to use DNP, see the Multiport DNP 3.0 and ION
Technology technical note.

Using the front panel

You cannot configure DNP through the meter’s front panel. You can only assign the DNP 3.0
protocol to communication ports. See "Communications" on page 91.

Using ION Setup
1. Open the Setup Assistant for your meter. See the ION Setup Help for instructions.
2. Select Communications > 3rd Party Protocols and click on the DNP 3.0 tab.
3. Select the DNP feature you want to configure (for example, Parameter Map) and click Edit.
The Setup Assistant wizard guides you through DNP configuration. See the

ION Setup Help for more information.

Using the DLMS protocol

The Device Language Message Specification (DLMS) provides an interoperable environment for
structured modeling and meter data exchange. DLMS supports applications such as remote meter
reading, remote control, and value-added services for metering different kinds of energy, such as
electricity, water, gas or heat.

DLMS is an international standard published as IEC 62056.
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DLMS configuration

DLMS-enabled meters come preconfigured with frameworks that allow the meter to provide
selected values to a DLMS master. You need to configure the meter's communication settings
before you can access values using DLMS master software.

DLMS is available on Ethernet and all serial ports, including the front optical port. Use the front
panel or ION Setup to set the protocol for the serial communication port you want to use for DLMS.
Use ION Setup to enable DLMS over Ethernet and assign the port.

Serial configuration using the front panel
1. Press and hold the ALT/ENTER button for a few seconds. The SETUP menu appears.

2. Use the navigation buttons to highlight the COM port that you want to configure (COM1
SETUP - COM4 SETUP) and press ALT/ENTER to select.

3. Use the navigation buttons to highlight the Protocol setting and press ALT/ENTER to select.
4. Select DLMS from the list of available protocols.

5. Select YES to confirm the change.

Serial configuration using ION Setup
1. Open the Setup Assistant for your meter. See the ION Setup Help for instructions.

2. Select Communications > Serial Settings and click on the COM tab that corresponds to
the communication port you want to configure.

3. Select the Protocol parameter and click Edit.

4. Select DLMS from the dropdown list and click OK.

Ethernet configuration using ION Setup
1. Open the Setup Assistant for your meter. See the ION Setup Help for instructions.
2. Select Communications > Advanced Ethernet and click on the Protocols tab.
3. Select DLMS in the Protocols list and click Edit.
4

. Select the Enabled checkbox to enable DLMS over Ethernet, enter the port you want to use
and click OK.

Changing the data exported to DLMS client software

You can configure your meter to export the values from the Data Recorder modules to DLMS client
software. To do this, you need to map the applicable data recorder to a DLMS Log Export module
and configure that module’s setup registers with the appropriate OBIS codes.

NOTE: Changing these modules and any of their inputs from the default template is an advanced
setup procedure that requires an understanding of the protocol and your meter’s internal
operations.

1. Start ION Setup and open your meter in Advanced mode. See the online ION Setup help for
more information.

2. Navigate to the DLMS Log Export Module Modules folder.
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3. Create a new module or edit an existing module. Double-click the module to edit its

configuration.

4. Select the Inputs tab to link the module to a Data Recorder module.

— Select the input and double-click (or click Edit).

— Navigate to the Data Recorder module that you want to link to the DLMS Log Export

module and click OK.

NOTE: You can link a Data Recorder module to multiple DLMS Log Export modules, but
you can only link each DLMS Log Export module to one Data Recorder module.

5. Select the Setup Registers tab and double-click a register to edit it:

Setup register

Profile Generic OBIS

Status Register

OBIS Code Source 1—
OBIS Code Source 16

Description

Enter the Profile Generic OBIS code you want to assign to the
values associated with the module.

Setting this register to ENABLED includes the status field in the
Profile Generic object.

If the Record input of the associated Data Recorder module is
linked to a Periodic Timer, the status of the DLMS Log Export
module is updated at that recording interval. If the Data
Recorder Record input is not linked to a Periodic Timer, the
value of the status register is OxFFFF.

Enter the register attribute OBIS codes for each input of the
linked Data Recorder module that you want to export.

Each OBIS Code Source setup register maps to the equivalent
input register of the linked Data Recorder module. If you do not
want to export a value, enter NONE for that OBIS Code Source
setup register (this is the default value for a newly created
DLMS Log Export module).

6. Click Send to save your changes to the meter. Use your DLMS client software to validate that
you are receiving the expected values.

Related topics:

» See the DLMS User Association website at www.dlms.com for information about the DLMS

protocol.

+ See DLMS/COSEM and ION technology for more information about how DLMS is implemented

on your meter.

» See ION Reference for module settings and operation.

IEC 61850

IEC 61850 is an Ethernet-based protocol designed for electrical substations. It is a standardized
method of communications, developed to support integrated systems composed of multi-vendor,
self-describing IEDs (intelligent electronic devices) that are networked together to perform
monitoring, metering, and real-time, non-critical protection and control.

Your meter can be integrated into an IEC 61850 system as an |IED (or server), supporting concurrent
IEC 61850 client connections and an FTP connection (used for transferring data or configuration

files).

IEC 61850 configuration assumes that you have an advanced understanding of IEC 61850 protocol,
your communications network and the power system that your meter is connected to.
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Related topics:

+ See the IEC (International Electrotechnical Commission) website at www.iec.ch for general
information about the IEC 61850 protocol.

» Seethe I[EC 61850 and ION Technology protocol document for more information about how IEC
61850 is implemented on your meter.

» See the ION Reference for a description of the IEC 61850 ION modules.

Implementation

Your meter comes configured with a default set of meter data available to IEC 61850. This default
set of meter data is used in the default data sets and reports in the ICD file(s) available for download
at www.schneider-electric.com.

NOTE: Select the ICD file that matches your meter’'s option module configuration, and either
Edition 1 or Edition 2 of the IEC 61850 protocol.

You must load a valid IEC 61850 configuration (CID) file into the meter in order to activate the IEC
61850 features of your meter.

NOTE: Your meter can have only one IEC 61850 configuration (CID) file loaded onto its internal
FTP site. If additional CID files are loaded, IEC 61851 functions are deactivated until the additional
files are removed.

Your meter has five dedicated IEC 61850 client connections.

You can load the IEC 61850 configuration file and configure the IEC 61850 custom modules using
ION Setup.

Configuring IEC 61850

No meter port configuration is required for IEC 61850, but the meter must have an operating
Ethernet connection for IEC 61850 client connections and for FTP transmission of configuration and
data files.

Configuring additional ION data into IEC 61850

The IEC 61850 ICD file for your meter contains a comprehensive set of default data values.
Additional meter data values can be made available in IEC 61850 by mapping the ION data to the
GGIO Custom Analog or GGIO Custom Digital modules.

Using the front panel

You cannot configure IEC 61850 through the meter’s front panel.

Using ION Setup
1. Start ION Setup.

2. Open the Setup Assistant for your meter.
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3. Navigate to Communications > 3rd Party Protocols, and then select the IEC 61850 tab.

The CID status indicates whether the meter has received and validated an IEC 61850 CID file
and is operating as an IEC 61850 server:

CID status Definition

) The meter has received and validated an IEC 61850 CID file
IEC 61850 stack running . .
and is operating as an IEC 61850 server.
Missing CID file No IEC 61850 CID file is loaded into the meter.
Invalid CID file The IEC 61850 CID file is invalid

4. Select the information type that corresponds to the data you want to map and click Edit.
Custom Analog and Custom Digital allow you to map additional numeric (analog) or
Boolean/binary (digital) values into IEC 61850.

NOTE: Because Custom Analog and Custom Digital are ION modules, they can be
configured at any time, regardless of CID status.

5. Expand the Available registers list and select the custom analog or digital value that you want
to map into IEC 61850. Highlight the IEC 61850 leaf you want to map onto and click the >>
button to map the value. Click the << button to remove the value. Select Show all available
registers to show all the ION modules and their registers. Click OK to send your changes to
the meter.

Configuring meter digital 1/0 control via IEC 61850

By default, your meter’s I/O status values are available via IEC 61850. You can configure the meter
to provide IEC 61850 control of the meter's optional digital output hardware ports by configuring the
GGIO Onboard ION module and the Digital Output module.

NOTE: Refer to "Inputs / Outputs" on page 145 for details on how to configure your meter’s digital
inputs and outputs.

To control your meter’s digital outputs via IEC 61850, you must configure the Digital Output
module’s Source register to be the IEC 61850 digital status value (SPCS.stVal) output register. This
output register is written by the IEC 61850 system into the IEC 61850 GGIO Onboard module. You
must also disconnect the Digital Input module’s Status output register from the IEC 61850 GGIO
Onboard Digital Output Status input register or else you will create a circular reference and the
modules will go offline. Refer to the ION Reference for details of the IEC 61850 GGIO Onboard
module.
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A WARNING

HAZARD OF UNINTENDED OPERATION

» Do not use the meter for critical control or protection applications where human or equipment
safety relies on the operation of the control circuit.

» Be aware that an unexpected change of state of the digital outputs may result when the supply
power to the meter is interrupted or after a meter firmware or template upgrade.

Failure to follow these instructions can result in death, serious injury, or equipment

damage.

Using ION Setup
1. Start ION setup.
2. Connect to your meter in Advanced Mode.
3. Navigate to the GGIO Onboard folder and double-click on the module in the right- hand pane.
1. Select the Setup Registers tab.

2. Select the SPCS Control Mode register that corresponds to the digital output you want to
control through IEC 61850 and click Edit. A dialog box appears.

3. Select IEC 61850 ctlVal from the dropdown list and click OK.

4. Select the Inputs tab.

5. Select the digital output Status register for the digital output that you want to control through
IEC 61850. Click Delete.

NOTE: This digital input register must be deleted in order to prevent a circular reference that
will cause the affected modules to go offline.
6. Click Send to send your changes to the meter.

7. Select the Setup Registers tab and confirm that the Digital Output module’s setup registers
are appropriately configured.

8. Navigate to the Digital Output folder.
9. Double-click on the Digital Output module that you want to control through IEC 61850.

10. Select the Setup Registers tab and confirm that the Digital Output module’s setup registers
are appropriately configured.

11. Select the Inputs tab.
12. Select the Source register and click Edit.

13. Navigate to the IEC 61850 GGIO Onboard module and select the SPCS. stValoutput register
that corresponds to the digital output.

14. Click OK and Send to save your changes to the meter.
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Configuring MV-90

ION8650 meters can provide energy values to an MV-90 data management system. In order to
recognize and communicate with your meter, the MV-90 software requires meter configuration data
to create a master (master.dat) file for your meter.

Use ION Setup to:

» Generate a meter configuration (master.dat) file for your meter that can be imported directly into
your MV-90 system or printed for manual data entry.

» Configure your meter’s revenue data in MV-90 E-File or P-File data formats.

« Export an .hhf file to transfer revenue data from your meter to your MV-90 system using a
handheld device.

For more information, see the MV-90 and ION Technology technical note, available from the

website.
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Time

This chapter covers the meter’s clock and time synchronization, including IRIG-B GPS time
synchronization.

NOTE: References to NTP in ION devices or documentation should be interpreted as SNTP.

In this chapter

Time SYNChrONiZatioN . ... 135
Clock module Settings ... 136
Replacing the battery ... . 137
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Meter clock configuration

The Clock module controls the meter’s internal clock, which provides timestamps for data logged by
the device. The clock needs to be configured properly to ensure that internally logged data has
accurate timestamp information. The clock settings do not affect any data logs that are stored
external to the meter. The Clock module also receives the time synchronization signals sent to it by
a workstation running Power Monitoring Expert or ION Setup, updating the device’s clock when
required.

The Clock module’s Clock Source setup register defines how the meter’s internal clock auto-
corrects drift from its internally calculated time. A separate time source (such as a GPS receiver or
a DNP Master) can be used to synchronize the clock through a communications channel. By
default, the clock is set to synchronize from the line frequency.

See the ION Reference for more information on the Clock module and the Time Synchronization &
Timekeeping technical note for more information about time and ION meters.

Time synchronization

Time synchronization lets you synchronize your meter’s internal clock with all the other meters,
devices, and software in a network. After the meter is synchronized, all the data logs stored on the
meter have timestamps that are relative to a uniform time base. This allows you to achieve precise
sequence-of-events and power quality analyses using the data logged on the meter. Use Power
Monitoring Expert or ION Setup to broadcast time signals across the network, or utilize an external
source (such as a DNP Master or IRIG-B) to synchronize your meter’s clock.

Refer to the Time Synchronization & Timekeeping technical note for more information on
implementing time synchronization.

Refer to the DLMS/COSEM and ION technology protocol document for information on time
synchronization with DLMS.

IRIG-B time synchronization

ION8650 meters come with an IRIG-B connection for GPS time synchronization using unmodulated
IRIG-B time code data. The meter is configured to synchronize via IRIG-B GPS, after you wire the
meter to a GPS receiver and set the clock Time Sync Source and Clock Source parameters.

Any GPS receiver that outputs unmodulated IRIG-B time code data can be used as a time
synchronization source.

You can configure IRIG-B time synchronization to update if the GPS receiver is locked onto a
satellite source or to update regardless of whether the GPS receiver is locked onto a satellite
source. Refer to the Clock module description in the ION Reference for more information on this
setting.

NOTE: When using a GPS receiver for time synchronization, the recommended setting for baud
rate and 8N 1 for stop bits/parity.
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IRIG-B standard and specifications

The standard is outlined in the IRIG-STANDARD 200-04 “IRIG Serial Time Code Formats” prepared
by the Timing Committee, Telecommunications and Timing Group, Range Commanders Council.

Accuracy +/-1ms

Format IRIG-B0O0x" format (unmodulated IRIG-B time code)
Nominal Voltage 5Vdc +/- 10%

Maximum Voltage 8Vdc

" Coded expressions 0 to 7 are supported but the year data is not used by the meters.

Diagnostic module outputs and event log entries

The Diagnostic module output registers and event log entries update as described in the Time
Synchronization & Timekeeping technical note, with the following exceptions:

+ The GPS Receiver Status output register in the Diagnostics module is set to N/A.

+ The GPS locked and GPS unlocked event log entries are not generated.

Configuring the meter clock

Use Power Monitoring Expert or ION Setup to change the meter’s clock settings.

Using the front panel

You cannot configure the time using the front panel.

Using ION Setup
1. Open the Setup Assistant for your meter. See the ION Setup Help for instructions
2. Select the Clock screen.
3. Click the Timezone tab to configure your meter's clock settings. Select a parameter and click

Edit to change.

NOTE: For IRIG-B, set the Time Sync Source to IRIG-B and the Clock Source to COMM.

4. Click onthe DST Settings tab to configure your meter’'s daylight savings periods for up to 20
years. Select a parameter and click Edit to change.

5. Connect the meter to the time sync source (such as a GPS receiver output) if applicable

Using Designer

Open your meter in Designer and navigate to the Meter Clock Setup framework. Right- click on the
Clock module to edit.

Clock module settings

The setup registers in the Clock module specify timezone and Daylight Savings Time (DST)
parameters and time synchronization functions. Refer to the Clock module description in the ION
Reference for information on advanced settings you can configure.
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Setup register

Timezone

DST Start 1 ...
DST Start 20

DSTENd...
DSTEnd 20

DST Offset

Time Sync Source

Time Sync Type

Clock Source

Percent Battery
Remaining

Time Set Count

Time Sync Count

Local Time

Function Default

Sets the timezone the device is in, relative to 0
Greenwich Mean Time.

The date and time when DST begins for 20 %ﬁﬁg%g‘? I?é\'{tgﬁwce Ten}'] latg aRue {gr eol:ctee
separate years.
twenty separate years

The date and time when DST ends for 20
separate years. 3,600 seconds

The amount of time the clock is changed when COM3
DST begins or ends.

Specifies the communications port that

receives time sync signals. For Ethernet, it UTC
also specifies which protocol can time sync

the meter.

Specifies the type of time sync signal (Local or
Universal time).

Specifies the clock’s time synchronization
signal source (line frequency, communications Not applicable
signals, orinternal crystal).

The setting displays the approximate
percentage of battery life remaining. You
should only need to edit this parameter if you
have replaced the battery.

This setting displays the number of instances
that the meter time has been updated.

This setting displays the number of time
update requests received via Not applicable
communications.

The parameter is shown for information
purposes only. It displays the current local
time on the meter. To change this, you must
time sync the meter.

Line Frequency

Not applicable

Not applicable

When modifying setup registers of the Clock module in Designer, use the Format option to convert between UNIX and

conventionaltime. Referto the description of the Clock module in the online ION Reference for more details.

Typically, the DST Start and DST End registers do not need to be reconfigured for users in North
America. The factory defaults are the DST start and end dates for 20 years, in UNIX time (the
number of seconds since 00:00:00 UTC on Jan. 1, 1970).

Refer to the Time Synchronization & Timekeeping technical note for further details on using the
meter's time synchronization functions. Refer to the /ON Reference for more information on the
Clock module and its registers.

Replacing the battery

See the ION8600/ION8650 battery replacement instructions for more information.
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Demand

Demand is a measure of average power consumption over a fixed time interval. Peak (or maximum)
demand is the highest demand level recorded over the billing period.

Demand is measured using Sliding Window Demand modules. These modules are configured to
calculate the average current demand and kW, kVAR and kVA demand. The setup registers in the
demand module define time intervals for demand calculations, setting the sensitivity of the module’s
operation.

The meter has a default demand framework that is suitable for most utility applications. However, if
needed, you can customize it for your specific application.

This chapter explains how to configure and view demand values on your meter.

In this chapter

Sliding window demand . ... L 139
Peak demand ... ... . 139
Basic demand framework . ... .. il 139
Configuring demand reset [oCKoUt time . ... L 140
Demand ForgiVeNeS S ... 141

Configuring Demand Forgiveness ... ... . 143
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Sliding window demand

Sliding window demand is often referred to as rolling block demand. To compute sliding window
demand values, the meter uses the sliding window averaging (or rolling interval) technique which
divides the demand interval into sub-intervals.

The demand is measured electronically based on the average load level over the most recent set of
sub-intervals. This method offers better response time than fixed interval methods.

The meter uses the Sliding Window Demand module to calculate sliding window demand.

Peak demand

Power utilities generally bill commercial customers based on their peak usage levels, called peak
demand (in kW) and energy consumption (in kWh). Demand is a measure of average power
consumption over a fixed time interval, typically 15 minutes. Peak (or maximum) demand is the
highest demand level recorded over the billing period. Sliding window demand is one method of
measuring demand.

Basic demand framework

In the following diagram, the Sliding Window Demand module labeled “Demand” calculates demand
from the power input by measuring and averaging the power over a set interval. The demand value is
then output to a Maximum module labeled “Peak Demand” that records the highest demand value
over time (peak demand).

o 06 e |0 (E)

Power

DEMAND
Sliding Window Demand module

Power output averaged (Demand)

PEAK DEMAND
Maximum module

Maximum value (Peak)

m T O W >»

For more information on ION modules, refer to the online ION Reference.
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Configuring demand

Use Power Monitoring Expert or ION Setup to change your meter's demand settings.

Using the front panel

You cannot use the front panel to configure demand.

Using ION Setup

The Demand screen in the Setup Assistant helps you configure sliding window (or rolling block)
demand. This screen also contains two registers used for configuring sliding window demand while
the meteris in TEST mode.

In ION Setup:
1. Open the Setup Assistant for your meter. See the ION Setup Help for instructions.
2. Select the Demand screen.

3. Select aregister and click Edit to configure.

Using Designer
Open your meter in Designer and navigate to the Demand Setup framework. Click on Demand
Setup to access the Sliding Window Demand modules. Right-click on a module to edit.

Sliding Window Demand module settings

The following table outlines the sliding window demand settings. See the ION Reference for more
information about the Sliding Window Demand module.

Setup .
. Function Default
register
Sub Intvl The time, in seconds, in the sliding window demand sub-interval. 900
#Sublntvls  The number of sub-intervals in the sliding window. 1
The speed of Predicted Demand calculations; use higher values for
Pred Resp . 70
faster prediction (70 to 99 recommended).
Varies
Update Rate Defines the update rate of the SWinDemand output register depending on
the module

Configuring demand reset lockout time

The demand reset lockout time sets the minimum time allowed between consecutive demand
resets; the meter ignores any attempts to reset demand that occur within the lockout time. The
default demand lockout time is 25 days (2160000 seconds).
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Using the front panel
1. Hold down the ALT/ENTER button to access the SETUP menu.

2. Use the up and down arrows to highlight DISPLAY SETUP then press the ALT/ENTER
button.

3. Use the up and down arrows to highlight DMD LOCK TO then press the ALT/ENTER button.

4. Use the up and down arrows to enter a demand lockout time in seconds. Press ALT/ENTER
to apply the value.

Using ION Setup
1. Open the Setup Assistant for your meter. See the ION Setup Help for instructions
2. Select the Demand screen and click the Rolling Block tab.

3. Select Demand Lockout and click Edit. Enter a demand lockout time in days (in Elapsed
Interval Format) or seconds (in Numeric Bounded Format). Click OK.

Demand Forgiveness

Demand Forgiveness is the time programmed to the meter during which demand (and therefore
peak demand) will not be calculated in the power restoration period following a total power outage.

During power-up following a complete power outage, customer equipment consumes a higher than
normal amount of power. Demand Forgiveness lets a utility forgive the customer for peak demand
penalties that can arise from power-up following a power outage (should the outage exceed a user-
specified period of time).

Demand and Peak Demand module behavior during Demand

Forgiveness

A peak demand value is the highest demand value since the last peak demand reset. The Demand
Forgiveness framework sets the Sliding Window Demand module inputs to zero during a Demand
Forgiveness period. This method allows demand interval data to accurately reflect a complete
interval that includes data:

* Prior to an outage

+ During the Demand Forgiveness period (zero values)

+ Afterthe Demand Forgiveness period.
NOTE: During a Demand Forgiveness period, Sliding Window Demand module inputs are set to
zero and do not reflect actual demand. These values should not be used to calculate energy for

billing purposes. Energy values are not affected and reflect actual energy consumption during the
Demand Forgiveness period.

The settings listed below must be made configured for Demand Forgiveness functionality. These
settings can be accessed from ION Setup; refer to "Using ION Setup" on page 144.

* Minimum Outage Duration lets you specify the amount of time (in seconds) that the power must
be out before the Demand Forgiveness period begins.
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» Demand Forgiveness Duration lets you specify the amount of time (in seconds) that demand is
forgiven (demand inputs are zero).

» Update Rate lets you define the update rate of the SWinDemand output register. It is set to
Every Second by default for revenue-related demand modules; with this setting, demand value
measured is updated once per second.

» Outage Voltage (line-to-line average in unscaled meter units) lets you define a voltage level that
is considered an outage. This is set to 20 volts by default.

A

o N— -
1:30 1:45 2:00 9

1 KW

2 Time

3 Demand Forgiveness begins

4 Demand Forgiveness ends

A The specified amount of time that the power must be out before demand is
forgiven.

B The specified amount of time that demand is delayed during the Demand

Forgiveness period.
Demand Interval #1
D Demand Interval #2

Demand Interval #3

The preceding diagram shows an example of a meter that is set up for Demand Forgiveness. The
Sliding Window Demand module is averaging demand values at 15-minute intervals. During interval
#1, the meter has a power outage that lasts for 18 minutes. The power outage is defined by a
system voltage of 20 volts which is specified in the Outage Voltage setting. The Minimum Outage
Duration setting is specified as 10 minutes, so this is the amount of time that the power must be out
before demand can be forgiven. The Demand Forgiveness Duration setting is specified as 1800
seconds (30 minutes), so for 30 minutes following power restoration, demand inputs are zero. The
power is restored during interval #2, where the surge of power consumption during power-up is
included in the Demand Forgiveness period and has a value of zero.
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Additional Information

The following points are important to note:

» The following demand input values are zero for kQ, kW, kVA, and kVAR during the Demand
Forgiveness period:

— Delivered
— Received
— Delivered + received
— Delivered —received
- Q1,Q2,Q3, Q4
» Ifanew peak is set prior to a power outage, it persists.

« Even though demand is zero during the Demand Forgiveness period, a new peak can be set if
the demand was very high prior to the power outage or after the Demand Forgiveness period
ends.

+ Demand Forgiveness works for auxiliary and blade powered meters.
* Al ION modules in the Demand Forgiveness framework are fully locked.

+ If aDemand Forgiveness period is initiated, and another power outage occurs that is less than
the time specified in the Minimum Outage Duration setting, the Demand Forgiveness period
continues. If a second outage is greater than the time specified in the Minimum Outage Duration
setting, the Demand Forgiveness period restarts.

» Both the power outage downtime and the Demand Forgiveness downtime are stored within the
Demand Forgiveness framework. The Store modules preserve a timestamp that is viewable in
Vista.

+ The Sliding Window Demand module Update Rate setup register must be set to
EVERY SECOND (this is the default for revenue-related demand modules).

+ If Demand Forgiveness is enabled on an auxiliary-powered meter and there is no power on the
blades, the meter assumes that this is an outage. When power is applied to the blades, demand
is forgiven for the specified time.

» If Demand Forgiveness is enabled and the meter is unplugged for servicing or other reasons,
the Demand Forgiveness framework assumes there was an outage and demand is forgiven for
the specified time.

+ For meters where Demand Forgiveness is enabled at the factory (for example, certain certified
revenue-sealed meters), demand is not measured when the meter is first put into service.
Instead demand is forgiven for the specified time.

Configuring Demand Forgiveness

Demand Forgiveness is disabled by default. Use ION Setup to enable Demand Forgiveness.

NOTE: If Demand Forgiveness is enabled, do not use demand values to calculate energy for
billing purposes. Energy values are not affected and reflect actual energy consumption during the
Demand Forgiveness period.
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Using the Front Panel

You cannot enable or edit Demand Forgiveness settings using the front panel.

Using ION Setup
1. Open the Setup Assistant for your meter. See the ION Setup Help for instructions.
2. Select the Demand screen and click the Demand Forgiveness tab.

3. Select Demand Forgiveness Enable. Click Edit and select ON. This enables Demand
Forgiveness.

4. Select Min Outage Duration and click Edit.

Type the amount of time (in seconds) that the power must be out before the Demand
Forgiveness period starts. Click OK.

5. Select Demand Forgiveness Duration and click Edit.

Type the amount of time (in seconds) that demand is forgiven (demand inputs are zero). Click
OK.

6. Select Outage Voltage if required and click Edit.

Type the minimum voltage (line-to-line average in unscaled meter units) that is considered an
outage; by default this is set to 20 V, but you can adjust this. Click OK.

7EN02-0306-05 Page 144 of 210



ION8650 User Manual Inputs/ Outputs

Inputs / Outputs

You can use the ION8650’s onboard 1/0 for a variety of applications.

For example, you can use a Form A digital input to monitor a breaker to verify how many times the
breaker trips. When the breaker reaches its limit for the number of trips, you can use the digital
output to light an LED next to the breaker, so field personnel are alerted. You can also use a Form C
digital output to send KYZ pulsing information to third-party system equipment.

NOTE: The Ethemet outage notification card uses the same physical slot as the 1/0 option board,
which means that you cannot have both optional I/0O and outage notification on the same meter.
This chapter provides information on the meter’s various digital and analog inputs and outputs (I/O).

Refer to your ION8650 Installation Guide for instructions on wiring inputs and outputs and for the
general meter I/O specifications.

In this chapter

/O configuration .. 146
Specifyingan /O portinamodule . ... . 148
Using the onboard digital OUtpUtS .. ... . . 149
Using the optional onboard digital iInputs . ... . 151
Using the optional analog OUtpULS ... . 152
Configuring INpuUts and OULPULS . ... o e 153
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I/0 configuration

The meter’s digital and analog I/O ports simplify data gathering by importing a variety of data types
into a single, common system.

You need to configure the following modules in order to use the meter for digital and analog I/0
capabilities.
 Digital Input: Digital (status) inputs can be used for monitoring external contacts or pulse

counting applications and are controlled by Digital Input modules. This module tells the meter
how to interpret incoming signals.

+ Digital Output: Digital outputs are used for hardware relay control or pulse counting
applications. The outputs can be controlled by Digital Output modules, Pulser modules, or
Calibration Pulser modules, depending on the application (relay switching or energy pulsing). An
example of a commonly used application for each module is listed below.

— Digital Output module: Monitors a change of state to control relay operation via a hardware
output device.

—Pulser module: Transfers high-speed pulses to a hardware pulse counting device that is
used to track energy usage.

— Calibration Pulser module: Integrates instantaneous power inputs, then outputs high-speed
pulses to an LED that can be monitored to verify revenue meter calibration.

All modules can act as intermediaries between the hardware port and the other modules in the
meter. They define the characteristics of outgoing signals.

» Analog Output: Analog outputs can deliver a continuous DC signal and are controlled by the
Analog Output modules.

See the ION8650 Installation guide for 1/0 wiring instructions.
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A Onboard I/O
B Onboard I/O
C Expanded I/O (and serial COMs): Molex Micro-Fit 24 pin male connector
D Optional Onboard I/0: 16 pin male connector.
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Optional I/0O Expander for serial communications and expanded 1/O. For more
information, see the PowerLogic I/O Expander Installation Guide.

Serial COMS:
COM1: RS-232 or RS-485
COM4: RS-485, depending on the options ordered for the meter.

E Depending on the version of the I/0 Expander that you ordered, you can have:
» Eight Form A digital inputs
» Four Form C digital outputs
* Four Form A digital outputs

* Four analog outputs

Onboard I/O breakout cable with female connector and sixteen bare-ended
F wires.
See your meter's Installation Guide for installation instructions.

1/0 Expander for ION8650 meters

For analog or additional digital I/O with the meter, you can use an external

1/0 Expander. Information for the analog and digital I/0O Expander options is available in the I/O
Expander Installation Guide.

Specifying an 1/O port in a module

For detailed information and instructions on configuring Analog and Digital I/O modules, see the /ON
Reference.

Configure the Digital Output, Digital Input, Analog Output, Pulser, and Calibration Pulser modules to
specify which port handles the outgoing or incoming signals. To assign a port to one of these
modules, simply modify the Port setup register by picking a port from the enumerated list. This can
be done with both ION Setup and the Designer component of Power Monitoring Expert.

The following table describes the ports that can be configured (in the Digital Output, Digital Input,
Analog Output, and Calibration Pulser modules) to handle outgoing or incoming signals.

NOTE: You must confirm the meter I/O options (onboard and/or I/O Expander) to determine which
of the following apply to your meter.

Hardware port Port setup register

ION module type ION module name . Description
(device label) name

Onboard digital output ports
On-Board FormA Out  Digital Output port 1

DO Onbrd RA-1 Al 1 (Form A Solid State)
Digital Output (DO) DO Onbrd RC-1 to C1lioCa On-Board FormC 1to Digital Output port 1 to
DO Onbrd RC-4 On-Board FormC 4 4 (Form C Relay)
VARh Pulse LED Watt LED WATT LED LED Output
Calibration Pulser Wh Pulse LED VAR LED VAR LED LED Output

Onboard digital input ports
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Hardware port Port setup register
ION module type ION module name . S i Description
(device label) name
DI-S9 S1 On-Board FormA 1 Digitf‘;(')’:ﬁ]“}\‘)m 1
Digital Input (DI) .
On-Board FormA2to Digital Input port 2 to 3
DI-$10, DI-S11 52,83 On-Board FormA3 (Form A)

1/0 Expander digital output ports

DORC-1to /O Exp FormC 1to Digital Output port 1 to

Oreital Outout (DO DO RC-4 Clies 1/0 Exp FormC 4 4 (Form C)
igital Output (DO) DORA-1to A to Ad /O Exp FormA 1to  Digital Output port 1 to
DORA-4 1/0 Exp FormA 4 4 (Form A)
1/0 Expander digital input ports
Digital Input (D!) DI-S1to DI-S8 A-1to A4 VOExpin1to Digital input port 1-8
g P I/OExpIn8 (Form A)
I/0 Expander analog output ports
Analog Out 1 to I/OExpAnOut 1to  Analog Output port 1
Analog Output (AO A1toAd
g Output (AG) Analog Out 4 © I/0O Exp AnOut 4 to4

Configuring energy pulsing applications

To configure the LED outputs for energy pulsing applications (for example, kVAh), see "Energy
pulsing" on page 154.

Using the onboard digital outputs

Digital outputs are used for hardware relay control or pulse counting applications. For example, the
meter’s digital outputs can provide on/off control signals for capacitor banks, generators, and other
equipment. The digital output ports can also send out status signals or kWh pulses, if the receiving
device determines energy usage by counting pulses.

A meter with the optional onboard I/O provides four Form C digital outputs and a Form A digital
output. All digital outputs can deliver a continuous signal or a pulse.

Contact Schneider Electric for complete information regarding relay applications.

Digital Output modules

A WARNING

HAZARD OF UNINTENDED OPERATION

» Do not use the meter for critical control or protection applications where human or equipment
safety relies on the operation of the control circuit.

» Be aware that an unexpected change of state of the digital outputs may result when the supply
power to the meter is interrupted or after a meter firmware or template upgrade.

Failure to follow these instructions can result in death, serious injury, or equipment

damage.
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These outputs can be controlled with Digital Output modules, Pulser modules, or Calibration Pulser
modules, depending on the application. For relay and control, the Digital Output module is used. For
pulsing applications, the Pulser or Calibration Pulser modules are generally used.

You must configure these modules in order to use the output ports.

+ Calibration Pulser modules allow you to generate high accuracy energy pulses for verifying
meter accuracy. They integrate instantaneous power inputs.

» Digital Output modules accept Boolean inputs and output a continuous signal or pulses.

» Pulser modules convert instantaneous pulses to pulses or transitions.

Configure the settings of the controlling module to match your requirements. Ensure that the
module’s Port setup register matches the meter's output that you want to control.

For detailed information and instructions on configuring these modules, see the ION Reference.
For information on the default settings for the modules, see the ION Device Template

Reference.

The available settings for these modules are as follows:

ION module

Port

Digital Output

Pulse Width
Polarity
EvLog Mode

Port

PulseWidth

Pulser OutputMode

Polarity

Setup register

Available settings

Not Used

WATT LED

VAR LED

1/0 Exp FormC 1
1/0 Exp FormC 2
1/0 Exp FormC 3
1/0 Exp FormC 4
1/0 Exp FormA 1
1/O Exp FormA 2
1/0O Exp FormA 3
1/0 Exp FormA 4
On-Board Form C 1
On-Board Form C 2
On-Board Form C 3
On-Board Form C 4
On-Board FormA Out 1

0 to 2000000
Fixed at NON-INVERTING
Log on or Log off

As per Digital Output, above

0.020 to 2000000
Pulse orKYZ

Fixed at NON-INVERTING

Description

Determines the output hardware
channel

Pulse Width, in seconds (0 for
continuous pulse)

Specifies a non-inverted (or level)
pulse

Determines whether to log status
changes in the Event Log

Determines the output hardware
channel

Pulse width, in seconds
Full pulse or KYZ (transition pulse)

Specifies a non-inverted (or level)
pulse
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ION module

Calibration Pulser

Setup register Available settings Description

Port As per Digital Output, above The output hardware channel
Pulse Width 0.010to 1.000 Pulse Width, in seconds

Kt 0.01 to 1000000000 Watts per pulse

Int Mode E(;rtward, Reverse, Absolute, or Lrg%%rt%téon modes that can be
OutputMode Pulse orKYZ Full pulse or KYZ (transition pulse)

Using the optional onboard digital inputs

Digital inputs are used for status monitoring or pulse counting applications. Status monitoring can
help you prevent equipment damage, improve maintenance, or track security breaches. Common
status monitoring applications include monitoring:

» closed/open positions of breakers.

+ on/off status of generators.

+ armed/unarmed conditions in a building alarm system.
» over/under pressures of transformers.

The function of each status input is controlled by a Digital Input module; this module tells the meter
how to interpret incoming signals. Digital Input modules can be linked with other modules for
counting status changes.

NOTICE

VOLTAGES OVER 130 VDC CAN DAMAGE DIGITAL INPUTS

Do not use digital inputs for voltage sensing applications.

Failure to follow these instructions can result in equipment damage.

For detailed information and instructions on configuring these modules, see the /ION Reference. For
information on the default settings for the modules, see the ION Device Template Reference.

The available settings in the Digital Input modules are as follows:

Setup

Available settings Description

register

Specifies complete pulse or KYZ
transition pulse

Specifies whether to log status
changes.

Digital Input status changes have an
event priority of 20.

Setting for the mechanical contact
bounce, in seconds

Polarity Fixed at NON-INVERTING Specifies a non-inverted (or level) pulse

Input Mode  Pulse, KYZ
EvLog Mode Log On, Log Off

Debounce numeric
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Setup
register

Available settings Description

/O MODULE IN1 to I/O MODULE IN 8,

NOT USED Specifies which hardware port the
Port module controls

/OExpIn1to8

On-Board FormA 1to0 3

Using the optional analog outputs

Analog outputs let you output real-time power to an RTU or perform equipment control operations.
The analog outputs provide industry standard 0 to 20 mA current signals. These outputs are only
available with the optional I/O Expander.

A WARNING

HAZARD OF UNINTENDED OPERATION

Do not use the meter for critical control or protection applications where human or equipment
safety relies on the operation of the control circuit.

The electrical signal on the output is DC. Make sure proper polarity is observed when wiring
external devices to the analog output ports.

Failure to follow these instructions can result in death, serious injury, or equipment
damage.

Four Analog Output modules control the optional I/O Expander’s analog outputs. These modules are
not linked by default. Link the numeric output of another ION module to the Source input of the
Analog Output module—this value is represented on the I/O Expander’s analog output port. Setup
the Zero Scale and Full Scale setup registers of the Analog Output module to the numeric range you
want to emulate.

For detailed information and instructions on configuring these modules, see the /ION Reference. For
information on the default settings for the modules, see the ION Device Template Reference.

The available settings in the Analog Output module is as follows:

Setup
register

Available settings Description

I/0 EXP AnOut 1 to I/0O EXP AnOut 4, o
NOT USED Specifies the output hardware channel.

Port
Sets the measured value that will

Full Scale -1x10°to 1 x 10° create the maximum possible output on
the analog output hardware port.

Sets the measured value that will
Zero Scale -1x10°to 1 x 10° create the minimum possible output on
the analog output hardware port.
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Ensure that the module’s Port setup register matches the I/0O Expander’'s output that you want to
control. If the port you want to use does not appear in the Port setup register list, that port is in use
by another module. Edit the Port setup register of the module using that port and set it to NOT
USED -the port is then available to other modules.

See the I/0 Expander Installation Guide for more information on the 1/0O Expander and the /ON
Reference for more information on the Analog Output module, including details are setting the zero
and full scales. Both documents are available from www.se.com.

Configuring inputs and outputs

Use Power Monitoring Expert or ION Setup to configure the meter's 1/0O framework.

Using the front panel

You cannot configure I/O using the meter’s front panel.

Using ION Setup
The Setup Assistant helps you configure your meter’s optional (onboard and I/0O Expander) analog

and digital inputs and outputs.

NOTE: See "Energy pulsing" on page 154 information on configuring the Calibration Pulser
modules in ION Setup.
In ION Setup:

1. Open the Setup Assistant for your meter. See the ION Setup Help for instructions.

2. Select either the Onboard 1/0 or the Expander 1/O folder and select the screen for the I/O
type that you want to configure.

The tabs on the 1/0 screens correspond to the associated modules (for example, Onboard 1/0
> Digital Outputs > A1 allows you to configure Digital Output module RA-1).

3. Click the tab you want to edit.
4. Select the parameter and click Edit to edit a value.

5. Select Source and click Edit to link a module to a source. Navigate to the source register you
require and click OK.

Using Designer

Open your meter in Designer and navigate to the Advanced Setup framework. Click on the
appropriate grouping object (Digital Inputs, Digital Outputs or Analog I/O) and right- click the module
that you want to edit.

7EN02-0306-05

Page 153 0of 210



ION8650 User Manual Energy pulsing

Energy pulsing

Your meter uses Calibration Pulser modules and Pulser modules for energy pulsing.

+ Calibration Pulser module — The Calibration Pulser module is a highly accurate energy pulser
used for verifying accuracy on meters employed in billing applications. This module type serves
as an intermediary between the power (kW, kVAR or kVA) outputs of the Power Meter module
and a device’s hardware output channel. Refer to the PowerlLogic ION8650 accuracy
verification technical note for instructions on verifying the accuracy of your meter. By default,
two Calibration Pulser modules are configured and linked to the front panel LEDs.

+ Pulser module — The Pulser module serves as an intermediary between other modules’ pulse
output registers (accepting them as pulse inputs) and a hardware output channel on the device.
These modules can send pulses or pulse transitions to any hardware output channel.

See the ION Reference for more information on these modules.
This chapter provides instructions for configuring energy pulsing on your meter.

In this chapter

Energy pulsing With LE DS . . 155
Configuring energy PUISING . . . ... 156
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Energy pulsing with LEDs

The two LEDs on the front panel are preconfigured for energy pulsing. The adjacent smaller infrared
outputs are connected to the LEDs and pulse at the same rate.

The pulse rate of the LEDs can be adjusted by modifying the Kt setup register in the associated
Calibration Pulser module. The value entered defines how much energy the module accumulates
before a pulse is sent to the hardware channel. The front panel WATT and VAR LEDs are factory
set to the same pulse rate. The Kt value is shown on your meter’s front panel label; the default
setting for Kt depends on the form factor of your meter.

(A
B

67

A Infrared pulsers
B LED pulse indicator
C Kt value for the meter

©@o @

WATT - LED and VAR - LED

The WATT - LED is controlled by a Calibration Pulser module that has its Source input linked to the
kW del+rec output of the Arithmetic module labeled ‘KW del, rec”.

The VAR —LED is controlled by a Calibration Pulser module that has its Source input linked to the
kVAR del+rec output of the Arithmetic module labeled ‘*kVAR del, rec”.

« Formeters with 9S, 36S and 29S form factors, the default pulse rate of the front panel WATT
LED is 1.8 (1.8 Watt-hours per pulse). The kt value of the VAR LED is also 1.8.

» For Form Factor 35S meters, the default pulse rate of the front panel WATT LED is set at 1.2
(1.2 Watt-hours per pulse). The Kt value for the VAR LED is also 1.2.

Customizing energy pulsing

Changing the value for the Kt setup register of the associated Calibration Pulser module lets you
modify the pulsing rate of either channel. If you want to configure the LED port for a different pulsing
application, you must re-link the Source input to the output register of a different instantaneous
power quantity in one of the Arithmetic modules. Ensure that the quantity you select originates from
the MU (meter units) Power Meter module.
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Configuring energy pulsing

Use Power Monitoring Expert or ION Setup to change your meter’'s energy pulsing settings.

A WARNING

HAZARD OF UNEXPECTED DIGITAL OUTPUT PULSE

» Do not use the meter for critical control or protection applications where human or equipment
safety relies on the operation of the control circuit.

» Be aware that an unexpected pulse on the digital outputs can result when the supply power to
the meter is interrupted or after a meter firmware or template upgrade.

Failure to follow these instructions can result in death, serious injury, or equipment
damage.

Using the front panel

You cannot configure energy pulsing using the front panel.

Using ION Setup

1.

2
3.
4

6.

Open the Setup Assistant for your meter. See the ION Setup Help for instructions.
Select LED Pulsing.
Click on the tab that corresponds to the LED that you want to configure.

Configure the settings as required. See "Calibration Pulser module settings" on page 157 for
more information on the settings other than Pulser Mode.

Pulser Mode determines whether the LED pulsing occurs always or only when the meteris in
TEST mode.

The appropriate Kt value depends on Scaled Rev Param (located on the Basic Setup tab).

—If Scaled Rev Param is OFF, the Kt value must be the primary value and the Calibration
Pulser module pulses based on primary kWh and kVARhD

— If Scaled Rev Param is ON, the Kt value must be the secondary value, and the Calibration
Pulser module pulses based on secondary kWh and kVARh.

Select the Energy Pulsing screen to configure the other default Calibration Pulser modules
for energy pulsing applications, if required. By default, these modules are not linked to an
output.

Click the End of Interval tab to configure the end of energy pulsing.

Using Designer

Open your meter in Designer and navigate to the Energy Pulsing Setup folder. Right- click a module
to edit.
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Calibration Pulser module settings

The setup registers available in the Calibration Pulser module are listed in the table below. The
defaults listed are for the two pre-configured Calibration Pulser modules that control the front panel
LEDs (these modules are labelled Wh Pulse LED and VAR Pulse LED).

Setup register Function Default

Specifies the width of the pulses sent to the hardware

Pulse Width channel (in seconds). The Calibration Pulser module
maintains a minimum duty cycle of 50% on the output 0.05
pulse train.

The numeric bounded register defines how much energy

Kt the module accumulates before a pulse is sent to the
hardware channel. An industry standard for energy pulsing
is 1.8, or one pulse per 1.8 energy-hours.

Int Mode Specifies the modes of integration that can be selected.  Absolute

Specifies whether the output is a complete pulse (Pulse)
OutputMode or a change of state transition (KYZ).

Specifies which hardware port the pulse/KYZ transition
Port appears on. Only those hardware channels that are still Not Used
available appear in this list.

varies'

Pulse

"The default Kt value varies depending on the template. For meters with the 9S/29S/36S template, the defaultis 1.8. For
meters with the 35S template, the defaultis 1.2.
Pulser module settings

Only the End of Interval Pulser module is available by default. The defaults below reflect the
defaults in this module.

Setup register Function Default

Specifies the width of the pulses sent to the hardware

Pulse Width channel (in seconds). 0.1
Specifies whether the output is a complete pulse (Pulse)

OutputMode or a change of state transition (KYZ). Pulse
Specifies which hardware port the pulse/KYZ transition

Port appears on. Not Used
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Logging
The ION8650 meter has powerful data logging and event recording capabilities. Data and event logs

recorded by the meter are prioritized and stored onboard. Data is retrieved periodically by Power
Monitoring Expert (or another third-party application).

If you use Power Monitoring Expert, all retrieved data from your system is stored in an ODBC-

compliant database. The information in the database can be viewed and analyzed using Power
Monitoring Expert components such as Vista (for viewing) or Web Reporter (for organizing and
presenting data).

In this chapter

Datalogging . ... ... 159
Configuring data logging . ... ..o 159
Viewing data log information ... ... .. 165

EVeNnt l0ggiNg ... o 165

Logging and recording CapacCity . ... ... ... i 167
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Data logging

The meter has a default, comprehensive data-logging configuration. Information regarding the
default logging capacity and default logging configuration can be found in "Default logging capacity”
on page 161.

To learn more about the Data Recorder modules in your meter, refer to the ION Reference.

Configuring data logging

Use Power Monitoring Expert or ION Setup to change your meter’s logging settings.

Using the front panel

You cannot configure logging using the front panel.

Using ION Setup
1. Open the Setup Assistant for your meter. See the ION Setup Help for instructions.
2. Select the Logging folder.

Use the Memory, Load Profile, and Event Log screens to configure your logging settings.

Memory screen
1. Click Logging > Memory to re-allocate meter memory.

2. Select the log you want to configure and click Edit. You can change both the Log Duration
(days) and the Log Size (records). Changing these parameters affects the meter memory
allocated to that log.

Load Profile screen

1. Click Logging > Load Profile to configure the Revenue Log.

2. Click the Channels tab to access the Revenue Log sources. Select a source.

— Click Unlink to unlink the parameter from the source.

— Click Edit to edit the parameter. The Parameter Selection dialog box displays the source
register groupings. To view the individual registers, expand the node beside the register
group . Select the register that you want to connect to the source, and then click OK.

Select the Show all available registers check box for a complete list of all possible
registers.

3. Click the Interval/Depth tab to edit the Revenue Log interval and duration and missing record
handling.
Events screen
1. Select the Event Log screen to configure what events are logged and the notification settings
2. Click the Events tab, select a parameter and click Edit:
— Depth: This parameter sets the number of events the event log contains.

— Cutoff: This parameter determines the minimum priority level for events to be logged; events
with a lower priority are not logged.
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— EvPriority: This parameter sets the event priority of Sag/Swell events. See "Configuring
power quality event logging" on page 182 for more information.

— PhaselLossEnable: This parameter enables or disables phase loss event recording.

Click the Notifications tab to configure the event log notification settings based on the
number of unread entries. These settings allow you to define the designated reader and set a
limit to the number of unread event log entries. Select a parameter and click Edit to change.

Designated Reader: This parameter allows you to select a user to be the designated
reader of the event log. An entry in the event log is designated unread until reviewed or
backed up to external storage by the designated reader. This feature can assist in
ensuring that event log entries are not overwritten before they can be reviewed.

SMTP Server: This parameter displays the IP address of the SMTP Server. The value can
only be displayed under this tab. Navigate to Communications > Advanced Ethernet >
SMTP to change this setting. See "Configuring Ethernet connections" on page 103 for
information on configuring network settings.

Depth: This parameter displays the number of events the event log can contain. The value
can only be displayed under this tab. Navigate to Logging > Event Log > Events to
change this setting.

Unread Events: This parameter displays the number of event log entries that have not
been reviewed or backed up to external storage by the designated reader. When the
designated reader reviews the event log, this value returns to zero. If any user other than
the designated reader reviews the event log, the unread events value does not change.
This value is not configurable.

Changing waveform recording

The Waveform Recorder modules do not require changes to their default settings. If you want to
change the format of the recorded waveforms, refer to the Waveform Recorder module description
in the /ION Reference.

NOTE: If you are generating COMTRADE waveform data records, the associated Waveform
Recorder modules cannot be modified unless the COMTRADE module’s Module Enable register
is set to DISABLED. If the Waveform Recorder modules are not configured identically (have the
same setup register values) the COMTRADE module will not go online.

The default logging framework

The following sections outline the default logging capacity and configuration.

NOTE: The default logging configuration may be used by other components of your power
monitoring system (for example, the reporting components of Power Monitoring Expert). Before
you change the default configuration of any of the logs, ensure you understand the impact on the
change on these components and the data they display.
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Default logging capacity

The following table summarizes the default recording depths and recording intervals of the various
Data recorders and Waveform recorders in the meter.

ION8650A ION8650B ION8650C
Interval
Default depth Default depth Default depth
Revenue log 900 seconds
Loss log 900 seconds
EgyDmd Log 900 seconds
DailyNom Log Daily
Hist Logs 9120 6240 900 seconds
Harm Logs 2280 1560 3600
Transient Log 3000 Triggered on demand
Sag/Swell Log 3000 3000 3000 Triggered on demand
SagSwellState Log 3000 3000 N/A Triggered on demand
COMTRADE" Triggered by

Waveform Recorder

Daily, weekly, 10
minutes...2

3 second, 10 minute,
2 hour

14 Data Recorders Varies? Varies? N/A

8 Data Recorders Varies® Varies® N/A

'See the COMTRADE and ION Technology technical note for more details.
2See the Power Quality: ION Meters and EN50160 technical note for more details.

3See the IEC 61000-4-30 Compliance and ION meterstechnical note for more details.

Changing the log depths

Change the value in a Data Recorder module’s Depth setup register to increase the number of
records stored in the recorder.

The RecordMode setup register controls how the Data Recorder overwrites old records; refer to the
Data Recorder module description in the /ON Reference before changing this setup register.
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Logging frequency
The five Periodic Timer modules that control the frequency of different data recording are as follows:
* “Revenue Log Trg” controls the frequency of the logging of revenue values
» “Loss Log Trg” controls the frequency of Loss Compensation Data logging

+ “EgyDmd Log Trg” controls the frequency of logging for the Energy and Demand Log (this log is
used for generating reports using Web Reporter)

+ “Hist Log Trg” controls the frequency of Historic Data logging
+ “Harm Log Trg” controls the frequency of Harmonics logging

Programming your meter to write to any data recorder at continuous intervals lower than 60 seconds
(heavy logging configuration) can cause loss of data in the event of a power failure.

NOTICE

DATA LOSS

Use an uninterruptible power supply (UPS) if you program your meter for heavy logging.

Failure to follow these instructions can result in data loss.

Change the value in the Period setup register to change the frequency of data logging (in seconds).
Do not change the Sync Mode setup register.

Default logging configuration

The following sections describe each Data Recorder module and the parameters they log. Your
meter may not have all the logs described and the settings may vary depending on the meter, its
firmware and its template.

Revenue logging

The Revenue Log is configured for use with UTS MV-90 billing software. The default values logged
by the Revenue Log are as follows:

Parameter Description
kWh del int Interval kWh delivered
kWh rec int Interval kWh received

kVARNh del int Interval kVAR delivered
kVARh rec int Interval kVARh received

Historic data logging

Three data recorders are used to record standard power system quantities, such as phase current,
phase voltage and power factor. By default, they log the following output register values:
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Hist Mean Log

e
KVAR fot Vilab high |1 avg high VIl ab low I avg low

VIl ca mean mean VII'bc high | kW tot high Viibclow |kW tot low

ViTavg Vil cahigh [kVAR tot high Vilcalow |kVAR tot low

i kVA tot mean ViTavg high |KVA tot high Vilavglow | KkVA ot low

V unbal V unbal high | PF lag high V unbal low |PF lag low

mean PF lag mean Ta high PFTead high Talow PFTead low

[amean PF lead mean Ib high Freq high Ib low Freq low

Ib mean Freq mean Ic high Ic low

Ic mean

Loss Log
One Loss Log recorder is configured to record loss values. By default, it logs the following
parameters — note that the parameters differ depending on the meter template:
Template Loss Log parameter Description
All MU la”2h int Phase A interval current squared hours
All MU IbA2h int Phase B interval current squared hours
All MU IcA2h int Phase C interval current squared hours
35S only MU VIl ab”2h int Phase A interval voltage Line-to-Line squared hours
35S only MU VII bcA2hint Phase B interval voltage Line-to-Line squared hours
35S only MU VIl ca*2h int Phase C interval voltage Line-to-Line squared hours
9S5/29S/36S only MU VIn a*2hint Phase A interval voltage Line-to-Neutral squared hours
95/29S/36S only MU VIn b*2hint Phase B interval voltage Line-to-Neutral squared hours
95/29S/36S only MU VIn c*2hint Phase C interval voltage Line-to-Neutral squared hours

Harmonics logging

Two recorders provide various harmonics logs, including K-factor and Total Harmonics Distortion
(THD). These recorders are labeled Harm Mean Log and Harm High Log. By default, they log the
following values:

Harm Mean log Harm High log
V1 THD mean 11 KFac mean V1 THD high I1 K Fac high
V2 THD mean 12 K Fac mean V2 THD high I2 K Fac high
V3 THD mean I3 KFac mean V3 THD high I3 KFac high
[1 THD mean [1 THD high
2 THD mean 2 THD high
I3 THD mean I3 THD high

Energy Demand Log

One data recorder is configured to provide power system data for the Web Reporter component of
Power Monitoring Expert.

EgyDmd Log
kWh del kVAh del+rec
kWh rec kW sd del-rec
kWh del-rec kVAR sd del-rec
kVARh del kVA sd del+rec
kVARh rec PF lag mean
kVARNh del-rec | PF lead mean
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Sag/Swell and Transient logging

Three data recorders provide details of these power quality events. The Sag/Swell and Transient
data recorders, by default, log the following values:

Sag/Swell log (ION8650A and ION8650B)
DistDur DistV1Engy DistV2Engy DistV3Engy
DistV1Min DistV2Min DistV3Min DistNominal
DistV1Max DistV2Max DistV3Max SwellLim
DistV1Avg DistV2Avg DistV3Avg SagLim
Sag/Swell log (ION8650C)

DistDur DistV2Max PT Prim
DistV1Min DistV3Min PT Sec
DistV1Max DistV3Max CT Prim
DistV2Min DistNominal CT Sec

Transient log
TranV1Dur TranV2Max TranNominal PT Sec
TranV1Max TranV3Dur Threshold CT Prim
TranV2Dur TranV3Max PT Prim CT Sec

The SagSwellState data recorder provides additional information required by the Sag/ Swell and

Transient logs.

See "Configuring power quality event logging" on page 182 for enabling or disabling Sag/Swell and
Transient events from being recorded in the Event Log.

NOTE: Modification of the Sag/Swell, Transient and SagSwellState logs is an advanced
procedure that should only be performed by experienced users familiar with ION and the

interaction of these data recorders.

See the COMTRADE and ION Technology technical note for information about COMTRADE

records.

EN50160 compliance logging (ION8650A and ION8650B only)

By default, 14 Data Recorder modules are used for logging EN50160 compliance parameters.

Data Recorder

EN50160 component logged

Data Recorder EN50160 component logged EN50160 Hrm .
EN50160 Power Frequency and Supply VIt Voltage Harmonics
Frg/Mg Magnitude EN50160 Thm
EN50160 Fricker Vit EN50160 Ihm VIt
Flicker EN50160 Mains Signaling Voltage
EN50160 VIt Supply Voltage Dips MSignal

y EN50160 Prm-
EN50160 VIt A%
Dp2 EN50160 VIt Dp2 ENS0T60 Prm:
EN50160 Intrp | Short/Long Interruptions Flk Parameter data
EN50160 Swell | Temporary Overvoltages EN50160
EN50160 PrmHrm1
Vunbal Voltage Unbalance EN50160

PrmHm2

The meter logs EN50160 counter data for present and previous observation periods as well as
EN50160 events. Enable or disable EN50160 Parameter Logging via the default Power Quality

diagram in the Vista component of Power Monitoring Expert.

7EN02-0306-05

Page 164 of 210



Logging ION8650 User Manual

For more information about EN50160 data logging, see the Power Quality: ION Meters and
EN50160 technical note.

IEC 61000-4-30 logging (ION8650A and ION8650B only)

Eight data recorders are used to log parameters related to 4-30 compliance and to create reports.

Data Recorder 4-30 parameters logged

—Voltage Disturbances
—V1-RMS (Root-Mean-Square)
4-30 3s THD Log —-V2-RMS
4-30 3s RMS Log —-V3-RMS
4-30 10mRMS Log — THD (Total Harmonic Distortion)
4-30 10mTHD Log —Vneg/Vpos
4-30 2hTHD Log —\Vzero/Vpos
4-30 2hRMS Log —V-Overdeviation
4-30 10s Freq —V-Underdeviation
4-30 Intrp Log (disabled by default) — Frequency
— Flicker (only available on A feature set)
—Unbalance

For more information on 4-30 compliance, see the IEC 61000-4-30 Compliance and ION meters
technical note.

Viewing data log information

In ION Setup

1. Select your meter.

2. Select View > Data Screens > Data Recorders. The following logs are available for viewing,
depending on your meter:

— Average Harmonics

— Energy & Demand

— Historic Average, Historic Highs, Historic Lows
— Maximum Harmonics

— Revenue Log

— Sags & Swells

— Transformer Losses

— Transients (ION8650A only)

See "Reports" on page 207 for information on running basic reports in ION Setup.

In Power Monitoring Expert

You can view information from the data logs in the Vista, WebReach and Web Reporter
components of Power Monitoring Expert. See Power Monitoring Expert help for more information.

Event logging

Events produced by the meter's various ION modules are prioritized and grouped to facilitate
custom logging. Each event is assigned a priority group number based on its type and severity.
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Event priority groups

Some event groups are preset with a priority number as shown in the table below. You can also
define your own priority number for some modules. Priority numbers from 128- 191 appear in the
global event log viewer in the Vista component of Power Monitoring Expert. Priority numbers from
192-255 are also logged, initiate a beep and cause the window to flash. You can customize these
responses to display messages or perform netsend messages, for example.

Event group Description Priority number

Reset Module reset or re-synchronized 5
Module setup changes (setup register changes, label changes, input

Setup Change handle changes) ges | PTes ? J g 10

Input Register Inputs of certain modules change value (for example, input to And/Or 15

Change module changes)

I/0 State Change I/0 state changes (for example, relay closes) 20

Information Module produces important user information 25

Warning Module produces a warning 30

EN50160 Event

(ION8650A An EN50160 counter (N4or N5) increases 50

and ION8650B only)

Loss of Potential Loss of Potential has occurred 128

Error Detected An error has been detected 255

Setpoint Setpoint condition goes Active or Inactive (for example, Sag/Swell programmable via
module detects a disturbance) module setup

The Event Log Controller module allows you to set a priority cutoff for event logging. Any events
with a priority number greater than the cutoff value are logged, and events with lower priorities are
discarded. Refer to the individual module descriptions and the Event Log Controller module
description in the ION Reference for more details.

Events external to the module

Some events are not produced by a specific module. These events are generated internally by the
meter. Their associated priority levels are shown in the table below.

Event group Description Priority number

Factory initialize performed

Firmware or memory upgrade performed
Meter power-up or power-down

Warning Internal modem not responding or modem recovered 30
Battery low

Serial terminal locked out
Security disabled or enabled

Failure Communications not able to allocate required memory 255

User triggered events

When a user produces an event, such as a reset, successful or unsuccessful login attempts, user
lockout or setup change, the event log displays the username associated with the event. Events
created in basic security through the front panel have the username USERO. Events created in
advanced security through the front panel or ION Setup are associated with the username that was
logged into the meter (USER1 - USER50).
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Drataf Time Causa ‘alse Efiect ‘alue Lkzar .
4282015 1000221205 AW Ethemet Changed Setup SECZ Comms Config Access Mo LISERD
|-L'?El."2".ll5 1R12:21.719.4M  Ethemet Changad Satup Securty Usar 1 Password Chengad LISE FI'Jl
41282018 1012221, 752 AW Ethismis Changad Setup Secunty Ulgar 2 Pateword Changed 1 JSERD
AR5 10221 820 AWM  Ethemet Changed Setug S0P Enable Advanced Security  Enabled LISERD
1R 2015 1000 354891 AR Frord Panel  YWiote Conlrol Action Mo MAl D 5p JFF
[4/28/2015 101 406,355 4 Frormt Panel _ Changed Setup 341 Pratacol EtherGate USER|
4282015 TH420. /34 A FromiFanel  Changed Setug 31 Pratacol DO LISERT
AR5 101425148 AW FromiPanel VWiabe Confrol Action  Maem /Al Desp OM -
Close Seve A Pt Help
Displaying events
View events in the following locations:
Application Menu / screen Navigation
Front Panel Event Log ALT display mode
ION Setup Event Log Setup Assistant > Reports > Event Log
Vista Meter Events Volts/Amps tab > Meter events object
Logging and recording capacity

The meter provides both data and event logs. The amount of memory required to store these logs
depends on the number of parameters being logged and the frequency with which these parameters

are logged.

The following equation can help determine the amount of memory required to store data and event

logs:

each record consumes (in Bytes) = [(number of parameters * 5) + 8]

The meter can also perform waveform recording. To calculate the waveform memory usage, use
the following formula:

in waveform) + 30

waveform memory usage (in Bytes) = [2*(number of samples per cycle) + 10]* (number of cycles

NOTE: Round up to the nearest kilobyte after each of the above calculations.

In ION Setup, the Memory tab in the Logging folder of the Setup Assistant displays the memory
allocated to each log and the meter’s total in-use and available logging memory.
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Revenue

A revenue meter provides, over a defined range of operating conditions, measurements that are
within international and national defined standards and industry-accepted accuracy limits.

It also provides protection against unauthorized alteration of these measured quantities. National
and utility-based standards regulate protection against unauthorized alteration of measured
quantities.

In this chapter

Revenue metering CompPONeNtS . L 169
Hardware-lock security OptioNn ... . 169
Anti-tamper sealing methods . ... .. 170
Scaled operational ValUES . ....... ... 171
Configuring scaled operational Values . . ... ... . L 173
P CT COmmeCtiON . 174
Configuring PT/CT COMmeCtioN ... e 174
Transformer Line Loss Compensation .. ... . e 174
ConfigUING TLC L 175
TImMe Of USe 176
Configuring Time of Use ... . 176
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Revenue metering components

To meet government regulations and utility security requirements, the meter incorporates three
types of security systems:

+ Traditional anti-tamper mechanical seals on the meter (See your device installation guide).
+ Password entry to reset meter values, for example, Master reset.

» Hardware locking mechanism that prevents modification of revenue quantities after the meter
is sealed.

Hardware-lock security option

The hardware-locked security feature is an ordering option for some meters that locks the ION
module parameters specific to revenue data so that these parameters cannot be altered. This
hardware lock is set at the factory. To make configuration changes to billing parameters on a
hardware-locked meter, you must first place the meter into TEST mode. The TEST mode button is
located under the anti-tamper sealed outer cover, and the cover must be removed to access the
TEST mode button. You cannot switch a hardware-locked meter to test mode from software.

DEMAND
RESET

A Press this button to enter TEST mode

The hardware-lock option, when combined with advanced security and physical anti-tamper sealing,
offers the highest level of security. Hardware-locked meters operate as follows:

+ With the meter in Normal mode, and with standard or advanced security applied, ION modules
that generate revenue data are locked and cannot be altered. Users can modify unlocked ION
modules depending on their level of password-protected access through software or the front
panel.

» With the meterin TEST mode (which requires removing the cover and breaking any anti-tamper
seals), users can modify ION modules depending on their level of password-protected access
through Power Monitoring Expert, ION Setup or the front panel.

Typical values that are hardware locked include:
+ kWh, kVARh, kVAh delivered, received, del-rec, del+rec.
* kW, kVAR, kVA Sliding Window demand min and max values.
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+ Digital Outputs controlling the energy pulsing applications.

« All Power system settings, including PT and CT ratios.

Locked module listings

For a complete list of locked modules specific to your meter and its firmware, see the /ION Device
Template Reference.

Anti-tamper sealing methods

The following sections describe the anti-tamper sealing methods used by the ION8650 revenue
meter option.

Demand reset switch seal

The demand reset switch located on the front panel can be sealed by a wire seal or lock inserted
through the side of the switch. This seal does not have to be broken to remove the meter's cover.

Socket seals

A standard ANSI C12.7 type socket-sealing ring can be used to hold the socket meter to the socket.
When removing the outer cover, the sealing ring must first be removed. Some socket sealing rings
facilitate wire seals.

Outer cover/case seals

For socket models, the outer cover of the meter is factory sealed to its backplate with a T-type seal.
Depending on the installation, this seal may be inaccessible after the meter is installed until you
remove the device from the socket.

For switchboard models, the outer case can be sealed by a wire seal or lock inserted through the
sealing point.

In certain countries the meter is no longer revenue certified if the anti-tamper seals are broken.

NOTICE

LOSS OF COMPLIANCE

Re-certify your meter with the appropriate revenue metering authorities if you remove the anti-
tamper seals.

Failure to follow these instructions may render your device non-compliant for billing
purposes.
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A Socket

B Socket sealing ring

C Outercover

D Outer cover T-type seal

E Demand reset switch seal
F Outer case sealing point

Scaled operational values

The scaled operational values (SOV) feature is intended for hardware-locked meters where the
Power Meter module’s PT and CT ratios are 1:1.

The SOV feature allows you to enter alterate PT and CT values through the Vista component of
Power Monitoring Expert, in order to obtain scaled non-revenue data for analysis. The alternate
scaling registers are stored in the Factory module and have a default value of 1.

The Power Meter module’s PT and CT primary and secondary values are compared against the
Factory module’s alternate values by a series of Arithmetic modules. The Arithmetic modules
determine if the SOV feature is enabled (the Power Meter module’s scaling ratios are all 1:1).

+ If the SOV feature is disabled, the Arithmetic modules output the Power Meter module’s PT,
CT, and kVA ratios.

+ If the SOV feature is enabled, the Arithmetic modules output the alternate PT, CT, and kVA
ratios. These ratios are applied to the outputs of the MU (Metering Units) Power Meter module
to generate scaled operational values. The scaled operational values can be viewed and
analyzed using the Vista and Web Reporter components of Power Monitoring Expert.

NOTE: Scaled operational data can only be accessed through Power Monitoring Expert.

The following diagram shows how scaled operational values are generated.
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Factory Module
A At PT Primary = 240
Alt PT Secondary = 120

Power Meter Module
B AltPT Primary = 120
Alt PT Secondary = 120

Two Arithmetic modules are used:

C SetRatios1 through SetRatios2
Arithmetic Module

D Source
PT Ratio 2:1

E MU Power Meter Module
Vina=30V

F Four Arithmetic modules are used:
ScaledOpVals1 through ScaledOpVals4
Arithmetic Module

G Source
Vina=60V

H Power Monitoring Expert server

1. Alternate PT and CT primary and secondary values are loaded into the first series of
Arithmetic modules.

Example: Alternate PT Primary = 240, Alternate PT Secondary = 120

2. Power Meter PT and CT primary and secondary values are loaded into the first series of
Arithmetic modules.

Example: PT Primary = 120, PT Secondary = 120

NOTE: All the Power Meter module’s ratios must equal 1:1 to enable the SOV feature.

3. Because the Power Meter module’s ratios are 1:1, the alternate scaling registers are used to
generate the PT, CT, and kVA ratios, which are loaded into the second series of Arithmetic
modules.

Example: PT ratio = 2:1
4. MU Power Meter module per phase voltage, current and energy values, and total/average

voltage, current and energy values are loaded into the second series of Arithmetic modules.

Example: VLN a=30V
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5. The second series of Arithmetic modules apply the PT, CT, and kVA ratios to the MU Power
Meter values to output operational scaled values to your Power Monitoring Expert database.

Example: VLN a=60V

The following 1-second data values are scaled by the SOV feature:

Vina Vinb Vinc Vinavg VIl ab

VIl bc Vil ca Vil avg la Ib

Ic lavg kW a kW b kW c

kW total kVAR a kVAR b kVAR ¢ kVAR total
kVA a kVA Db kVAc kVA total

The following are derived from scaled operational data values:
e Maximum/minimum,
+ Historic high/low/mean, and
» Waveforms.

NOTE: The Sag/Swell and Transient modules are not affected by the SOV feature. The nominal
voltage register in the Sag/Swell module must be set to the unscaled voltage value.

The Harmonics Measurement module outputs are only scaled by the SOV feature when the Display
Mode register is set to Engineering units. No other harmonics modules are affected.

Because total harmonic distortion (THD), total even harmonic distortion (TEHD) and total odd

harmonic distortion (TOHD) are expressed as percentages, these values are not affected by the
SOV feature.

Configuring scaled operational values

You can configure the alternate PT and CT values in the Vista component of Power Monitoring
Expert.

1. Open your meter in Vista.

2. Select the Power Quality tab and click the Setup icon to open the Power Quality Setup
screen.

The Power Quality Setup screen contains fields where you can enter the alternate scaling
register values, along with an indicator showing whether the SOV feature is enabled or
disabled.

NOTE: The alternate scaling registers are set to 1 by default.

3. Enterthe alternate PT and CT values to provide the desired scaling.

When the SOV feature is enabled and the alternate PT and CT values are configured (no longer

equal to 1), the Vista screens indicate if the data values displayed are scaled operational values or
not.
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PT/CT correction

The primary application for PT/CT correction is to apply correction factors for ratio errors and phase
angle errors to instrument transformers. Instrument transformer correction reduces or eliminates the
need to replace transformers in installations where high accuracy is required.

PT/CT correction is done using the Instrument Transformer Correction (/nstr Xformer) module.
There is an ITC module for each current input (11, 12, 13) and for each voltage input (V1, V2, V3) to
the meter. Note that the correction affects only the 1-second values in the Power Meter module. No
high-speed, harmonics, or waveform values are affected by the correction. For more information,
see the ITC (Instr Xformer) module description in the ION Reference.

Configuring PT/CT correction

1. Open the Setup Assistant for your meter. See the ION Setup Help for instructions.
2. Select Revenue > PT/CT Correction.

3. Select Active Correction on the ITC Correction tab then click Edit. The Transformer
Correction Setup wizard appears.

4. Select the checkbox beside the Voltage Inputs or Current Inputs and click Next. The first
correction screen appears.

5. Select atest point and click Edit to edit the test points. Click OK to return to the correction
wizard then click Next to move to the next correction screen. Go through all the correction
screens then click Finish.

NOTE: You can select a maximum of eight (8) test points.

6. Select Active Correction on the ITC Correction tab and click Analyze to access screens
where you can input your wiring configuration and power system information.

Transformer Line Loss Compensation

Transformer Loss Compensation (TLC) is used when a meter’s actual location is different from the
electrical location where change of ownership occurs; for example, where meters are connected on
the low-voltage side of power transformers when the ownership change occurs on the high-side of
the transformer. This physical separation between meter and actual billing point results in
measurable losses. Compensating for this loss - Loss Compensation - is the means of correcting
this meter reading. Losses may be added to or subtracted from the meter registration.

Meters are usually installed on the low-voltage side of a transformer because it is more cost-
effective. There are also cases where change of ownership can occur halfway along a transmission
line where it is impractical to install a meter. In this case, power metering must again be
compensated.

NOTE: Due to the variation in installations, advanced knowledge of power systems and
connection methods is required before transformer loss compensation can be properly
implemented. Data parameters should only be programmed by qualified personnel that have
appropriate training and experience with Transformer Loss Compensation calculations.

For more information, see the Transformer Line Loss Calculations technical note.
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Configuring TLC

Use Power Monitoring Expert or ION Setup to change your meter's TLC settings.

Using the front panel

You cannot configure Transformer Line Loss Compensation using the front panel.

Using ION Setup

The Transformer Loss screen allows you to enable or disable TLC, choose which method you prefer
(1 or 2) and configure TLC settings.

In ION Setup:

1. Open the Setup Assistant for your meter. See the ION Setup Help for instructions.

2. Select Revenue > Transformer Loss. Click the Method Selection tab.

3. Select Loss Comp Enble to enable TLC, then click Edit.

4. Select Comp Enabled from the dropdown list and click OK.

5. Select Comp Mthod Slct and click Edit to choose the TLC method you want to use. Select
Method 1 to use the Test Sheet method and Method 2 to use the %Loss Constants method.
Click OK.

6. Click the tab of the TLC method you chose in the previous step and configure the settings for
that method.

Using Vista

1. Open your meterin Vista.

2. Click the Revenue tab.

3. Click the Loss Compensation object. The Loss Compensation window appears:
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. . W, Back to
Wictoria . SWBEE50A Revenue
Loss Compensation

Loss Compensation Mode Loss Compensation Method

If Loss Compensation is enabled, " Disabled ' Method 1 ("Test Sheet Method")
all billing parameters are compensated, —p
I _ @ Method 2 ("%Loss Constants Method")
Method 1 ("Test Sheet Method") Method 2 ("%l oss Constants Method")
Supply Side Line Load Side Line {w
Instrument Transformer Ratios {prim/sec)
Indicate if meter location is supply side 1ﬂ Supply Load
or load side i PT ratio
e . . o ratio
Indicate if meter location is transformer side I
ar not
Mot Transformer Side (& W TremsErmer Side Meter Information
R I'm Wal
Instrument Transformer information B | 120
) ) 172 Cl.|ss Meter Amps
PT ratlo Primary VI ratedlIl
o ratio > leer Blements
Transformer Losses
kA rated Power TranxGrmer Ratio Copper Loss Iron Loss
LWFe (no-load) o5 EnNcation Compensation Compensation
Lweu full-load) | 2 | % Impedane™ 2 & Enabled & Enabled
B B " Disabled " Disabled
Supply Side Line Loss Load Side Line Loss
Line Length Line Length 12 LW Cu LWFe
Resistance/Unit Length Resistance/Unit Length BLEn %L\.-'Fe
Reactance/Unit Length Reactance/Unit Length
Click radio buttons to change state
Click boses, enter value, then press Enter to change paramedN\s
Device Time 4/5/2011 01:59:40.203 PM O
Device Type IOM36504
A Click here to enable Loss Compensation calculations.

Choose either the Test Sheet or %lLoss Constants
compensation method.

These are the true instrument transformer ratios. Normally
they coincide with the Power Meter module's setup.

(v9)

O

4. Configure your values as required.
See the Transformer Line Loss Calculations technical note for more details on this feature.
Time of Use

The Time of Use module may only be important if you are using the meter in a billing application (for
example, you are a power provider), as the module contains the meter's seasonal rate schedules.
Typically, power consumers do not require Time Of Use configuration.

See the ION Reference for more information on the Time of Use module.
Configuring Time of Use

Use Power Monitoring Expert or ION Setup to change your meter's Time of Use settings.

Using the front panel

You cannot configure Time of Use using the front panel.
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Using ION Setup
1. Open the Setup Assistant for your meter. See the ION Setup Help for instructions
2. Select Revenue > Time of Use.
3. Select a Time of Use program from the list (for example, Sample TOU) and click Edit.
4

Follow the Time of Use Wizard to configure your program. Click Send to save the TOU
program on your meter.

Time Of Use settings

The Time of Use module’s setup registers define your seasons’ start and end dates, the day types
where your rates differ, and the rate schedules for each season’s day types. The module compares
the meter’s internal clock with the season, day, and time of day settings in these registers and
changes its output registers to reflect the current state of these settings.

Seasonal settings

The Time of Use module supports up to four separate seasons. Each seasons’ start and end dates
are set into the appropriate Season setup register.

NOTE: Ensure that there is no date overlapping when defining seasons and that every day of the
year is covered by your seasons. If there are gaps between seasons, the module returns an
exception message and will not function.

If your rates do not change between seasons, you do not need to configure the Season setup
registers — by default, all Season 1 rates are in effect all year.

If you have different seasons, enter their start and end dates into the appropriate setup registers. If
your season is active on the same dates every year, you only need to enter a single range of dates
in the appropriate Season setup register. If the active dates are different each year (for example,
Season 3 becomes active every first Monday in August), the start dates must be individually
specified for each year.

NOTE: Changes to the TOU seasons are noted in the meter’s event log.

Time of Use module settings

The Time of Use module is partially configured at the factory. Check the setup registers to ensure
that the settings match your Time of Use schedules.

Setup register Function

These setup registers define the dates for each active season.
Season 1-4 When a season is active, the Time of Use module uses the
applicable rate schedules.

Season 1-4 Weekday These setup registers specify seasonal weekday rates.

Rates

gea?esg n1-4Weekend These setup registers specify seasonal weekend rates.

Season 1-4 These setup registers specify a season's daily rates during the days
Alt 1 Rates specified in the Alt 1 Days setup register.
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Setup register Function

Season 1-4 These setup registers specify a season's daily rates during the days
Alt 2 Rates specified in the Alt 2 Days setup register.

These setup registers specify a season's daily rates during the days
specified in the Holidays setup register.

This register defines the days of the week for all seasons. The rates
Weekdays inthe Season (1, 2, 3, or 4) Weekday Rates setup registers are
used on these days.

This register defines the weekend days for all seasons. The rates in
Weekends the Season (1, 2, 3, or 4) Weekend Rates setup registers are used
on these days.

This register defines a set of alternative dates for all seasons.
Alt 1 Days These dates generally have different rates from weekdays,
weekends, or holidays.

This register is similar in function to Alt 1 Days but contains a
Alt 2 Days different set of dates.

This register defines the holidays for all seasons. The rates defined

Season 1 -4 Holiday Rates

Holidays in the Season (1, 2, 3, or 4) Holiday Rates setup registers are used
on these days.
This setup register defines the dates and times that the Self Read
Self Read Days output register pulses. If no time is entered in this register, the Self

Read output register pulses on the date specified at 12:00 AM.

Displaying Time of Use

View Time of Use values in the following locations:

Application Navigation

Active TOU Rate and Active TOU .
Front panel ALT Display mode
Season screens

Vista Time of Use Screen Revenue tab > Time of use object
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Power quality

This chapter explains how to configure your meter’s power quality functionality.

NOTE: To help ensure meter accuracy:

Your meter must have adequate power; for power quality applications with inadequate line power,
an auxiliary power supply for the meter is recommended.

Your meter must have a properly connected protective earth ground since insufficient earth
grounding of the meter can adversely affect meter accuracy.

In this chapter

Power quality configuration . .. ... . 180
Configuring power quality Settings .. ... . L 180
Configuring power quality event 109ging . ... ... . .. 182
Power quality standards compliance ... ... 182
Disturbance Direction Detection ... ... . . .. 183
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Power quality configuration

Power quality configuration is provided by several modules and frameworks, depending on your
meter type, such as the Sag/Swell module, the Transient module, the Mains Signalling Evaluation
module, and the IEC 61000-4-30 framework, among others.

See the ION Reference for more information on these modules.

For a description of the scaled operational values (SOV) feature and the alternate scaling registers
on the Power Quality page in the Vista component of Power Monitoring Expert, see "Scaled

operational values" on page 171.

Configuring power quality settings

Use Power Monitoring Expert or ION Setup to change your meter's power quality settings.

NOTE: The Sag/Swell module’s Nom Volts setting is used by the Transient module, as well as in
other power quality features such as EN50160 and 4-30 calculations. You must set this register to
enable these power quality features. If the Sag/Swell module’s Nom Volts setup register is set to
zero, these functions are disabled. Nom Volts is typically set when the meter is put into service. If
Nom Volts has not been set, enter a value for your system’s nominal voltage (i.e., 120, 277, or

347).

Using the front panel

You cannot configure power quality from the front panel.

Using ION Setup

NOTE: COMTRADE must be DISABLED in order to configure Sag/Swell or Transients.

1. Open the Setup Assistant for your meter. See the ION Setup Help for instructions.
2. Select the Power Quality > Sag/Swell.
3. Select a setting and then click Edit. Configure the settings as required.

NOTE: The Sag/Swell module’s Nom Volts setting is used by the Transient module, as well
as in other power quality features such as EN50160 and 4-30 calculations. All power quality

functions are disabled if the nominal voltage is set to 0 (zero).

4. Click the Transient tab to set the voltage deviation threshold, set the transient waveform
recorder depth and frequency, enable COMTRADE waveform records and set other transient

settings.

NOTE: The ION8650A features dual waveform capture: Sags are recorded at 32 samples x
54 cycles. Transients waveform capture at 512 samples x 4 cycles.

5. Re-enable COMTRADE, if necessary.

Using Designer

Open your meter in Designer and navigate to the Power Quality folder. Right-click a module to edit.
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Sag/Swell module settings

The Sag/Swell module monitors voltage waveforms for sags and swells (i.e., ITI [CBEMA] Type 2
and Type 3 disturbances). It then reports each disturbance’s magnitude and duration. The
Sag/Swell module can also detect sub-disturbances during a Sag/Swell event. Settings are as

follows:
Setup Function Default
register
swell Lim 'Sl'vr:/ig"is the magnitude above which a voltage deviation is considered a 110
SagLim ;'Qés is the magnitude below which a voltage deviation is considered a 90

.. | This is the amount a voltage signal must change during a disturbance to
Change Crit be considered a new sub-disturbance. 10

Nom Volts® This is the nominal power system voltage (used for all power quality 0
functions). Set Nom Volts to 0 (zero) to disable power quality monitoring.

This is the difference in magnitude between the start and end limits for a

Hvsteresis Sag/Swell. For example, if the sag limit is set to 90% and the hysteresis 2
y is set to 2%, the voltage needs to reach 92% before the sag is considered
over.
EvPriority -rlm-ircj;?] ggltc;nty assigned to Sag/Swell module events (0 to 255, 255 is 0

"The primary power system voltage is sometimes different than the PT Primary setup register value (forexample, when the

PT Primary is used to indicate winding ratio ratherthan primary voltage).

You also need to set the EvPriority register value if you want Sag/Swell events to be recorded in the
Event Log. To enable Sag/Swell events, the EvPriority value must be greater than the Event Log
Controller module’s Cutoff value (the recommended Sag/ Swell EvPriority value is 200). To disable
Sag/Swell events so they are not recorded in the Event Log, set EvPriority to 0 (zero).

You can change Swell Lim and Sag Lim, but most applications are served by the default values
entered into these registers. The Change Crit setup register does not need to be changed for normal
operation.

Transient module settings (ION8650A only)

The Transient module monitors voltage waveforms for transient activity (i.e.

ITI [CBEMA] Type 1 disturbances). The Threshold setup register defines what voltage disturbance
magnitude is considered as transient activity. Threshold is interpreted as a percentage of the
nominal system voltage, plus 100. For example, if you want transients recorded when voltage
deviates from nominal by 20%, enter 120 into the Threshold setup register.

rﬁZ::tper Function Default
This is the magnitude at which a voltage deviation is considered a
Threshold transient. 125
L The priority assigned Transient module events (0 to 255, 255 is
EvPriority’ highest). 0

"By default, Transient events are not recorded in the Event Log.

You also need to set the EvPriority register value if you want Transient events to be recorded in the
Event Log. To enable Transient events, the EvPriority value must be greater than the Event Log
Controller module’s Cutoff value (the recommended Transient EvPriority value is 200). To disable
Transient events so they are not recorded in the Event Log, set EvPriority to 0 (zero).
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Configuring power quality event logging

Use Power Monitoring Expert or ION Setup to change your meter's power quality event log settings.

NOTE: By default, Power Quality events are not included in the Event Log.

Using the front panel

You cannot configure Power Quality event logging from the front panel.

Using ION Setup
1. Open the Setup Assistant for your meter. See the ION Setup Help for instructions.
2. Select Logging > Event Log.

3. Onthe Event tab, select SS1 EvPriority (Sag/Swell Event Priority) or TR1 EvProiority
(Transient Event Priority), and then click Edit.

— To stop Sag/Swell or Transient events from being recorded in the Event Log, set event
priority to zero (0).

—Toinclude Sag/Swell or Transient events in the Event Log, the event priority must be greater
than the Event Log Cutoff (EL71 Cutoff) value. The recommended EvPriority value for enabling
event logging is 200.

Using Designer
Open your meter in Designer and navigate to the Power Quality Setup Framework. Right-click the

Sag/Swell or Transient module to edit.

Power quality standards compliance

The ION8650 has additional frameworks and settings related to the power quality standards below.

EN50160 settings (ION8650A and ION8650B)

The EN50160 framework is composed of numerous ION modules including: Mains Signaling
Evaluation, Harmonics Evaluation, Voltage Harmonics, Flicker, and more.

NOTE: To avoid missing data in your EN50160 reports, use a meter with an auxiliary power option
connected to a UPS (Uninterruptible Power Supply) so that the EN50160 framework continues to
operate during power outage situations.

See "EN50160 compliance logging (ION8650A and ION8650B only)" on page 164 for information on
EN50160 parameter logging.
See the Power Quality: ION Meters and EN50160 technical note for details.

4-30 settings (ION8650A and ION8650B only)

IEC 61000-4-30 power quality standard compliance is provided by a variety of ION modules
including: Power Quality Aggregator, Harmonics Measurement, Disturbance Analyzer,
Symmetrical Components, Mains Signaling Evaluation, Sag/Swell and more.

See the IEC 61000-4-30 Compliance and ION Meters technical note for details.
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COMTRADE settings (ION8650A only)

The meter can provide waveforms in COMmon format for TRAnsient Data Exchange
(COMTRADE) format. COMTRADE records are created from the existing Waveform Recorder
modules, which are connected to the COMTRADE module.

See the COMTRADE and ION Technology technical note for details.

Disturbance Direction Detection

Your meter has disturbance direction detection capabilities to help you determine the location of a
power system disturbance. When a disturbance occurs, the meter analyzes the disturbance
information to determine the direction of the disturbance relative to the meter. This analysis includes
a confidence level indicating the level of certainty that the disturbance is in the determined direction
and is stored in your meter’s event log.

Disturbance direction detection can help locate the source of a disturbance when used in a system
of disturbance direction detection devices, as shown in the following diagram.

Disturbance location

Meter #1 reports downstream disturbance
Meter #2 reports upstream disturbance
Meters report upstream disturbance
Meter reports downstream disturbance

moOoOw>»

The arrows show the direction the meters have determined for the disturbance. With this
information, you can focus on the section between meter #1 and meter #2 to find the cause of the
disturbance.

NOTE: The disturbance direction detection feature is only available on the ION8650A and
ION8650B meter models.
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Viewing disturbance direction detection events

The results of the disturbance direction detection algorithm appear in the meter’'s event log. The
image below shows an example of how the Disturbance Direction Detection event appears in your
meter's event log when viewed using ION Setup.

NOTE: You can view your meter's event log through the display, ION Setup or using the meter’s
webpages.

Related topics:

« See the ION Reference for more detailed information about the Disturbance Direction Detection
module.

+ See "Event logging" on page 165 for more information about your meter’s event log.
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Displays

The meter ships with preconfigured front panel display screens designed to suit the data needs of
most users. Different types of screens are available depending on the meter’'s current mode of
operation (see "Modes of operation" on page 30 for details).

Front panel displays can also be customized on your meter to show virtually any measurement or
calculation. For example, you can:

+ Change displayed parameters, such as from VIl to Vin or Vilab to Vina
» Adjust character size to be different on each screen

+ Change data display settings such as backlight timeout, automatic display scrolling, parameter
update rate, display mode and display units.
This chapter explains the available front panel displays. It also includes procedures for customizing

displays using Power Monitoring Expert or ION Setup.
In this chapter

Configuring front panel displays . .. ... L 186
Adding orediting adisplay SCreen ... . 186
Default front panel display SCreens .. ... 189
Viewing ALT display modes .. ... .. 190
Setting the display brightness ...l 193
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Configuring front panel displays

Using the front panel

You cannot configure displays from the front panel.

Using ION Setup

The following sections explain how to add or edit a display screen, and how to set up scaling for a
display.

Adding or editing a display screen

1. Open the Setup Assistant for your meter. See the ION Setup Help for instructions.
2. Select the Displays screen.
3. Select Displays on the Front Panel tab and click Edit.

ION Setup uploads your meter’s display information to the Display Editor. This can take a few
moments.

4. Edit, rename, delete or rearrange displays as needed.

5. Click New to add a new display or click Edit to change an existing display. The Display
Setup wizard appears. There are three basic steps for creating or editing display screens.

a. Select a Screen Type: Choose the screen type you want from the dropdown list.

b. Select Parameters: Link or unlink the parameters available for your chosen screen type.
Assign your preferred display units (if required); see "Considerations when assigning
display units" on page 186 for considerations and examples of display unit scaling.

c. Select Digit Display Properties: Select your display qualities, including digit resolution
and truncated or rounded last digits.

6. Click Send to save the changes in the meter.

Considerations when assigning display units

NOTE: If you want to scale all front panel values by the same scaling factor, you do not need to
assign display units to individual parameters. Instead configure the display scaling settings under
the DISPLAY SETUP menu on the front panel; see "DISPLAY SETUP menu" on page 41. You
can also configure the display scaling settings by accessing the Display Options module; see the
ION Reference for more information.

For most values, the meter determines and displays the correct units for the source measurement,
and automatically scales displayed values for readability. If these units meet your needs, you do not
need to configure display unit scaling. Assigning display units allows you to: 1) override the default
units and force a certain scaling or 2) to display units when the meter cannot determine the correct
units (for example, when the source is an output from an Arithmetic module).

For the purposes of the display units, the source parameter is assumed to be in the base units of the
Power Meter module (in other words, V, A, kW, etc.). If the source parameter is not in the base units
of the Power Meter module, the parameter may be scaled incorrectly or display incorrect units.
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NOTE: You can only assign display units to One, Two, Three, and Four Parameter screens and
One, Two, and Three Parameter with Timestamp screens.

The available units are:

— Default -V, kV, MV - A, kA, MA - kw, MW, GW
-kVAR, MVAR, GVAR - kVA, MVA,GVA — Vh, kVh, MVh — Ah, kAh, MAh
— kWh, MWh, GWh —kVARh, MVARh, GVARh — kVAh, MVAh, GVAh —LD/LG’

— IND/CAP? - Hz - % — Blank

'"Power factor related units will not scale orchange based on the input value. They are always assumed to be coming froma

lagging source ora leading source.

The following example illustrates display unit scaling on a three parameter screen, including the
case when the parameter is not in the base units from the Power Meter module. In the example, the
kW tot value from the Power Meter module is 10000.

« Parameter 1 = kW tot directly from the Power Meter module

» Parameter 2 = kW tot from an Arithmetic module that has divided the Power Meter module
value by 1000, converting it to MW.

e Parameter 3 = kW tot from an Arithmetic module that does not scale the value from the Power
Meter module.

Configuration Displayed value Notes
Parameter 1 = 10000

Default kW Parameter 2 and 3 do not display units because they
Parameter 2 =10 come from Arithmetic modules

Parameter 3 = 10000

E\?vrameter 1=10000 Parameter 2 and 3 do not change since they are

- assumed to be in the base units of the Power Meter
kW Parameter 2 " 10kwW module. However, parameter 2 is shown as 10 kW
Parameter 3 = 10000 | \yhen it has already been scaled to 10 MW.

kw
Parameter 1 = 10 MW
MW Parameter 2 = 0.01 All three parameters are scaled. However, parameter 2

has been scaled twice.

Parameter 3=10 MW

Using Designer

NOTE: Before you reconfigure or delete a framework, it is recommended that you make a copy.
This ensures that you can restore the framework, if necessary, without having to reinitialize the
factory configuration.

Removing a data display screen

1. Open your meter in Designer.
2. Select the Display module responsible for the screen.
3. Press DELETE. This also deletes all links to that particular Display module.

If the display screen you are deleting is part of the automatic scrolling cycle, you must
reconfigure the links from the Scroll module’s Trigger outputs to the remaining Display
modules so that the following considerations hold true:

7EN02-0306-05 Page 187 0of 210



Displays

ION8650 User Manual

» Thefirst Display module in the scrolling cycle is linked to the Trigger 1 output of the Scroll
module.

» Thelast Display module in the scrolling cycle (module n) is linked to the Trigger n output of the
Scroll module. For example, if your scrolling cycle consists of 5 screens, Trigger 5 should be
linked to the fifth module in the cycle.

» The Wraparound setup register of the Scroll module designates the last trigger output (Trigger
n). Expanding on the previous example, since Trigger 5 is the last trigger, the Scroll module’s
Wraparound setup register would have a value of 5.

Adding a new display screen

1. Create a Display module.
2. Define the modules characteristics (display format) by adjusting its setup registers.
3. Link any required data to the Source inputs of the Display module.

If you want your new screen to appear in the automatic scrolling cycle, you must link the Show
input of the Display module to a Trigger output of a Scroll module.

Creating a Disk Simulator screen

1. Create a new Display module and set the type as Disk Simulator.

2. Connect the new Display module’s first input to the Calibration Pulser module’s Disk Position
output that you want to monitor for its pulsing interval.

3. Toinclude the newly added screen to the ALT screen list, connect the Display module’s
Show1 and Show2 inputs to the Scroll module’s last available Trigger outputs in ALT SCROLL
UP and ALT SCROLL DOWN (respectively).

You can determine the last available Trigger by right-clicking on the output to discover the
Triggers’ owners.

4. Increase the Scroll module’s Wraparound setup register by 1 to include the new screen.
5. Configure the remaining display settings according to your needs.

Although the Disk Simulator display is intended to show the disk behavior of mechanical watt-hour
meters, this feature can be used to monitor any accumulated meter quantity over the time. To do
this, connect the Display module’s first input to the meter quantity and connect the second input to
the maximum value that you expect the displayed quantity to be bounded by (this can be any output
register or an External Numeric module register). In a case where the Display module is not
connected to a Calibration Pulser module, the Disk Simulator revolves from left to right.

If the associated Calibration Pulser module is set for NET accumulation, and a negative value is
accumulated and sent to the Disk Simulator display, the negative number on the display will be a
negative accumulation, but the display disk will still go from left to right (forwards). To make the
display disk go from right to left (backwards), set the associated Calibration Pulser module’s Int
Mode register to reverse.

NOTE: The inputs to the Disk Simulator display are always positive. If the value exceeds the
maximum scale value assigned in the second input, nothing is displayed except labels and the
disk rectangle.
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Configuring leading zeros

The leading zeros and decimal point in a numeric display can be configured with the Display module
setup register Screen Resolution. For example, the number 276.3443 can be configured in one of
the following ways, depending on the selection you make in the Screen Resolution setup register:

Value Screen resolution

276.3443 1.x = 276.3
1234.xx = 0276.34
123456. = 000276.

If the Screen Resolution setup register is set to DEFAULT, the Display module uses the
resolutions defined in the Display Options module.

Last digit mode

The Display module setup register Last Digit Mode lets you specify whether to truncate or round a
value’s last digit. Numbers round up at 5 or greater and round down from 1 to 4. A truncated value
disposes of any digits after the number of decimal places that you specified in the Screen
Resolution setup register.

Screen resolution =1.xxx

Value = 276.35192
Rounded = 276.352
Truncated = 276.351

Configuring parameter titles

The parameter value on a display screen is the value of an output connected to the Display module
Source input register. By default, the displayed parameter’s title is the name of the output connected
to the Source input. The Display module Source Title setup register lets you change the default to a
title that better describes your system. For example, if “KWh Net” is linked to the first Source input,
you can change its display name by setting Source 1 Title to “KWh Net West”. A maximum of 25
characters is permitted.

See "Changing TEST mode timeout" on page 196 for information on configuring TEST mode display
timeouts.

Default front panel display screens

Each mode of operation (NORM, ALT and TEST) has its own display screens, providing various
power system data and meter properties screens.

NORM mode display screens

The meter comes factory-configured with the NORM mode displays detailed below. If the settings
in the Scroll module have not been altered, each screen is displayed for five seconds (if no front
panel buttons are pressed).

Display scrolling is suspended when a front panel button is pressed, allowing you to manually scroll
through the display screens using the up or down arrow buttons. If required, refer to "Front panel
features" on page 24 for more instructions on using the front panel buttons.

7EN02-0306-05

Page 189 0f 210



Displays

ION8650 User Manual

+ kWh: This screen displays kWh delivered and received values.
+ kVARNh: This screen displays kVARh delivered and received values.
* kVAh: This screen displays kVAh delivered and received values.

+ Peak Demand Delivered: This screen displays the maximum delivered kW, kVAR, kVA values
and a timestamp of when the peak occurred. These values are sliding window (rolling block)
demand calculations.

+ Peak Demand Reset Count: This screen displays a count of the number of demand resets
executed as well as a timestamp of the latest peak demand reset.

* Q Metering: This screen displays approximated VARh measurements, one phase (60 degrees)
behind the normal watthour connection (90° - 330° and 150° - 270°).

+ Disk Simulator: This display simulates the behavior of a mechanical watt-hour meter indicating
power received or delivered by the direction of the pulse.

» All Segments: This is a screen test where a black screen showing all segments (all pixels on)
indicates that the display is functioning properly.
ALT mode default display screens

The meter comes factory-configured with the ALT mode displays detailed below. If the settings in
the Scroll module have not been altered, each screen is displayed for five seconds if no front panel
buttons are pressed (until five minutes have elapsed).

Viewing ALT display modes

1. Press the Alt/Enter button once to toggle between the NORM and ALT display modes.
2. Press the up or down arrow buttons to scroll back or forth through the displays.
If no buttons are pressed, the meter reverts to NORM mode after five minutes.

NOTE: These screens vary depending on the firmware version on the meter and custom
display configuration.

+ Name Plate 1: The Name Plate 1 screen contains information on owner, TAG1, TAG2, battery
life, and firmware version and feature set of the meter.

TAG1 and TAG2 typically identify the meter’'s user and installed location. The Owner and TAG
registers are located in the Factory module and are configurable with Power Monitoring Expert
or ION Setup. See "TAG your meter" on page 44.

+ Name Plate 2: This screen displays the following information for the current sliding window
(rolling block) demand settings:

Sliding Window (Rolling Block)

CONFIG | Length of the demand period multiplied by the number of demand periods

UPDATE | Length of the demand period

SYNC Clock synchronization source

MAX (kW) | Maximum kW Demand’

"The MAX (kW) value is a maximum allowable demand level based on installed transformer configurations and nominal

voltages and currents.
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Event Log: The Event Log screen displays up to four of the most recent, high priority events
(priority 255 only). The date, a timestamp, an event description, and an event code are provided
for each event displayed. If more than four high priority events have been recorded, the Event
Log screen indicates additional logs exist. Refer to "Data logging" on page 159 for more details.

Phasor Diagram: This screen shows phasors and numeric values for each phase current and
phase voltage measurement.

Instantaneous Voltage: This screen shows the phase voltage and average voltage (line-to-
neutral or line-to-line voltage, depending on the meter's service type).

Instantaneous Current: This screen shows the phase current and average current values.

Instantaneous Power: This screen shows kW total, kVAR total, kVA total and signed Power
Factor total values.

Instantaneous Demand: This screen shows kW delivered and received from the sliding window
(rolling block) demand calculation.

Voltage Harmonics: These screens show per-phase voltage harmonic histograms.
Current Harmonics: These screens show per-phase current harmonic histograms.
Instantaneous Demand: This screen shows kW delivered and received.

Flicker (ION8650A and ION8650B only): This screen displays flicker measurements from V1,
V2 and V3.

Frequency: This screen displays frequency information.

ALT mode Time of Use (TOU) display screens

The ALT mode TOU display screens are factory-configured to show Time of Use (TOU) data. The

measurements displayed originate from frameworks of modules that are linked to a TOU module.
By default, only one season is configured in the sample TOU schedule; until you configure other
seasons, all data appears under that one season. For details about the TOU module, refer to the
ION Reference.

By default, all demand values result from sliding window (rolling block) calculations.

NOTE: The following abbreviations are used on the TOU display screens:

PB = Past Billing period. A billing period is the time between two consecutive meter readings for
billing purposes by a utility.

PS = Previous Season. Billing Seasons are defined in the TOU module description in the /ON
Reference.

» Active TOU Rate: This screen shows which of the valid TOU billing rates is active.
+ Active TOU Season: This screen shows which TOU billing season is currently active.

« TOU Energy by Rate: This screen shows kWh delivered values for each TOU rate.

* kW Peak Demand: These screens display the maximum kW delivered value for each TOU rate.

These values result from sliding window (rolling block) demand calculations.

» Past Billing Energy: This screen displays the kWh delivered values for each TOU rate in the
previous billing period.
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» Past Billing Peak Demand: These screens display the maximum kW delivered value for each
TOU rate in the previous billing period. These values result from sliding window (rolling block)
demand calculations.

+ Past Season Energy: This screen displays the kWh delivered for each TOU rate in the past
billing season. These values result from sliding window (rolling block) demand calculations.

» Past Season Peak Demand: These screens display the maximum kW delivered for each TOU
rate in the past billing season.

» Past Billing/Season Energy: These screens display the kWh delivered and received values in
the past billing period and billing season.

» Past Bill/ Season Pk Demand: These screens show the maximum kW received values in the
past billing period and billing season. These values result from a sliding window (rolling block)
demand calculation.

+ Past Billing/Season Energy: These screens display the kVARh delivered and received values
in the past billing period and billing season.

» Past Bill/Season Pk Demand: These screens display the maximum kVAR delivered and
received values in the past billing period and billing season. These values result from a sliding
window (rolling block) demand calculation.

+ Past Billing/Season Energy: These screens display the kVAh delivered and received values in
the past billing period and billing season.

+ Past Bill/Season Pk Demand: These screens display the maximum kVA delivered and received
values in the past billing period and billing season. These values result from a sliding window
(rolling block) demand calculation.

TEST mode default display screens

The values shown in the TEST mode display screens represent different accumulators than those
shown in NORM mode (although they perform some of the same basic measurements). The TEST
mode display values are for the purpose of checking accuracy; they only accumulate while the
meteris in TEST mode.

Viewing TEST mode

There are two ways to switch the meterinto TEST mode depending on the type of meter you have:

+ Standard meter (without hardware lock): You must use Power Monitoring Expert or ION Setup;
refer to "Switching to TEST mode" on page 195.

+ Standard hardware-locked meter: You must remove the cover from the meter and press the
TEST mode button; refer to "Performing a master reset from the front panel" on page 201 for
detailed instructions on removing the meter’s cover.

When the meter is in TEST mode, the front panel cycles through four TEST mode display screens:

* kWh Test: This screen shows TEST mode kWh delivered and received values.

* kVARhO/KVAh Test: This screen shows TEST mode kVARh/KVAh delivered and received
values.
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» Instantaneous Demand Test: This screen shows TEST mode kW delivered and received
values. Both quantities are produced from a sliding window (rolling block) demand calculation.
This value is reset if the demand reset switch is turned while the device is in TEST mode.

Setting the display brightness

The Brightness setup register in the Display Options module allows you to set the display to one of
four different brightness levels. The brightness level is controlled through ION Setup.

1. Start ION Setup.
2. Connect to your meter in Advanced Mode.

3. Navigate to the Display Option Modules folder and double-click on the Display Option module
in the right-hand pane.

4. Select the Setup Register tab.
5. Select the Brightness register and click Edit.

6. Select a brightness level (Dim, Standard, Bright, Extra Bright) from the dropdown list and click
OK.

7. Click Send to save your changes to the meter.
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TEST mode

TEST mode is typically used for verifying meter function. The meter is usually reading data from a
test power supply while these functions are performed.

Several things to note about TEST mode:

+ All the billing quantities that are recorded when the meter is in Normal mode stop accumulating
when the meter is switched to TEST mode. The data is sent to special TEST mode registers
instead.

» The values accumulated in these test registers are displayed on the front panel and in Power
Monitoring Expert or ION Setup.

» The regular normal mode billing registers are unaffected while the meter is in TEST mode;
accumulation of this data continues as soon as you exit TEST mode.

+ Alltest registers are reset to zero when you exit TEST mode.

NOTE: The meter always returns to NORM mode when you exit TEST mode, even if you entered
TEST mode from ALT mode.

You cannot place a hardware-locked meter in TEST mode using Power Monitoring Expert or ION
Setup. The meter must be placed in TEST mode using the front panel.

Refer to the PowerlLogic ION8650 accuracy verification technical note for final accuracy verification
test details and procedure.

This chapter describes your meter's TEST mode and explains how to switch from Normal mode to
TEST mode.

In this chapter

SWiItching t0 TE ST MOAe .. . e 195
Changing TEST mode timeoUt ... 196
TEST mode default display SCreens ... .. 197
TEST mode LED energy puUISINg ... oo 198
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Switching to TEST mode

Place the meter into TEST mode using the front panel, ION Setup or Vista. The meter’s front panel
informs you when the meter is in TEST mode with a special display screen.

Using the front panel

TEST
MODE

&=

The TEST mode button on the meter is located beneath the outer cover. You must first remove the
cover to access the button. Refer to the ION8650 Installation guide for instructions and safety

precautions.

A DANGER

HAZARD OF ELECTRIC SHOCK

Wear PPE and take precautions not to touch the meter’s lever contact switches if accessing the
front panel buttons of a switchboard meter.

Failure to follow these instructions will result in death or serious injury.

After you remove the outer cover, press the TEST mode button.

NOTE: If you have a hardware-locked meter, only the basic communications parameters can be
changed in NORM mode. You must enter TEST mode to change other meter parameters on the
hardware-locked meter. See for more details.

Using ION Setup

NOTE: You cannot place a hardware-locked meter in TEST mode using ION Setup. The meter
must be placed in TEST mode using the front panel. See Using the front panel above.

In ION Setup:
1. Open the Setup Assistant for your meter. See the ION Setup Help for instructions.
2. Click Verification.

3. Select Test Mode on the Verification tab and click Edit. Enter your meter password if
prompted. A dialog box informs you that the meter is in Test mode. Click OK.
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TEST mode

The Test Mode screen appears, and test values are displayed.

4. Click on the tabs to perform various test-related tasks. See the ION Setup online help for more
information.

5. Click Scaling on the Energy tab if you want to apply PT/CT scaling to the values displayed in
Test mode. The default is OFF (no scaling is applied).

6. Click Loss Mode on the Volts, Amps and Power tab if you want any transformer loss
compensation that you have configured applied to values in TEST mode.

7. Click Close. A dialog box informs you that the meter is back in Normal mode.
Using Vista

NOTE: You cannot place a hardware-locked meter in TEST mode using Power Monitoring Expert.
The meter must be placed in TEST mode using the front panel. See Using the front panel above.

1. Open your meterin Vista.
2. Select the Setup/Diagnostics tab and click General Setup.

3. Select the Test Mode option for Meter Mode. You are prompted for the Power Monitoring
Expert user password. If meter security is enabled, you are also prompted for the meter
password. For more information see the Vista section of the online Power Monitoring Expert
Help.

Changing TEST mode timeout

If no front panel buttons are pressed, the meter exits TEST mode after 30 minutes (1800 seconds)
by default, if the default TEST mode timeout value has not been changed. The timeout value resets
to 30 minutes each time you press any front panel button. While in TEST mode, the value on the
bottom right of the status bar indicates the amount of time before TEST mode times out. The meter
always returns to NORM mode when the TEST mode timeout elapses.

kWh del T
kWhrec T

6.63
0.00

9:36:54 12/09/2014 ABC Q1 TEST EXIT:28:17 (A)

| A Thetimerindicates the TEST mode timeout. |

You can change the value of the TEST mode timeout using Power Monitoring Expert, ION Setup or
the front panel.

Using the front panel

Follow these steps to change the TEST mode timeout using the front panel:

NOTE: You must be in TEST mode to change the TEST mode timeout if your meter is hardware
locked.

7EN02-0306-05
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5.

Enter the SETUP menu by holding down the ALT/ENTER button.

Scroll through the menu items, highlight DISPLAY OPTIONS, and press the ALT/ENTER
button.

Scroll down and highlight the TEST MODE TO menu item. Press ALT/ENTER. The current
TEST mode timeout is displayed.

Enter the new value of the TEST mode timeout in seconds. Use the up or down arrow buttons
to change the value of the highlighted digit. Press the up or down arrow button to change the
position of the highlight cursor. Press the ALT/ENTER button.

Select YES to confirm the change. Enter the meter password if prompted.

Using ION Setup

1.
2
3.
4

5.

Connect to the meter in Advanced Mode. See the ION Setup Help for instructions.
Locate the Display Options module in the module list and double-click to open the module.
Click the Setup Registers tab and double-click the Test Mode Timeout setup register.

Set the Test Mode Timeout to the desired time. You can choose from a numeric bounded
format or an elapsed interval format.

Click Send to save the changes to the meter.

Using Designer

1.
2.
3.

4.
5,

Open your meter in Designer.
Double-click the Display Setup folder.

Right-click on the Display Options module to access the setup registers. Select the Test
Mode Timeout setup register and click Modify to edit.

Set the Test Mode Timeout to the desired time.

Click OK to send the changes to the meter.

TEST mode default display screens

The values shown in the TEST mode display screens represent different accumulators than those
shown in NORM mode (although they perform some of the same basic measurements). The TEST
mode display values are for accuracy checking purposes; they only accumulate while the meter is
in TEST mode.

In TEST mode, the front panel cycles through four TEST mode display screens:

kWh TEST: This screen shows TEST mode kWh delivered and received values.

kVARh/KVAh TEST: This screen shows TEST mode kVARh/KVAh delivered and received
values.

Instantaneous Demand TEST: This screen shows TEST mode kW delivered and received
values. Both quantities are produced from a sliding window (rolling block) demand calculation.
This value is reset if the demand reset switch is turned while the device is in TEST mode.
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TEST mode LED energy pulsing

Above the display screen are two pairs of energy pulsing LEDs and infrared outputs. The LEDs and
IR outputs are factory-configured to pulse while the meter is in TEST mode.

() S
B) N @

67

WATT infrared output

WATT LED

The Kt label indicates the default pulsing rate
VAR infrared output

VAR LED

moow >

The energy pulsing LEDs provide an interface for accuracy checking instruments. The Kt label
indicates the factory-configured pulsing rate. (You can change the energy pulsing frequency with
Power Monitoring Expert or ION Setup.) See "Configuring energy pulsing” on page 156 for more
information on configuring the LED settings.
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Resets

Resets allow you to clear various accumulated parameters stored by the meter.

This chapter provides instructions for performing various meter resets; including a master reset, and
demand resets.

In this chapter

Performing amaster reS et ... 200
Performing a demand reset ... L 201
Using the front panel ... . 201
Using ION SetUD .l 202
UsSiNg VISt 202
Master resets and hardware-locked meters ... .. ... . .. 203
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Performing a reset

Resets allow you to clear various accumulated parameters stored by the meter.

Performing a master reset

To perform a master reset on a hardware-locked meter, you must remove the front cover and press
the master reset button. See "Master resets and hardware-locked meters" on page 203 for more
information.

With a meter that is not hardware-locked, you can perform a master reset using software. It does
not have to be in TEST mode.

NOTICE

DATA LOSS

Retrieve all important data from the device before you perform a master reset.

Failure to follow these instructions can result in data loss.

Parameters affected by a master reset
The master reset deletes most accumulated values and all derived revenue measurements from the
meter, clears the meters event and waveform logs, and clears COMTRADE waveform records from
the meter’s internal FTP server. The mode that the meter is in (NORM mode or TEST mode - see
"Modes of operation" on page 30) defines the values that are reset.
NORM or ALT mode
In NORM or ALT mode, the following parameters are reset to zero:

» Energy and Demand

* Peak Demand

* Loss Calculation

* Long-term Min/Max

+ Power Quality disturbance counters

+ Time of Use
The following are cleared:

+ Event Log

» All Data Recorders

+ All Waveform Recorders

» All COMTRADE files

TEST mode

All TEST mode Energy and Demand measurements are set to zero.
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Performing a demand reset

Parameters affected by a demand reset

The mode that the meter is in (for example, NORM mode or TEST mode) defines the values that will
be reset.

+ NORM mode: resets the peak demand values logged in the meter.

» TEST mode: resets the test demand parameters to zero.

Demand Lockout Time

The setup register labeled Demand Lockout Time (Display Options module) sets the minimum time
allowed between consecutive demand resets; the meter ignores any attempts to reset the demand
outside the bounds of the register.

The default value for the Demand Lockout time is 25 days. For details on the Demand Lockout Time
setup register, refer to "Configuring demand reset lockout time" on page 140.

For more details on the Display Options module, see ION Reference.

Using the front panel

Performing a master reset from the front panel

The master reset button is recessed to avoid accidental activation. You must first remove the
meter's cover before you can perform a master reset.

MASTER
RESET
[+

A DANGER

HAZARD OF ELECTRIC SHOCK

Wear PPE and take precautions not to touch the meter’s lever contact switches if accessing the
front panel buttons of a switchboard meter.

Failure to follow these instructions will result in death or serious injury.

1. Remove the front cover of the meter. Refer to the ION8650 Installation guide for instructions
and safety precautions.

2. Using a pin or similar instrument, press and hold the master reset button. The message All
recorded data will be lost HOLD TO CONTINUE is displayed. Hold the master reset
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button for 5 seconds to continue with the reset.

MASTER RESET

All recorded data will be lost
HOLD TO CONTINUE

19:36:54  12/09/2014 ABC Q1 ALT 1 11m

NOTE: Do not configure or power down your meter until the meter's front panel displays a
message stating that the master reset is complete. If you configure or power down your meter
during a master reset, the affected parameters may not be completely reset.

<]

Performing a demand reset from the front panel
The demand reset switch can be activated with the cover on or off.

In most applications, the demand reset switch is sealed with an anti-tamper mechanism; a through-
hole in the switch can accommodate either an external seal or a locking mechanism. See for details
of anti- tamper sealing.

NOTE: A Demand Lockout Time register sets the minimum time allowed between consecutive
demand resets; the meter ignores any attempts to reset the demand outside the bounds of the
register. The default value for the Demand Lockout Time is 25 days (2160000s).

Using ION Setup
1. Open the Setup Assistant for your meter. See the ION Setup Help for instructions.
2. Click Verification.
3. Select Normal Mode, and then click Display.
4

. Select the desired tab in the Normal Mode dialog box. Two resets are available: Peak Reset
and Master Reset. Click the appropriate button to perform the reset (Peak Demand in the
example below).

A dialog box informs you when the reset is complete.

NOTE: Do not configure or power down your meter until a message appears stating that the
master reset is complete. If you configure or power down your meter during a master reset, the
affected parameters may not be completely reset.

Using Vista

Open your meter in Vista. You can perform several resets from within Vista.
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Performing a master reset

NOTE: The master reset is not accessible via software in a hardware-locked meter, whether the
meteris in TEST, ALT or NORM mode. A master reset on a hardware- locked meter can only be
performed from the front panel. See "Master resets and hardware-locked meters" on page 203 for
details.

With a meter that is not hardware-locked, you can perform a master reset via software. It does not
need to be in TEST mode.
1. Click the Setup/Diagnostics tab and click the General icon.
2. Click the Master Reseticon.
NOTE: Do not configure or power down your meter until a message appears stating that the

master reset is complete. If you configure or power down your meter during a master reset, the
affected parameters may not be completely reset.

Performing a peak demand reset
1. Click the Revenue tab and click the Demand Max icon.

2. Click the Peak demand reseticon.

Performing a Min/Max reset
1. Click the Volts/Amps tab and click the Long-term min/max icon.

2. Click the Reset Min/Max icon.

Performing a Sag/Swell or Harmonics Min/Max reset
1. Click the Power Quality tab.

2. Click Reset counters to reset the disturbance counters. Click the Harmonics Details icon
then click Reset Min/Max to reset the harmonics min/max values.

NOTE: The master reset is not accessible via software in a hardware-locked meter, whether the
meteris in TEST, ALT or NORM mode. A master reset on a hardware- locked meter can only be
performed from the front panel. See "Master resets and hardware-locked meters" on page 203 for
details.

With a meter that is not hardware-locked, you can perform a master reset via software. It does not
need to be in TEST mode.

Master resets and hardware-locked meters

The master reset is not accessible via software in a hardware-locked meter, whether the meter is in
TEST, ALT or NORM mode. A complete master reset on a hardware- locked meter can only be
performed by pressing the master reset button on the meter’s front panel. See "Performing a master
reset from the front panel” on page 201.

TEST mode

In TEST mode, a screen is displayed stating that the master reset is unavailable:
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MASTER RESET

UNAVAILABLE IN
TEST MODE

19:36:54  12/09/2014 Q1 TEST EXIT: 29:55

Normal mode, Locked

In this case the meter attempts the master reset, but revenue and event logs are not cleared. The
rest of the master reset is successful.

LOCKED METER

PARTIAL RESET
IN PROGRESS

13:36:54  12/09/2014 Q1 NORME_] 0:46m

LOCKED METER

PARTIAL RESET
COMPLETED

13:36:54  12/09/2014 Q1 NORME_] 0:49m
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Setpoints

The Relative Setpoint module provides extensive non-critical control, secondary protection, and
analysis capabilities by allowing you to initiate an action in response to a specific condition. It is
particularly useful for performing actions based on differences between a value (for example, kW on
phase A) relative to a reference value (for example, kW demand for all three phases). Use this
module’s outputs for demand control of equipment or any other applications requiring setpoint
activity relative to a varying value. See the /ON Reference for more information on the Relative
Setpoint module.

A WARNING

HAZARD OF UNINTENDED OPERATION

» Do not use the meter for critical control or protection applications where human or equipment
safety relies on the operation of the control circuit.

» Be aware that an unexpected change of state of the digital outputs may result when the supply
power to the meter is interrupted or after a meter firmware or template upgrade.

Failure to follow these instructions can result in death, serious injury, or equipment
damage.

This chapter provides instructions for configuring meter setpoints.

In this chapter

Relative Setpoint module settings
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Configuring setpoints

Use Power Monitoring Expert or ION Setup to change your meter's setpoints.

Using the front panel

You cannot configure setpoints using the front panel.

Using ION Setup
1. Connect to your meter in Advanced Mode.

2. Click on the Relative Setpoint module you want to configure.

Using Vista

Open your meter in Vista and click on the Setpoints tab. Click the Setup icon. Use the switches to
turn various monitoring on and off (see circled below). Click the numeric boxes to edit condition
settings.

Relative Setpoint module settings

By default, the following Relative Setpoint modules are configured:

Label Description

When active, this annunciates when the total kW sliding window demand
Over KW sd exceeds a specified amount.

When active, this annunciates when the current on phase A exceeds a

Overla specified amount.

Overlb When active, this annunciates when the current on phase B exceeds a
specified amount.

When active, this annunciates when the current on phase C exceeds a

Overlc specified amount.

When active, this annunciates if the voltage unbalance exceeds a
OverV unbal specified amount.

Phase 1loss, Phase [When active, these annunciate if the phase voltage drops below the Sag/
2loss, Phase 3loss | Swell module’s Nom Volts register by a specified amount.

V1,V2, V3 (+/-15%) |When active, these annunciate when the phase voltage deviates from the
for 10m, 10s, 3s Sag/Swell module’s Nom Volts register by a specified amount.

NOTE: There is usually no need to change any of the Relative Setpoint modules’ setup registers
for normal operation of the meter.

See the ION Reference for more information on the Relative Setpoint module.

Fine tuning over condition monitoring

If you want to fine-tune over condition monitoring, the only setup registers you should change are
SusUntION and SusUntIOFF.

SusUntION determines how long the modules wait after an over condition is detected before
reporting it. This gives the monitored value a short period to correct itself before the event is
registered with the module so that very brief over conditions are ignored. Similarly, SusUnt/OFF is
the amount of time a normal value must be present before the module considers normal operation to
be restored. Both SusUntION and SusUntIOFF values are entered in seconds.
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Reports

Accumulated meter values are saved in logs. These logs can be acquired by your energy
management software and saved in its database for analysis and reporting.

The Web Reporter component of Power Monitoring Expert is a database reporting application that
lets you define, generate, and manage comprehensive reports based on the information in your
system database. It processes selected data and generates a finished report.

For more information on reports, see the Web Reporter section of the online Power Monitoring
Expert Help.

This chapter provides instructions for viewing various meter reports and logs.

In this chapter

VI BWING MO OGS - 208
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Viewing meter logs

View meter logs using Power Monitoring Expert, ION Setup or the front panel.

Using the front panel

The front panel only displays recent high priority events (Event Log).

DATE TIME EVENT CODE
12/08/2014 10:23:45 Shutdown SD25
12/08/2014 10:42:03 Power Up SD25

12/08/2014 11:19:26  Changed Setup  SD25
ADDITIONAL LOGS - READ THROUGH COMMS
9:36:54 12/09/2014  ABC Q1 ALT H__11im

Press ALT/ENTER to access the ALT display then press the up and down arrow buttons to
navigate to the Event Log.

Using ION Setup
1. Open the Setup Assistant for your meter. See the ION Setup Help for instructions.
2. Select the Reports screen.
3. Select one of the logs or comparisons in the list and click Display to view the associated log.
4. Youcanview, save or print the log. Click Close to exit.

See also "Viewing data log information" on page 165 for information on viewing data log
information in ION Setup.

Using Vista

Open your meter in Vista and click on the various tabs available. Click an icon to view the
associated logs. The following logs are available in Vista:

* Volts/Amps tab:

— Meter Events
— Voltage
— Current
— Power
— Frequency/PF

* Revenue tab:

— Logged Interval data

* Power Quality tab:

— Harmonics Trending
— Transient & Sag/Swell Statistics CBEMA

— Waveforms/Sequence of Events

EN50160
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